BlackTrax Wiki
The Complete BlackTrax User Wiki

About this Manual
BlackTrax System Overview
BTWYSIWYG For BlackTrax
Motive for BlackTrax
BlackTrax GUI
BTEngine & Background Modules
Simulator & Cue Modules
BlackTrax Device Manager
Health and Safety Information

BlackTrax User Wiki

1

August 2017

About this Manual
This wiki provides instructions for the installation, conﬁguration and operation of the BlackTrax system.

© CAST Group of Companies Inc., 2002-2017 All rights reserved. BlackTrax, WYSIWYG, CAST Software,
and Autofocus are trademarks of the CAST Group of Companies Incorporated. All other trademarks and
logos are the property of their respective owners. Depending on your product/version, CAST incorporates
source code or libraries which are licensed to CAST and copyright protected. For more information, go to
http://www.cast-soft.com/content/third-party-libraries.

BlackTrax User Wiki

2

August 2017

About this Manual
Table of contents:
1 Introduction :
2 Text Conventions :

BlackTrax User Wiki

3

August 2017

About this Manual
The following text conventions are used in this wiki:
Instructions titles appear in Bold and Orange. For example, "To view a BTCamera’s video feed
in the visible spectrum"
Menus and menu commands appear in Bold and Navy. For example, “To open the window if
closed, go to the View menu and click Cameras.”
User interface elements such as buttons, tools, shortcuts, and dialog boxes appear in Italics and
Medium Blue. For example, “To close the project, click Yes.”
Keyboard keys are indicated in CAPITALS AND BLUE. For example, “To call up the save menu, enter
in the command CTRL+SHIFT+B.”
References to manuals appear in Italics Underlined in Blue. For example, “For an in depth
understanding on BTWYSIWYG and its capabilities, please refer to the WYSIWYG Reference Guide.”
Instructions to direct you to diﬀerent features of the BTSystem or areas in the physical Space are
indicated by being Green and Underlined. For Example “In the Physical Space, take the BTBeacon.”
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List of standard system modules
Note: The quantity of BTCameras, BTBeacons, and Stringers delivered with a BTSystem are dependent
on each user’s needs and on the individual sale.
(1) BTServer (pre-installed software below)
Hardware secured inside the server
BTX Dongle
Motive Dongle
Pre-installed software
BTWYSIWYG
Motive for BlackTrax
BlackTrax Software Suite
Charging Station for Management
VNC Server
LogMeIn
Adobe Reader
Macrium Reﬂect
Artnetominator
Wireshark
(1) BTRouter
(1) Timekeeper
Ferrite ﬁlters
(1) eSync 2 Controller*
BNC/RCA Adapter
BTCameras
BTBeacons
Stringers
(1) BTSmart Charger
(1) BTCalibration Kit
(1) BTCalibration Wand Head
(1) BTCalibration Telescopic Wand Handle
(1) BTCalibration Ground Plane
(1) BTCalibration Power Supply Unit
(1) BTCalibration Battery Power Supply Unit
(1) Carrying case
Attention: *The original eSync Controller is discontinued.

Not included mandatory components
Category 6 Ethernet cable
Power over Ethernet (PoE) gigabit Switch

Optional components
DMX/Ethernet Node (for tracking with moving lights)
Additional Power over Ethernet (PoE) gigabit Switches
BlackTrax User Wiki
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BTServer diagram

Physical characteristics

Technical Speciﬁcations
BTServer Rev 4:
(2x) Intel Xeon Processor E5-2620 v4 (8C, 2.1GHz, 3.0GHz Turbo, 2133MHz, 20MB, 85W)
(2x) 2.5" 512GB SSD SATA in RAID 1
16GB (4x4GB) 2400MHz DDR4 RDIMM ECC
NVidia GeForce GTX 1060
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Integrated Intel I350 (4x1Gbit) Quad Port Network Card + Additional Intel I350 Quad-Port Gigabit
Ethernet Controller
Windows Embedded 8.1 Industry Pro

BTServer Rev 3:
(2x) Intel Xeon Processor E5-2620 v3 (6C, 2.4GHz, 3.2GHz Turbo, 1866MHz, 15MB, 85W)
(2x) 2.5" 512GB SSD SATA in RAID 1 -or- (2x) 2.5" 500GB HDD SATA in RAID 1
64GB (8x8GB) 2400MHz DDR4 RDIMM ECC
NVidia GeForce GTX 1060 -or- NVidia GeForce GTX 960 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Integrated Intel I350 (4x1Gbit) Quad Port Network Card + Additional Broadcom BCM5719 Quad-Port
Gigabit Ethernet Controller
DVD-ROM Optical Disk Drive
Newer Systems: Windows 8.1 Pro; Legacy Systems: Windows 7 Professional

BTServer Rev 2:
(2x) Intel Xeon Processor E5-2620 v2 (6C, 2.1GHz, 2.6GHz Turbo, 1600MHz, 15MB, 80W)
(2x) 2.5" 500GB HDD SATA in RAID 1
16GB (4x4GB) 1866MHz DDR3 ECC RDIMM
NVidia GeForce GTX 760 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Intel X520-T2 Dual Port 10GbE Network Interface Card
DVD-ROM Optical Disk Drive
Windows 7 Professional
BlackTrax User Wiki
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BTServer Rev 1:
(2x) Intel Xeon Processor E5-2620 v2 (6C, 2.1GHz, 2.6GHz Turbo, 1600MHz, 15MB, 80W)
(2x) 3.5" 500GB HDD SATA in RAID 1
4GB RDIMM, 1600MT/s, Low Volt, Single Rank, x8 Data Width
NVidia GeForce GTX 760 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Broadcom 5720 Quad Port 1Gb Network Interface Card
DVD-ROM Optical Disk Drive
Windows 7 Professional

Default user login
User name: btuser
Note: There is no password associated with the default user account for the BTServer

Default network address

Note:
The BTServer is built with 2 Network Interface Cards (NIC) with 4 ports on each card, and the
functions are: (see BlackTrax detailed system diagram)
Port 1: BTNet (PoE Switch - Tracking, BTCameras)
Port 2: RTTrPL and Lighting Input (Network Switch - Lighting)
Port 3: RTTrPM (Network Switch - 3rd Party)
Port 4: BTLink (links to BTServers)
Port 5-8: (User Deﬁned)
Lighting Input and RTTrPL are combined into the RTTrPL port.
BTLink is the network connection link to the other BTServers.
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Timekeeper diagram

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number: BTTKV01

Physical Characteristics
Width: 5.7 cm (2.245")
Height: 7.11 cm (2.8")
Depth: 2.57 cm (1.013")
Weight: 125 g (4.41 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoeE Network Switch via Ethernet port (No input power via USB port)

Status LEDs

Timekeeper Functions
The Timekeeper is a single wireless access point that uses a proprietary radio system running on the 2.4
Ghz frequencey to send data to all BTBeacons. Data sent includes a signal used to syncronize the
BTBeacons with the BTCameras with the BTCameras, and conﬁguration commands sent to the eSync
Controller via an RCA cable.
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Timekeeper transmitter characteristics
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BTRouter diagram

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number BTTKV01

Physical characteristics
Width: 5.7 cm (2.245")
Height: 7.11 cm (2.8")
Depth: 2.57 cm (1.013")
Weight: 125 g (4.41 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

Input/output & power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoeE Network Switch via Ethernet port (No input power via USB port)

Status LEDs

BTRouter functions
The BTRouter is a single wireless access point that uses a proprietary radio system running on 2.4 Ghz
frequency to receive data from all BTBeacons. Data received includes BTBeacon button presses, battery
status, conﬁguration details as well as inertial measurement unit (IMU) data. IMU data can be used to
calculate the BTBeacon’s orientation and position.
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BTRouter transmitter characteristics
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Ferrite ﬁlter diagram

Product ID
Manufacturer: API
Model number: BF1835

Physical characteristics
Width: 1.8 cm (.709”)
Height: 1.96 cm (.776”)
Depth: 3.48 cm (1.378”)
Center diameter: 0.89 cm (.354”)
Weight: 15 g (.53 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)
Impedance: 172 Ohm

Ferrite function
The ferrite ﬁlter is a cylindrical clamp fastened over cables to conform with regulatory standards. A
ferrite ﬁlter must be clamped over any cables connected to the Timekeeper and BTRouter. Ferrite ﬁlters
should be fastened on any connected cables as close to the respective device as possible.
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eSync Controller diagram

Physical characteristics
Width: 13.89 cm (5.47”)
Height: 4.09 cm (1.61”)
Depth: 9.25 cm (3.64”)
Weight: 368.54 g (13 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

Input/output & power
PoE: IEEE 802.3af-2003
Adapter: 12V DC and 3 Amps
Data: Ethernet

Status LEDs
Per port activity status
Master time
External lock
Ethernet link status
Ethernet activity

eSync Controller functions
The eSync Controller synchronizes BTCameras so that the shutters of BTCameras open and close
simultaneously and in synchronization with the pulsing of LED Stringers attached to BTBeacons.

eSync Controller connection to
the TimeKeeper
The eSync Controller connects to the TimerKeeper over RCA cable. The RCA cable is plugged into the
RCA port of the eSync Controller.
BlackTrax User Wiki
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eSync 2 Controller diagram

Physical characteristics
Width: 13.89 cm (5.47”)
Height: 4.09 cm (1.61”)
Depth: 9.25 cm (3.64”)
Weight: 368.54 g (13 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

Input/output & power
PoE: IEEE 802.3af-2003
Adapter: 12V @ 0.6A power supply
Data: Ethernet

Status LEDs
Per port activity status
Master time
External lock
Ethernet link status
Ethernet activity

eSync 2 Controller functions
The eSync 2 Controller synchronizes BTCameras so that the shutters of BTCameras open and close
simultaneously and in synchronization with the pulsing of LED Stringers attached to BTBeacons.

eSync 2 Controller connection to
the TimeKeeper
The eSync 2 Controller connects to the TimeKeeper over RCA cable. A BNC/RCA adapter is used to plug
the RCA into input 3 of the eSync 2 Controller.
BlackTrax User Wiki

16

August 2017

BlackTrax System Overview

SLIM 13E
SLIM 13E diagram

Product ID
Model number: SLIM 13E

Physical characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)
Case: Aluminum and Polycarbonate
Width: 6.86 cm (2.7”)
Height: 6.86 cm (2.7”)
Depth: 4.45 cm (1.75”)
Weight: 320 g (11.29 oz)

Lens & ﬁlter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 56°
Vertical FOV: 46°
Optional Lens: 8 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°
Optional Lens: 3.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 82°
Vertical FOV: 70°
Adjustable focus with wave spring assist
850nm band-pass ﬁlter
850nm (Infrared) / 700nm (Visible) Filter Switcher
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Image Camera
Resolution: 1280 × 1024
Frame Rate: 30–240 FPS (100 FPS average usage)
Accuracy: Sub-millimeter
Latency: 4 ms
Shutter type: global
Shutter speed:
Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.9 ms (3,900 µs) at 240 FPS

Input/output & power
Data: Ethernet
Synchronization: Ethernet
Power: (PoE) 8.0 watts

S250e SLIM
S250e SLIM diagram

Product ID
Model Number: S250e

Physical characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)
Case: Aluminum and Polycarbonate
Width: 8.1 cm (3.19”)
Height: 8. cm (3.16”)
BlackTrax User Wiki
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Depth: 6.76 cm (2.66”)
Weight: 430.91 g (15.2 oz)

Lens & ﬁlter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 56°
Vertical FOV: 46°
Optional lens: 8 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°
M12 Lens Mount
Adjustable focus with wave spring assist
800nm IR long pass ﬁlter with Filter Switcher

Image Camera
Resolution: 832 × 832
Frame Rate: 30–250 FPS (100 FPS average usage)
Accuracy: Sub-millimeter
Latency: 4 ms
Shutter Type: global
Shutter Speed:
Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.8 ms (3,800 µs) at 100 FPS

Input/output & power
Data: Ethernet
Synchronization: Ethernet
Power: (PoE) 15.4 watts

BTCamera functions
BTCameras are used to view BTBeacon positions in the Space. A BTBeacon's position in 3 dimensions (X,
Y, and Z) can be determined when two or more BTCameras simultaneously have a direct line-of-sight to a
connected Stringer’s LED. This information is then sent to the BTServer.
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Attention:
The switch must provide consistent power to every port simultaneously in order to power each
camera.
Standard PoE switches must provide a full 15.4 watts to every port simultaneously.
Note that PoE Midspan devices or power injectors are not suitable for Ethernet camera systems.
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BTBeacon diagram

Product ID
FCC ID: RKT- BTBCV01
IC: 10858A- BTBCV01
Model: BTBCV01P

Physical characteristics
Case: Plastic with Velcro strap attachments
Width: 4.94 cm (1.945”)
Height: 8.08 cm (3.18”)
Depth: 1.87 cm (.737”)
Weight: 75 g (2.65 oz)

Input/output & power
Data: USB, Radio 2.4 (GHz) 10Hz
Power: Rechargeable Lithium-ion Battery, charged by 5V USB
Watt hour: 4.44 Wh normal operation, 5.04 Wh while charging

BTBeacon Status LEDs (During Operation)

Warning: If a BTBeacon experiences a charge error, there could be a potential issue with the Lithium-ion
battery. Discontinue use immediately. For more information about Lithium-ion battery safety see “Health
and Safety Information”. Alternately, no battery may be in the BTBeacon.

BTBeacon Status LEDs (During Boot
BlackTrax User Wiki
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Loader mode)

BTBeacon functions
Each BTBeacon has three ports, each of which can power a single connected Stringer. When a Stringer is
connected to a BTBeacon’s LED port, the Stringer’s LED will emit infrared light in a unique pattern. These
infrared pulses create a unique ID used to identify BTBeacons. When the LED infrared pulse is seen by 2
or more BTCameras, the positional coordinates (XYZ) for the Stringer LED is calculated by the BTServer.
Position is based on the location of visible Stringer LEDs connected to a BTBeacon. Orientation data (roll,
pitch, yaw) is determined by an internal inertial measurement unit (IMU). The IMU also functions as a
backup for determining the BTBeacon's position. The IMU measures acceleration and rotation.
The BTBeacons have a red power and reset button, and two white auxiliary buttons. The auxiliary buttons
are used during ﬁxture calibration.
The BTBeacon transmits the following data over radio to the BTRouter, which is relayed to the BTServer:
IMU data, button presses, battery status, conﬁguration details, and Stringer IDs.
To enter the BTBeacon into Boot Loader Mode, turn the beacon oﬀ and hold A or B while inserting the
BTBeacon into the BTSmart Charger. This mode is used to update ﬁrmware.

BTBeacon transmitter characteristics

BTBeacon charging information
A BTBeacon’s rechargeable lithium-ion battery is not fully charged when shipped. Please read the
following instructions carefully:
Never charge BTBeacon near heat or ﬂammable objects.
The temperature range which the BTBeacon can be charged is 0°C to 40°C (32°F to 104°F).
Charging outside the recommended temperature range may automatically be blocked by the
protection circuitry of the device.
Do not charge or use the BTBeacon if any damage has occurred to the device.
BlackTrax User Wiki
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The temperature range over which the BTBeacon’s battery can operate is 0°C to 40°C (32°F to
104°F). Operation outside of this temperature range may damage the performance of the battery
or may reduce its life expectancy.
Battery performance will naturally decay over time. If a battery can not maintain charge for long
periods, even when it is being charged correctly, this may indicate it is time to replace the battery.

BTBeacon battery replacement
After a period of time the battery of the BTBeacon will naturally decay through normal use and require
replacement. Contract your BTE for details on replacing the BTBeacon battery.
Attention: Any unauthorized modiﬁcation to the BTBeacon or its battery will invalidate any warranty
claim and may damage the device.
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BTSmart Charger diagram

Size and weight
Case: Steel
Width: 15.5 cm (6.1”)
Height: 8.47 cm (3.33”)
Depth: 36 cm (14.17”)
Weight: 2440 g (86.07 oz)

Input/output & power
Data: Ethernet, USB
Power: 20 Watt
Voltage range: 100V - 240V
Note: The latest BTSmart Charger version Rev 6 is built with a momentary contact type power button
with the blue LED that will light up only after the "boot up" is complete. To turn the device power oﬀ,
press the power button, then wait until the blue LED light turns oﬀ before you disconnect from the power
source.

BTSmart Charger functions
The BTSmart Charger is a device used to recharge the battery of a BTBeacon. BTBeacons are connected
to the BTSmart Charger using the BTBeacon’s USB port. While connected, the BTSystem can read the
status of the battery, regulate charging and maximize battery life. The BTSmart Charger can hold a
maximum of 6 BTBeacons at one time.

BTSmart Charger conﬁgurations
The BTSmart Charger can be conﬁgured to either be horizontal and sit ﬂat on a desk, or be vertical and
be mounted on a wall.

Horizontal conﬁguration diagram
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Vertical conﬁguration diagram
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Wand Head

Size and weight
Width: 105.92 cm (41.7”)
Height: 26.92 cm (10.6”)
Depth: 2.03 cm (0.8”)
Weight: 715 g (25.22 oz)

Triangular Wand Holder

Size and weight
Length: 24 cm (9.45”)
Height: 17.5 cm (6.89”)
Width: 4.45 cm (1.75”)
Weight: 420g (14.82 oz)

Telescopic Wand Handle
Size and weight
Length: 2.03 cm (0.8”)
Height: 149.86 cm (59”)
Width: 2.03 cm (0.8”)
Weight: 365 g (12.86 oz)
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Ground Plane

Size and weight
Width: 76.96 cm (30.3”)
Length: 98.04 cm (38.6”)
Depth: 5.08 cm (2”)
Weight: 1905 g (67.2 oz)

Power Supply Unit (PSU)

Size and weight
Width: 10.5 cm (4.1”)
Height: 9.8 cm (3.8”)
Depth: 4.57 cm (1.8”)
Weight: 335 g (11.82 oz)

Power
Power: 10 Watt

Hybrid Power Supply Unit (HPSU)
Size and weight
Width: 1.35 cm (0.5")
Height: 0.45 cm (0.2")
Depth: 1.1 cm (0.4")
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Power run time
High: 1 - 1:20 hours
Med: 2:45 - 3 hours
Low: 3:15 - 3:30 hours

Notes
1. Most applications (comparable to the current PSU) use Medium, depending on the size of the venue
and how far the cameras are. You may try out low or high to conserve power or boost the IR.
2. A USB port is available where you can use to charge an external Beacon.

Lighting Wand

Size and weight
Size: 2 m (6.56’)
Weight: 235 g (8.29 oz)

BTCalibration Kit Case

Outside dimensions: 96.8 x 40.6 x 15.5 cm (44.37” x 16” x 6.12”)
Weight: (with foam lining only): 7.7 kg (16.98 lbs.)

BlackTrax Calibration Kit functions
The Calibration Kit is used for calibrating the BTCameras position in the Space. The function of each
equipment in the Kit are:
1. The Wand Head is attached to the Wand Handle and connected to the Power Supply Unit.
2. When you move the Wand Head inside the Space, the BTCameras look for active LEDs located on
the Wand Head.
BlackTrax User Wiki
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3. When multiple BTCameras see the LEDs on the Wand Head, the BTSystem is able to generate a
measurement point for BTCamera calibration.
4. BTCameras use the measurement point data to determine their position relative to each other.
5. The Ground Plane is connected to the Power Supply Unit and placed in the designated origin of the
Space.
6. The Ground Plane LEDs are used in the BlackTrax system to calculate the BTCamera positions
relative to the origin and the orientation of the Cartesian axes.
7. The Lighting Calibration Wand is used for ﬁxture calibration.
8. The Lighting Calibration Wand can be attached to a BTBeacon instead of a Stringer to extend the
range of a BTBeacon LEDs. This is used to calibrate ﬁxtures in areas that are diﬃcult to reach.

BlackTrax User Wiki

29

August 2017

BlackTrax System Overview

Stringer diagram

Physical characteristics
Cable length: 1.37 m (4.5') Custom sizes are available
Cable thickness: 2.9 mm (0.11")
LED Diﬀuser diameter: 7.93 mm (5/16")
Strain relief: 30 mm (1.18")

Stringer functions
When a Stringer is connected to a BTBeacon LED port, the LED portion of a Stringer will pulse that
BTBeacon’s unique ID signal. The pulse is viewed by BTCameras, sent to the BTServer and used to
calculate the BTBeacon position in the Space.
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Attention: BlackTrax requires additional components to function which are not included with purchase
of the BTSystem.
Category 6 Ethernet Cabling
Power Over Ethernet Gigabit Switch for BTCameras
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All Ethernet cabling used to connect the system components together must be of Category 6 (Cat6)
quality or greater. Cat6 is necessary for the transmission of data at gigabit speeds, which is required by
BlackTrax. The amount of cable needed will vary depending on the Space dimensions and user needs.
Attention: The maximum allowed length of a Cat6 cable is 91.44 meters. It is recommended that Cat6
standards be followed when connecting modules together to ensure the BTSystem operates as intended.
This range can be extended by using Gigabit switches to connect Cat6 cable of 91.44 meter length or
less.
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BlackTrax requires a dedicated Power over Ethernet (PoE) gigabit switch or dedicated virtual local area
network (VLAN) to connect all the BTCameras with the rest of the system. The switch should have the
following:
A PoE gigabit switch.
A PoE port for each BTCamera, plus 4 extra to connect to the Timekeeper, BTRouter, eSync
Controller and BTServer.
PoE switches must support 15.4 watts per Ethernet port.
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Depending on the purpose of tracking, you may need additional hardware components that are not
included with the BTSystem.
DMX/Ethernet Node for Tracking with Moving Lights
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Compatible DMX/Ethernet nodes
To connect BlackTrax downstream to a lighting console, a DMX to Ethernet/Ethernet to DMX node is
required. The following nodes have been tested and are approved to work with BlackTrax
Luminex Ethernet-DMX2/Truss MkII
Luminex Ethernet-DMX4 MkII
Luminex Ethernet-DMX4/ Truss MkII
Luminex Ethernet-DMX8 MkII
Luminex Ethernet-DMX8/ Truss MkII
Merging Channel:
The merging channel is a single DMX channel that is patched into your lighting console to
enable the control of moving ﬁxtures from BlackTrax.
The merging channel can be a dimmer channel that controls intensity fading between BlackTrax
and the lighting console, or as a simple non-dim On/Oﬀ control.
The merging channel must be patched in your console and set as the trigger channel in your merge
node.
When the merging channel is at full (100%) intensity, BlackTrax has complete control over the
channels connected to the BlackTrax project. When the merging channel is at zero (0) intensity, the
lighting console has full control over the channels in the BlackTrax project.
In the Project Properties widget in BlackTrax, you can activate and set the monitoring of the Merge
Channel that was set in your merge node.

Luminex node settings
The Luminex Ethernet DMX nodes must be conﬁgured to work with your BlackTrax system.
Attention: The following is a guide outlining how each variable should be set for use with
BlackTrax. Each BlackTrax event is diﬀerent. There are circumstances where these settings would need
to be modiﬁed based on factors such as the rig, cabling and patching.
The node set up is done through a web interface. If not setting up your node through a BlackTrax server,
please ensure your IP settings match that of the node(s) you wish to conﬁgure.
1. Navigate to the web interface by entering in the IP address of the node in your browser window.
2. Under Setup, click on the desired node you wish to conﬁgure.
Note: The 8 port nodes will appear as multiple 4 port nodes in the interface.
3. For the desired ports, choose Output as the Direction, and Custom for IP Merging.

4. Once setting IP Merging to Custom, a blue box will appear beside the number for the output. Click on
this blue box.
Result: The Conﬁg page for that output will pop up.
BlackTrax User Wiki
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5. Set your universes as you wish to merge. Choose one universe to the the DMX protocol, and the other
to be RTTrPL
6. Change the Mode to be X-Fade, and set the trigger channel to be the same as your merging channel.
Once this is done, press Set default mode.
7. Click Submit Changes.
Result: That output will be conﬁgured as expected. If you Show table you should see the channels
have all changed to X-Fade, with a trigger of the speciﬁed channel.
8. Repeat the above for all outputs you wish to conﬁgure on the node. When ﬁnished, click Submit
Changes.
9. Navigate to the Global tab under Setup. Set Enable Trigger to DMX, and the universe to whichever
universe your Merging Channel is patched to, with the desired DMX protocol.
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System conﬁguration overview
It is recommended that all hardware modules that connect to the BTServer be located in the same
location outside of the tracking area, except for the BTCameras. BTCameras need to be positioned where
they will not be disturbed and have the best unblocked view of the tracking area. The following diagram
outlines a typical hardware conﬁguration and demonstrates how all BlackTrax hardware modules are
connected together.
Attention: The Timekeeper and BTRouter Ethernet port is designed to only connect to a commercially
available Power over Ethernet (PoE) network switch. The Timekeeper and BTRouter are not designed to
be a peripheral device to a Class B personal computer. As such, the Ethernet port shall not be connected
to a Class B personal computer in any operating conﬁguration.

BlackTrax system conﬁguration diagram

BlackTrax User Wiki

38

August 2017

BlackTrax System Overview

Optional equipment overview
Depending on your tracking needs, additional components must be connected with the BTSystem. The
following outlines how to connect this optional equipment with the BTSystem.

Tracking with moving light ﬁxtures diagram
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Licensing overview
As of BlackTrax Version 2, a licensing security system has been implimented to authorize hardware
devices on the BlackTrax network. In this version of the software, unrecognized devices on the BlackTrax
network are not compatible with the software. An unrecognized device is any device on the BlackTrax
Network that was not sold directly to you by CAST Software.
You only need to update your license ﬁles if:
You are updating from version 1.8.8 Patch 1 or earlier.
You have added new hardware devices to the network and receive an error message in BlackTrax
or Tracker.
Note: The default License Folder location is: C:\bt_run_time\license. For information on how to download
the license ﬁle, please refer to this link.

License installation
You may download the latest license and key ﬁle from the CAST Forums, under the License File Download
post. The installer will prompt the user to specify the location of the license and key ﬁles during the
installation process, and then use these ﬁles to license the BlackTrax suite of applications.

To use the BlackTrax License Installer
1. The installer will prompt the user for the location of the BlackTrax License File "btlicense.btl".
2. Once the user has located the license, the Next button should be pressed to proceed with the
installation
3. The installation will then prompt the user for the BlackTrax Key File "blacktrax.pem"
4. Once the user has located the key ﬁle, the Next button should be pressed to proceed with the
installation.
Result: The installation is complete. The software can be run as normal.
For the initial release of BlackTrax Version 2 (BETA), the system will warn the user if any unrecognized
device is detected. On the ﬁnal release of BlackTrax Version 2 however, the system will lock and prevent
the system from functioning until the unrecognized devices are removed from the system.
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Charging overview
BTBeacons are charged using the BTSmart Charger. BTBeacons can be connected to the BTSmart
Charger using the Mini USB port found on the side of the BTBeacon.
Attention: The Mini USB port of the BTBeacon is not designed to be a peripheral device to a Class B
personal computer. As such, a user shall not connect the USB port to a Class B personal computer during
normal operation.
Attention: The sole power source of the BTBeacon is the internal 3.7V rechargeable Lithium-ion battery.
The BTBeacon does not require a connection at the Mini USB port to operate.

To charge a BTBeacon using the BTSmart Charger
Connect the BTBeacon to the charge station via the Mini USB port found on the side of the BTBeacon.
Result: The BTBeacon is charging. To determine when the BTBeacon is fully charged, see BTBeacon
status LEDs (During operation).
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BTBeacon lithium-ion battery overview
After extensive use the lithium-ion battery in a BTBeacon may no longer operate and be unable to power
the BTBeacon. The end of a lithium-ion battery’s life cycle can be determined when the lithium-ion
battery will not hold a charge and the BTBeacon will not power on. When this occurs, it is recommended
that the lithium-ion battery inside the BTBeacon be carefully replaced with a new lithium-ion battery.
Attention: Only use lithium-ion batteries supplied by CAST. It is recommended that
batteries be changed every 6 months to ensure optimal performance.
Attention: The following is required when replacing a BTBeacon’s battery:
Replacement battery
3/8” Hex key
Adhesive tape

To replace a BTBeacon’s battery
1. On the BTBeacon, hold down the red Power button for 2 seconds.
Result: The BTBeacon will power oﬀ. No lights on the unit will be on.
2. Turn the BTBeacon over. Using a hex key, remove the 3/8” screws holding the case together.
3. Carefully separate the two halves of the BTBeacon case. There is a ribbon cable connecting the
motherboard in one half of the case, to the lithium-ion battery in the other half of the case.
4. Disconnect the ribbon cable from the motherboard.
5. The lithium-ion battery is attached to the case with adhesive tape. Gently remove the battery free
from the case.
Attention: When removing the battery, use soft tools and take care to not puncture or damage
the battery casing.
6. Properly dispose of the old battery.
7. Take a new battery and adhere it to the inside of the case.
Note: The adhesive tape must be heat resistant to function properly.
8. Connect the ribbon of the new battery to the motherboard.
9. Join the halves of the BTBeacon case and close the unit.
10. Fasten screws to the back of the BTBeacon case, sealing it.
11. Press the Power button down.
Result: The lights of the BTBeacon will ﬂash and the unit will turn on. The BTBeacon’s battery has
successfully been replaced.

Opening the case to remove the battery

Disconnecting the ribbon cable
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Adding new double sided tape, and insert new battery

Reconnecting the ribbon cable

Closing the case
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The BTServer is a closed system. Circumventing the security measures in place on the BTSystem for any
reason, including the installation of third party software on the BTServer, is explicitly not permitted.
Circumventing the security of the BTSystem will immediately void the warranty.
This policy is in eﬀect to protect the performance and stability of the BTSystem. Having third party
software installed might adversely aﬀect the BTSystem.
Note: If third party software must absolutely be installed on the BTSystem, please contact CAST or your
local BTE for a possible solution. If a BTE or CAST deems the software acceptable, they may arrange to
install it for you.
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In the event a user needs to switch from their main BT Server, to a backup BT Server, the following
procedure should be followed.
Note: Users should keep a backup of their related show ﬁles in the event they need to switch servers
during operation. Users can easily do this using BTBackup on their servers, or by manually copying the
ﬁles to a USB stick.
1. Only 1 instance of Motive, as well as BTEngine should be present on the network at any given time.
Therefore, the backup server should not have these modules open, or be disconnected from all
networks until needed.
The BlackTrax GUI, and BTWYG can be opened, with their ﬁles loaded on both servers at the
same time.
2. In the event of needing to switch servers, ensure the main BTServer has been disconnected from
it's associated networks.
3. On the Backup server, Launch Motive, with the correct ﬁle.
4. In the BTGUI launch BTEngine and Apply Changes.
From this point the show should be running as expected from the Backup Machine. Optionally, users
could have all modules and ﬁles running on the Backup Machine, with it completely disconnected from all
networks until the time of failover.
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The environment of the Space can have a great impact on the capacity of BlackTrax to function as
intended. The following precautions should always be remembered when installing the BTSystem to
minimize interference and make an optimal tracking environment.
Infrared interference: External infrared sources and reﬂections can cause interference with
BTCameras. For best results, ensure the venue is free from sunlight, lights which emit in the
infrared spectrum, infrared based devices, ﬁre, and highly reﬂective materials. For infrared sources
and reﬂections which cannot be removed from the venue, there are provisions within the software
to mask out the aﬀected areas of the BTCamera's ﬁeld of view.
Note: Infrared interference is more of a concern during the BTCamera calibration than during
tracking operation. Since the BTSystem looks for a unique signal during tracking, there is some
tolerance for other infrared sources.
Reﬂective surfaces: A venue that possess material that is reﬂective might reﬂect and mimic a
BTBeacon’s unique LED pulse, creating errors with tracking. It is recommended complex objects
inside the tracking area are covered to block reﬂections. Reﬂective objects outside the tracking
area can be blocked out.
Cabling: When setting up Ethernet connected BTCameras, remember that they are subject to the
limitation of Ethernet communication standards. The total Ethernet connection between any
component to the BTServer can not be longer then 91.44m for BlackTrax to function correctly. This
range may be extended with a PoE switch to link cables together.
Camera stability: Ensure that the location where you choose to install BTCameras is stable,
sturdy and always stationary. Any movement of a BlackTrax camera will require recalibration of the
entire camera system.
Example: If a BTCamera is hung on a truss system which sways, the accuracy and performance of
the BTSystem will be aﬀected. If the sway is small, you can decrease accuracy in the system and
may be able to track at the cost of accuracy.
Camera blocking: Ensure that BTCameras have an unimpeded view of the intended tracking area.
Multiple BTCameras needs to see the same area at the same time for tracking to occur. Care
should be taken that temporary objects do not obscure tracking.

BlackTrax User Wiki

48

August 2017

BlackTrax System Overview
To install a BTCamera lens
Note: Only used on s250e and Slim 13E cameras.
Screw the lens onto the BTCamera with the included plastic lens tensioner between the M12 lens adapter
and the lens itself. Tighten until proper focus is achieved. Once the desired focus has been achieved,
hold the lens in place while tightening down the lens tensioner.

Note: The s250e comes with a spring for the lens instead of a tensioner. No tightening is required for
this lens.
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In order for tracking to function correctly, multiple BTCameras must be arranged to have overlapping
ﬁelds of view of the Space. A BTCamera ﬁeld of view is the part of the Space that is visible through the
BTCamera while the BTCamera is in a ﬁxed position and orientation.
Attention: It is recommended that cameras are not placed any closer than 1m apart to help ensure
optimal camera calibration. Good camera placement and orientation is absolutely critical to proper
operation of the BTSystem!
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Introduction
The following diagrams outline how the components of the BTSystem are connected and how data ﬂows
between the diﬀerent modules of the system.

BlackTrax detailed system diagram
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Embedded inside each BTServer is a BTX dongle which serves two principal uses. The primary function of
a dongle is to act as a key. The dongle is the only way that BlackTrax software will open and operate. The
dongle has dynamic embedded information that controls the level of the software you can open/use, as
well as the expiry date of the Membership Period. A BTX Dongle grants the server access to the
BlackTrax software package as well as a custom version of WYSIWYG for BlackTrax. The expiry date for
the BTX dongle is set for 20 years after the date of activation.
Secondly, a dongle is a security device used by CAST to prevent unauthorized use of the software and
protects an End User's work as well as their investment in the Product.
From time to time, CAST polls and tests technical performance of each Dongle to assure that it meets
CAST's standards, to validate and/or update each End User's Product Registration Information for security
purposes, and/or amend the security protocol embedded on it.
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In BlackTrax, when system information is saved, the information is saved to a general folder on the
BTServer. Information saved this way includes conﬁguration ﬁles and system lists from sub-processes.
By default this folder can be found at the following location, depending on your server version and
BlackTrax release version:
All BlackTrax Servers running v2.0.0 or later - C:\bt_run_time
BlackTrax Version 1 Server - C:\users\blacktrax\BlackTrax Conﬁguration Files
BlackTrax Version 2 Server - C:\users\btuser\BlackTrax Conﬁguration Files
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Important FCC Information
These devices comply with Part 15 of the FCC Rules. Operation is subject to the following conditions:
1. This device must not cause harmful, interference, and
2. This device must accept any interference received, including interference that may cause
undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications.
Certiﬁcate Numbers:
Model BTTKV01: Radio Cert. No.: IC: 10858A-BTTKV01
Model BTBCV01P: Radio Cert. No.: IC: 10858A-BTBCV01
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BTWYSIWYG is an award winning program that oﬀers lighting designers a customized 3D CAD, reporting
and pre-visualization application which is included in the BlackTrax software suite. Using BTWYSIWYG you
will create a virtual representation of the Space.
BTWYSIWYG exports this information as a .btx ﬁle, which is then used by BlackTrax as a blueprint for
tracking in the Space. If you are tracking with moving ﬁxtures, ﬁxture position and patching must also be
included in the .btx ﬁle.
When connected to BlackTrax, BTWYSIWYG can optionally act as a visualizer for what is happening in the
Space. Trackable and ﬁxture movement can be fully simulated, using information from BlackTrax or other
data sources.
The following section on BTWYSIWYG only covers features directly related to BlackTrax. For an in depth
understanding on BTWYSIWYG and its full capabilities, please refer to the current WYSIWYG Reference
Guide.
Tip: A registered BlackTrax Expert can be consulted to assist with any portion of a BlackTrax project,
including transfering information from BTWYSIWYG to BlackTrax.
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Creating a BTWYSIWYG Project from BlackTrax
When a new BTWYG project is created from BlackTrax, all necessary settings and conﬁgurations are
automatically applied to that new project. These template projects can be used to simplify the setup
process for BTWYSIWYG on new installations.
Result: Creating and launching the new BTWYSIWYG project from the BlackTrax File menu will
automatically start BTWYSIWYG in a state that is ready for BlackTrax use.
Note: We recommend to create and launch the new BTWYSIWYG project from the BlackTrax File menu
which is more convenient than having to manually create the new project and settings in BTWYG.
Creating a new BTWYSIWYG Project in BTWYSIWYG
The New command creates a new show document and will be saved as a ".wyg" ﬁle.
To create a new BTWYSIWYG project
1. In BTWYSIWYG, on the Welcome Screen, click File to choose New.
Result: The BTWYSIWYG opens a new show ﬁle in CAD.

BTWYG Welcome Screen
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Once you have all the information on the Space in BTWYSIWYG created, the information will need to be
saved as a BTWYSIWYG project ﬁle (.wyg). Save will save the open BTWYSIWYG project to the same ﬁle
name and location under which it was previously saved. If you are saving the project for the ﬁrst time,
this command will perform Save As.... Save As... is used to save the current project with a new ﬁle
name and/or a new destination.
To save the BTWYSIWYG project using Save
1. In BTWYSIWYG, from the File menu, click Save.
Result: A dialog window will appear.
2. In the window, navigate to where you want to save the project ﬁle.
3. In the File name ﬁeld type in the name of the project.
4. Click Save.
To save the BTWYSIWYG project using Save As...
1. In BTWYSIWYG, from the File menu, click Save As....
Result: A dialog window will appear.
2. In the window, navigate to where you want to save the project ﬁle.
3. In the File name ﬁeld type in the name of the project.
4. Click Save.
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To use BlackTrax you are required to create a virtual representation of the Space in BTWYSIWYG. This
virtual Space will possess vital information that BlackTrax requires: what the dimensions and tracking
area of the Space are, what objects or people you want BlackTrax to follow (Trackables), and information
on devices in use (e.g., ﬁxtures). This section will guide you on creating the Space in BTWYSIWYG and
aspects that have to be included.
Attention: To track with moving ﬁxtures in BlackTrax, the following mandatory steps must be taken in
the creation of the BTWYSIWYG ﬁle:
Deﬁne a common origin position in the Space.
Patch Trackables to a motion universe.
Hang moving ﬁxtures approximately where they will be in the venue.
Patch ﬁxtures to DMX universe, assign Spot IDs and assign avatars.
Patch DMX universes to console.
Patch all created universes to BlackTrax.
Save the BTWYSIWYG project.
Export the BTWYSIWYG project for use with BlackTrax.
Attention: If you are NOT using BlackTrax for tracking with moving ﬁxtures (e.g. moving lights) then
only the following steps need to be completed:
Deﬁne a common origin position in the Space.
Create avatars of Trackables.
Patch Trackables to a motion universe and assign avatars.
Patch all created universes to BlackTrax.
Save the BTWYSIWYG project.
Export the BTWYSIWYG project for use with BlackTrax.

BTWYG ﬁle with patched ﬁxtures and a trackable
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Origin introduction
Most objects in BTWYSIWYG are drawn as 3D objects, with width, depth, and height values using the
Cartesian coordinate system of 3 working axes, X, Y, and Z. The point where the 3 axes meet is called
the origin and the value of X, Y, and Z is 0 respectively (0,0,0).
By default the origin will be in the center of the WYSIWYG project. This default origin is called the
Document Origin. It is possible to move the origin from its default location to a new position. This origin is
called the User Origin.

CAD mode with a frame representing the default origin

Origin Requirements
The location of the origin is recommended to be inside the Space.
The origin should be easy to see and determine in the physical Space.
The origin in the phsyical space needs to be visible to at least 2 BTCameras for BTCamera
calibration to function.
The location of the origin needs to be consistent. The origin needs to be the same in the
BTWYSIWYG virtual Space, in Motive, in the physical Space and any Third Party Programs
connected to BlackTrax. Inconsistencies will cause errors in the BTSystem and any connected
downstream technologies.
The alignment of the ground plane in relation to the axes needs to be the same in the
BTWYSIWYG virtual Space, in Motive, and in the physical Space. It is recommend that the
following conventions are followed when aligning the origin:
The +Y axis directed Upstage.
The +X axis is directed Stage Left.
The +Z axis is directed vertically towards the ceiling.

Ruler Tool
The Ruler Tool helps you design your show ﬁle in the Wireframe views of the CAD mode, providing a
visual aid for coordinate reference and measurement. By default, the ruler is aligned with the document
origin and displays coordinate information along the top and left side of the view. Its scale matches the
default grid scale. The ruler has diﬀerent colors to represent diﬀerent axes (X=Red, Y=Green, Z=Blue).

X Axis Ruler
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Y Axis Ruler

Z Axis Ruler

Ruler Icons
Document Origin: The document origin icon appears when the Ruler’s zero position (origin) is aligned
with the Document Origin, which is set by default to be the center point of the BTWYSIWYG venue
deﬁned for the event.

Document Origin Icon
User Origin: The user origin icon appears when you have set a new User Origin for the ﬁle.

User Origin Icon
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Using the tools in BTWYSIWYG’s CAD mode, create an accurate scale representation of the venue the
Space is in. The suggested minimum level of detail is that it contain the ﬂoor, the walls and any pipes,
trusses or structural frames in which BTCameras or moving ﬁxtures will be attached. The more detailed
the venue, the better looking and accurate the visualization will be.
Attention: Fixtures need to be attached to pipe or truss to be inserted. You may also insert ﬁxtures on
the ﬂoor, but you won't be able to spin them using Fixture Properties.
Note: Due to the complexity of recreating an accurate representation of a venue, it is recommended
that the WYSIWYG User Guide’s chapter on The CAD environment is read for a thorough understanding.
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Objects or people that are to be tracked are called Trackables. An avatar of each Trackable needs to be
created in BTWYSIWYG. They can be represented by any scenic library object found in BTWYSIWYG, or by
any drawn object like a sphere or riser.
Important Note: As of BlackTrax v2.2, Trackables are automatically named and patched when created.
To create a Trackable in BTWYSIWYG
1. In BTWYSIWYG, in CAD mode, at the bottom of the screen click the Wireframe view tab.
2. From the Library menu, choose Browse Library.
Result: The Library Browser window will appear.
3. At the bottom of the Library Browser window click the Library Items (scenic) tab to view the
contents.
4. Navigate to the desired object you which to represent a Trackable.
Note: The actual look of the Trackable is purely cosmetic and will only represent the Trackable’s
position in the visualization.
5. At the top of the Library Browser, click the Insert tool.
Tip: You can also double-click on the object name.
6. To insert the object, click in your drawing.
7. To stop inserting the object, right-click in the drawing. In the menu that appears, click Finish
Library Item.
8. In the BlackTrax menu choose BT Trackable.
Result: The Enter new Axis name window appears.

9.
10.
11.
12.

13.
14.
15.
16.

In the window, select the layer for the Trackable from the Layer drop-down.
You can also mark the checkboxes to enable the other options for the layer display.
Click OK.
In your drawing, in the Trackable object, click where you want the Trackable to pivot.
Result: A Trackable object will appear where the mouse was clicked. The Trackable object is
represented as a Cartesian axis.
On the Trackable object you inserted into the drawing, right-click.
In the menu that appears, select Properties.
On the General tab, from the Attach to Axis drop-down list, select the unique name you created for
the Trackable object.
Click OK.

Result: The Trackable is created. It is represented as the inserted object and its motion is associated
with the BTTrackable.

Trackable object with a person attached
Note: It is possible to create multiple Trackables at once using the array tool in WYSIWYG. See the
Array section in the WYSIWYG Reference Guide for more information.
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Patching Trackables introduction
Important Note: As of BlackTrax v2.2, the Quick Motion Patch Tool is no longer required to patch
Trackables because Trackables are automatically named and patched when inserted.
After Trackables are created they need to be patched to a Motion Universe. The patch will allow the
visualization of Trackable movement to occur in BlackTrax. This section will show how to easily patch
Trackables using the Quick Motion Patch tool, as well as the manual way to patch each Trackable.
Note: It is recommended that the WYSIWYG User Guide’s chapter on Data mode is read for a complete
understanding of patching if manually assigning Trackables.

Quick Motion Patch Tool

Patching Trackables using the Quick Motion
Patch Tool
To patch all Trackables using the Quick Motion Patch Tool
1. From the BlackTrax menu, click on on Quick Motion Patch Tool.
2. Under the Auto-Patch Motion section, ensure that All Trackable/Axes is selected
3. Click Patch.
Note: If the motion universe BT-Trackables does not yet exist in the ﬁle, BTWYSIWYG will ask in a
dialog if you wish to create it. In the dialog click Yes to create the motion universe.
Result: The Trackables will be patched to the motion universe. The total number of Trackables
patched will be reported at the bottom of the window.
4. Click Close.

To patch only selected Trackables using the Quick Motion Patch Tool
1. Select all Trackables you wish to patch in one of the wireframe views
Tip: Remember that the Trackable is the Cartesian axis associated with the Trackable, not the
Trackable object itself
2. From the BlackTrax menu, click on on Quick Motion Patch Tool.
3. Under the Auto-Patch Motion section, ensure that Only Selected Trackable/Axes is selected.
4. Click Patch.
Note: If the motion universe BT-Trackables does not yet exist in the ﬁle, BTWYSIWYG will ask in a
dialog if you wish to create it. In the dialog click Yes to create the motion universe.
Result: The Trackables will be patched to the motion universe. The total number of Trackables
patched will be reported at the bottom of the window.
5. Click Close.
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To clear all Trackables' patch using the Quick Motion Patch Tool
1. From the BlackTrax menu, click on on Quick Motion Patch Tool.
2. Under the Clear Motion Patch section, ensure that All Trackable/Axes is selected.
3. Click Clear.
Result: All Trackables will be unpatched from the motion universe. The total number of patched
Trackables removed will be reported at the bottom of the window.
4. Click Close.

To clear only selected Trackables' patch using the Quick Motion Patch Tool
1. Select all trackables you wish to clear patch info for in one of the Wireframe views.
Tip: Remember that the Trackable is the Cartesian axis associated with the Trackable, not the
Trackable object itself.
2. From the BlackTrax menu, click on on Quick Motion Patch Tool.
3. Under the Clear Motion Patch section, ensure that Only Selected Trackable/Axes is selected.
4. Click Clear.
Result: All selected Trackables will be unpatched from the motion universe. The total number of
patched Trackables cleared will be reported at the bottom of the window.
5. Click Close.
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Any moving ﬁxtures that you want to follow Trackables need to be placed and hung in BTWYSIWYG. By
placing a ﬁxture, BlackTrax will be able to pull valuable ﬁxture information, such as the properties and
capabilities of the ﬁxture and its position in the venue.
Fixtures will need to be placed on the ﬂoor or connected to pipes or trusses to be hung. The position and
orientation of the ﬁxtures in BTWYSIWYG need to be close to where they will be in the actual Space for
tracking to work correctly.
Attention: Calibration can usually solve ﬁxtures being in incorrect locations or being orientated
backwards, but the calibration process will be very tedious. Physical ﬁxtures should match their virtual
ﬁxture orientation and location to make calibration easier.
Tip: To keep ﬁxture orientation consistent, make a note about which way a ﬁxture’s tail is facing. This
provides a good indication of which way the ﬁxture is hung.
Note: It is recommended that the WYSIWYG Reference Guide’s chapter on Hanging and focusing
ﬁxtures is read for a complete understanding on how to hang ﬁxtures.
Attention: Only devices that are capable of changing their pan and tilt values remotely are capable of
following Trackables.

To insert ﬁxtures in BTWYSIWYG
1. In BTWYSIWYG CAD mode, at the bottom of the screen, click the Wireframe view tab.
2. From the Library menu, choose Browse Library.
Result: The Library Browser window will open.
3. At the bottom of the Library Browser click the Fixture Tool.
4. In the menu that is now visible, double-click Manufacturer to select ﬁxtures by manufacturer name,
Type to select by ﬁxture type, or All to see all the ﬁxtures in alphabetical order.
Note: Alternately, you can use the Library Browser’s search function to locate the ﬁxture that you
want to insert. Simply type the name of the ﬁxture (or a partial name) in the search box at the top
of the Library Browser, and then click the Search icon .
5. Double-click the ﬁxture name.
Result: A ﬁxture with default settings for this type attaches to the cursor.
6. To change the properties of the ﬁxture before inserting, in the Library Browser right-click on the
ﬁxture name. In the menu that appears click Properties.
Result: A dialog box opens with a shaded view of the ﬁxture on the left and an image of its symbol
on the right. Change the properties as needed.
7. To place the ﬁxture, click over a hang structure.
Result: Copies of the ﬁxture will attach to hang structures when clicked. Continue placing this type
of ﬁxture by clicking on the other hang structures as desired.
8. Finish placing this ﬁxture type by right-clicking. In the menu that appears select Finish placing
ﬁxtures.
Note: Alternately entering ESC will ﬁnish placing ﬁxtures.
9. To place other ﬁxture types, repeat the above steps for each type.
Attention: It is recommended that ﬁxtures intended for tracking are not hanging
directly over the space. When placing moving ﬁxtures that are to follow Trackables, it is
recommended that ﬁxtures are not placed directly above the Space. Fixtures placed above the
space may run into pan and tilt range limitations when attempting to follow a Trackable.

Fixtures placed on a pipe
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To obtain the precise tracking in BlackTrax, the limitations of moving ﬁxtures must be taken into account.
The following section will guide you through known limitations of moving ﬁxtures in BlackTrax and
provide smart practices used to overcome these limits.
Attention: Do not place ﬁxtures that will track directly above the Space
A number of issues can occur if ﬁxtures are directly above the Space. If ﬁxtures are placed above the
Space and are following a Trackable which moves in a circular path underneath, this can cause ﬁxtures
to spiral and reach a pan stop.
Note: BlackTrax has a feature where if a ﬁxture pan-ﬂips, the ﬁxture will dim while performing the ﬂip.
This is in place to reduce the disruption caused by the pan-ﬂip during operation.
When a Trackable moves almost directly underneath a moving ﬁxture which is following it, the panmotion of the ﬁxture must be very fast in order to remain pointing at the Trackable. It is likely that the
moving ﬁxture will not be able to move quick enough to track in this way and a lag in tracking will occur.
Tip: Prediction algorithms can be selected when tracking to try and achieve speciﬁc tracking needs. See
Fixture Sensitivity for more information.
To avoid these problems, it is recommended that moving ﬁxtures are instead placed in front, behind, or
on the sides of the Space. This will limit the range of both pan and tilt movement needed by ﬁxtures to
follow a Trackable and avoid these potential problems.
Tip: If tracking must occur below a ﬁxture, a possible solution is to hang the ﬁxture sideways.

BlackTrax User Wiki

69

August 2017

BTWYSIWYG For BlackTrax

Patching ﬁxtures to BTWYSIWYG introduction
The patching of ﬁxtures as they appear in the connected console has to be recreated in BTWYSIWYG.
When tracking occurs, BlackTrax uses the DMX values generated by the console, but overrides the pan
and tilt channels with new values. These new values instruct the ﬁxture where it should be aimed so it
can follow a Trackable. If a ﬁxture is edited to have a persistent beam size, then the zoom and iris values
will change as well. The patching needs to be the same so that BlackTrax can override the correct DMX
universe and channels.
Attention: Each ﬁxture in the project will also need to be assigned an individual Spot ID number in
BTWYSIWYG. This Spot ID number will map to a ﬁxture ID on a connected lighting console. The ﬁxture ID
is used by the BTSystem to diﬀerentiate between ﬁxtures in the project.

To create a DMX universe
1. In BTWYSIWYG, in DATA mode, click the Patch layout tab at the bottom of the screen.
2. In the patch shortcut area on the right of the screen, right-click.
3. In the menu that appears select New Patch.
Result: A dialog box is displayed, prompting for the type of universe that you want to create, and
the name of the new universe.
4. Type the name of the patch universe.
5. Under Patch Universe Type, select DMX.
6. Click OK.
Result: The patch shortcut appears in the Patch tab.

DATA Mode with one DMX universe created

Fixture Patching Methods
There are multiple ways to patch ﬁxtures in BTWYSIWYG. The following section will guide you through
some of the simplest methods. For more information see the WYSIWYG User Guide’s chapter on Data
Mode.

To patch ﬁxtures and assign spot IDs using Quick Tools
Using Quick Tools, ﬁxtures can be patched and assigned spot IDs by clicking on their Wireframe view
image. The ﬁrst ﬁxture clicked will be assigned the patch and ID as conﬁgured in Quick Tools. The next
ﬁxture clicked will be assigned the next available channel in the patch and the next ﬁxture ID in the
sequence until you are ﬁnished using Quick Tools.
1. In BTWYSIWYG, in CAD mode, in Wireframe view, go to Tools > Quick Tools > Quick Tools.
Alternately click the Quick Tools icon in the Tools toolbar.
Result: The Quick Fixture Tool window will open.
2. In the Quick Fixture Tool window, in the Fixture Attributes section, mark the Spot checkbox.
3. In the Spot ﬁeld, enter a number which will be the ﬁrst ﬁxture ID used in the sequence.
4. In the Fixture Data section, mark the Patch check box.
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5. In the Patch ﬁeld, enter the universe and channel the ﬁrst ﬁxture will patching to, separated by a
period.
Example: “A.1” would patch to universe A, chapter 1.
6. Click Ok.
Result: When a ﬁxture is clicked on, it will be assigned a Universe and channel to operate on. The
ﬁrst ﬁxture clicked will be assigned the to the channel number entered in Quick Tools. Subsequent
ﬁxtures clicked will be assigned the next sequential channel and Spot ID number.
7. Click on a ﬁxture to patch it to a universe and channel. Clicking on each ﬁxture that you want
patched and assigned a spot ID.
8. To stop patching ﬁxtures, right click.
9. In the menu that appears, click Finish Quick Tools.

Quick Tools

To patch ﬁxtures and assign spot IDs using the data spreadsheet
In DATA mode, the Spreadsheet view has information on all ﬁxtures created in the BTWYSIWYG project.
Using the spreadsheet you can edit the patch information and Spot ID directly in the table.
1. In BTWYSIWYG, in Data mode, click on the Spreadsheet tab.
2. In the Columns section on the left side of the window, click All Data (Sortable).
Result: All ﬁxture data will be displayed in the spreadsheet.
3. In the Patch column, enter the appropriate patch information for each ﬁxture.
4. In the Spot column, enter a unique Spot ID for each ﬁxture.
Tip: It is possible to assign sequential values to ﬁxtures quickly by selected all ﬁelds for the
ﬁxtures you wish to edit (for example all spot ID ﬁelds for all ﬁxtures) and type the spot ID of the
starting ﬁxture and a '+' and hitting enter. For example 101+ will set the ﬁrst ﬁxture to spot 101,
and every ﬁxture after that will increase by 1. If this method is used to assign values, it is
recommended that ﬁxtures are ﬁrst sorted so ﬁxtures are organized. Fixtures can be sorted in
order of position, or Unit # along a pipe/truss. This can also be used for patching ﬁxtures as well.

DATA>Spreadsheet with ﬁxtures patched for BlackTrax
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BlackTrax requires that the patching information of the connected console be recorded in BTWYSIWYG.
This will inform BlackTrax which console is in use and which ports will transmit information.

To patch the DMX universe to a console
1. In BTWYSIWYG, in LIVE mode, go to the Managers menu and click Device Manager....
Result: The Device Manager dialog window is displayed.
2. In the Device Manager window, click New.
Result: The Library Selection window is displayed.
3. Navigate through the console library until you ﬁnd the console or device that you are connecting
to. Click the console name to highlight it.
4. Click Insert.
Result: The console appears in the Device Manager window.
5. With the console name still selected, click Properties.
Result: The Properties dialog window is displayed.
6. From the Protocol drop-down list, select the protocol used by the console.
Result: The console model is displayed in the Model ﬁeld. The name of the console is displayed in
the Name ﬁeld.
7. In the Address ﬁeld, type the designated address of the console, if applicable.
8. You must bind output ports from the console to BTWYSIWYG patch universes. Bind a Port output to
the appropriate universe by clicking the Universe ﬁeld next to the output.
Result: A drop-down list of available Universes is displayed.
9. Select the appropriate Universe from the list.
10. Repeat the above steps to bind all ports to their appropriate patch universes.
11. Click Close to close the Properties window.
12. Click Close to exit the Device Manager window.
Result: BlackTrax will know which console will be connected and which ports will transmit
information

Device Manager with an Art-Net device and a BlackTrax console

Art-Net Device Properties with patched universes
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After universes are created, be it motion or DMX, this information will need to be patched to BlackTrax.
This will inform BlackTrax which of its ports are in use and which ports will transmit information.
To patch universes to BlackTrax
1. In BTWYSIWYG, in LIVE mode, go to the Managers menu and click Device Manager....
Result: The Device Manager dialog window is displayed.
2. In the Device Manager window, click New.
Result: The Library Selection window is displayed.
3. In the Library Selection window, in the Search ﬁeld, type BlackTrax Network and then click the
Search icon.
Result: The device BlackTrax Network will be displayed in the search results.
4. Click on BlackTrax Network from the list to highlight it, then click Insert.
Result: The BlackTrax Network appears in the Device Manager.
5. With the BlackTrax Network name still selected, click Properties.
Result: The Properties dialog window is displayed.
6. You must bind output ports from the BlackTrax Network to BTWYSIWYG patch universes. Bind a
Port output to the appropriate universe by clicking the Universe ﬁeld next to the output.
Result: A drop-down list of available Universes is displayed.
7. Select the appropriate Universe from the list.
8. Repeat the above steps to bind all ports to their appropriate patch universes.
9. Click Close to close the Properties window.
10. Click Close to exit the Device Manager.
Result: BlackTrax will know what ports are in use.

Device Manager with an Art-Net device and a BlackTrax console

The BlackTrax Console with Motion and DMX universes patches
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After creating and saving the BTWYSIWYG project as a .wyg ﬁle, BlackTrax requires that the information
be converted. The conversation will take all the valuable information that was put into the BTWYSIWYG
project, and put it into the .btx format that BlackTrax understands.
To convert a .wyg ﬁle to a .btx ﬁle
There are 3 methods for creating a .btx ﬁle in BTWYSIWYG:
BTX Apply in LIVE mode
BTX Export in CAD mode
BTX Apply in CAD mode
Method 1: BTX Apply in BTWYSIWYG LIVE mode
1. In BTWYSIWYG, in LIVE mode open the BlackTrax window.
2. Ensure that the BlackTrax GUI is open, and BTWYSIWYG is connected to it.
3. In the BlackTrax window of BTWYSIWYG , click BTX Apply.
Result: BTWYSIWYG will send the .btx ﬁle to the BlackTrax GUI, where it can be applied to
the current project.
Method 2: BTX Export in BTWYSIWYG CAD mode
1. In BTWYSIWYG, in CAD mode from the File menu, click BTX Export.
Result: A dialog window will appear.
2. In the window, navigate to where you want to save the project ﬁle.
3. In the File name ﬁeld type in the name of the project.
4. Click Save.
Result: The BTWYSIWYG ﬁle (.wyg) will convert to the BlackTrax format (.btx) and be saved
as a separate ﬁle.
Note: If the ﬁle fails to convert, an error message will appear alerting you to why it failed.

BlackTrax Menu found in CAD mode
Method 3: BTX Apply in BTWYSIWYG CAD mode
1. Ensure that the BlackTrax GUI is open, and BTWYSIWYG is connected to it.
2. In BTWYSIWYG, in CAD mode and from the BlackTrax menu, click BTX Apply.
Result: BTWYSIWYG will send the .btx ﬁle to the BlackTrax GUI, whre it can be applied to the
current project.


LIVE mode showing the BlackTrax panel with BTX Apply
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In BTWYSIWYG three-dimensional areas, called Zones, can be drawn inside the virtual representation of
the Space. Zones are an incorporeal volume and can only be viewed in BTWYSIWYG, but when created
exist simultaneously in the virtual and physical Space. Zones are available in rectangular, cylindrical and
spherical shapes of any size.
BlackTrax has a number of preset interaction between Zones and ﬁxtures, which can be accessed in the
Chapter section of BlackTrax. For more information see To enable a Zone for a Fixture.

To draw a Rectangular Zone
1. In BTWYSIWYG, in CAD mode, click the Wireframe view tab.
2. From the BlackTrax menu, go to BT Zone > Rectangular Zone.
Result: The New Rectangular Zone window will open.
3. In the New Rectangular Zone window, in the Width ﬁeld, enter in the width of the Zone.
4. In the Depth ﬁeld, enter in the depth of the Zone.
5. In the Height ﬁeld, enter in the depth of the Zone.
Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.
6. In the Zone Name ﬁeld, enter in a unique name for the Zone.
7. Click OK.
Result: The Zone will be inserted into the Space. It can be repositioned by dragging and dropping
where needed. The dimensions of the Zone can be altered by manipulating the Zone directly, or by
right clicking the Zone and selecting Properties.

BTWYG drawing with a Rectangular Zone selected
To draw a Cylindrical Zone
1. In BTWYSIWYG, in CAD mode, click the Wireframe view tab.
2. From the BlackTrax menu, go to BT Zone > Cylindrical Zone.
Result: The New Cylindrical Zone window will open.
3. In the New Cylindrical Zone window, in the Height ﬁeld, enter in the height of the Zone.
4. In the Horizontal Radius ﬁeld, enter in the horizontal radius of the Zone.
5. In the Vertical Radius ﬁeld, enter in the vertical radius of the Zone.
Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.
6. Lock Ratio controls the aspect ratio of the radius. This feature is enabled by default. To disable,
unmark the check box next to Lock Ratio.
7. Number of Segments controls how many segments make up the radius of the cylindrical Zone. The
default is set to 16. To change the number of segments, unmark the check box next to Use
Document Defaults. Enter in the new segment number in the ﬁeld.
8. Note: The maximum number of segments allowed is 40.
9. In the Zone Name ﬁeld, enter in a unique name for the Zone.
10. Click OK.
Result: The Zone will be inserted into the Space. It can be repositioned by dragging and dropping
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where needed. The dimensions of the Zone can be altered by manipulating the Zone directly, or by
right clicking the Zone and selecting Properties.

BTWYG drawing with a Cylindrical Zone selected
To draw a Spherical Zone
1. In BTWYSIWYG, in CAD mode, click the Wireframe view tab.
2. From the BlackTrax menu, go to BT Zone > Spherical Zone.
Result: The New Spherical Zone window will open.
3. In the New Spherical Zone window, in the Horizontal Radius ﬁeld, enter in the horizontal radius of
the Zone.
4. In the Vertical Radius ﬁeld, enter in the vertical radius of the Zone.
Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.
5. Lock Ratio controls the aspect ratio of the radius. This feature is enabled by default. To disable,
unmark the check box next to Lock Ratio.
6. Number of Segments controls how many segments make up the radius of the spherical Zone. The
default is set to 12. To change the number of segments, unmark the check box next to Use
Document Defaults. Enter in the new segment number in the ﬁeld.
Note: The maximum number of segments allowed is 40.
7. In the Zone Name ﬁeld, enter in a unique name for the Zone.
8. Click OK.
Result: The Zone will be inserted into the Space. It can be repositioned by dragging and dropping
where needed. The dimensions of the Zone can be altered by manipulating the Zone directly, or by
right clicking the Zone and selecting Properties.

BTWYG drawing with a Spherical Zone selected
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In BlackTrax tracking only occurs if two or more BTCameras can see a BTBeacon at the same time.
Therefore, when placing BTCameras, there needs to be some overlap between what each BTCamera
sees.
It is recommended that BTCameras are ﬁrst placed and aimed in BTWYSIWYG before they set up in the
physical Space. This step is optional and will not aﬀect your BlackTrax project. Planning BTCamera
placement in BTWYSIWYG will only help you to test the BTCamera’s coverage of the venue and
determine how best to position them. It is recommended that cameras are not placed any closer than 1m
apart to help ensure optimal camera calibration.
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To place a BTCamera in BTWYSIWYG
1. In BTWYSIWYG, in CAD mode, click the Wireframe view tab.
2. From the Library menu, choose Browse Library.
Result: The Library Browser window will open.
3. At the bottom of the Library Browser window, click the Fixture tool .
4. In the menu that is now visible, double-click Manufacturer to select ﬁxtures by manufacturer
name, Type to select by ﬁxture type, or All to see all the ﬁxtures in alphabetical order. BlackTrax
ﬁxtures can be found in Manufacturer under CAST, in Type under BlackTrax.
Note: Alternately, you can use the Library Browser’s search function to locate the ﬁxture that you
want to insert. Simply type the name of the ﬁxture (or a partial name) in the search box at the top
of the Library Browser, and then click the Search icon .
5. Double-click on the name of the BTCamera that you want to insert.
Result: A ﬁxture with default settings for this type attaches to the cursor.
6. To change the properties of the ﬁxture before inserting, such as the lens size, right-click on the
ﬁxture name, and then click Properties.
Result: A dialog box opens with a shaded view of the BTCamera on the left and an image of its
symbol on the right. Use the Appearance tab to change the lens settings for the Camera. Options
are 5.5 mm, 8.0 mm, 3.5 mm for Slim 13E. For s250e BTCameras options are 5.5 mm, 8.0 mm.
7. To place the BTCamera, move the mouse over a hang structure, and then click. Continue placing
this type of ﬁxture by clicking on the other hang structures as desired.
8. Finish placing this ﬁxture type by right-clicking, and then choosing Finish placing ﬁxtures from
the resulting menu.
Result: The BTCameras will be hung in the virtual Space. The BTCameras will emit a red beam to
represent their ﬁeld of vision.

To aim a BTCamera in BTWYSIWYG
1. In BTWYSIWYG, in CAD mode, click the Wireframe view tab
2. In the Wireframe view, right-click on a BTCamera.
3. In the menu that appears, select Properties....
Result: The Properties window for the BTCamera will appear.
4. In the Properties window, in the Fixture tab, enter in new values in the Pan and Tilt ﬁelds to
reposition the BTCamera.
5. Click Apply.
6. Click Ok.
Result: The BTCamera will orientate itself based on the new Pan and Tilt values. The BTCamera’s
new ﬁeld of view will be shown.
Note: The focus tool can also be used to aim BTCameras in BTWYSIWYG. See the section on Quick
focus in the WYSIWYG Reference Guide for more information.

Example of BTCamera Placement
In CAD mode, BTCameras can be hung in the venue exactly the same as ﬁxtures, from any pipe or truss.
In this example BTCameras are hung around the perimeter on pipes represented in yellow, a mannequin
in orange is at the origin of the room.
When BTCameras are hung, the BTCamera’s ﬁeld of view will correctly project in the visualization. A
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BTCamera ﬁeld of view of in BTWYSIWYG is depicted as a red beam Everything in the red beam is what
the BTCamera can see.
Tracking can only occur when two or more BTCameras see the same area at the same time. By selecting
multiple BTCameras, we can see their ﬁeld of view and where their vision overlaps. Overlapping views
are depicted in BTWYSIWYG as a deeper red then an individual view.
Two BTCameras whose ﬁeld of view are overlapping. The deeper red in the center is the overlapping area
where tracking can occur.
By placing BTCameras in BTWYSIWYG and viewing their projected ﬁeld of view, it is easy to determine
where BTCameras should go and how they should be aimed to maximize the tracking area in the venue.
Any gaps in coverage where tracking cannot occur will also be shown. Once the position and orientation
of BTCamera has been determined, you can record the data to reproduce the BTCamera placement in
the actual venue.
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BlackTrax projects can be visualized within BTWYSIWYG, allowing ﬁxture and Trackable interactions to be
simulated in the BTWYSIWYG virtual Space. Fixtures or Trackables when selected in BlackTrax will be
selected in BTWYSIWYG. BTWYSIWYG, Motive and BlackTrax will need to each be open and running the
project ﬁle for visualization to work correctly.

To visualize BlackTrax activity in BTWYSIWYG
1. In BlackTrax, have the BlackTrax project ﬁle open.
2. In BTWYSIWYG, in LIVE mode, go to the BlackTrax panel.
Note: To open the BlackTrax panel if closed, from the Live menu, select BlackTrax.
Result: The BlackTrax panel will appear on the right side of the BTWYSIWYG window.
3. Mark the check box next to BTX Mode.
4. With BlackTrax running, click Connect.
Result: Activity in BlackTrax will now be visualized in BTWYSIWYG.
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BTWYSIWYG can visualize the tracking data. This can be useful for troubleshooting. Seeing ﬁxtures and
Trackables move in BTWYSIWYG based on the data can help determine if data is actually being
transmitted. If there is no activity in BTWYSIWYG there could be problems in the BTSystem connections.

To visualize tracking data in BTWYSIWYG
1. In BTWYSIWYG LIVE mode, from the Live menu, select BlackTrax Panel to open the BlackTrax
panel.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.

2. In the BlackTrax panel, mark the BTX Mode checkbox to enable the option to connect with
BlackTrax.
3. Click Connect to activate the connection with BlackTrax, or click Disconnect to deactivate the
connection to BlackTrax.
Note: The BlackTrax template ﬁle connects automatically to BlackTrax when opened.
4. To customize how you interact with Trackables within Shaded view, select from the following
options:
Display Mode: From this drop-down, select Beacon Focused or Trackable Focused.
Beacon Focused: Displays all LEDs and Centroids regardless of Trackable patch in
BlackTrax. This mode hides all objects attached to Trackables in BTWYSIWYG.
Trackable Focused: Displays only LEDs and Centroids that are actively patched to a
Trackable in BlackTrax. This mode also displays objects attached to the Trackable in
BTWYSIWYG.
Select Trackable Objects Only: Mark this checkbox to select only Trackable objects in the
Shaded view of BTWYSIWYG.
Prefer Frame LEDS: Mark this checkbox to display only Rigid or Soft Frame's LEDs and
Centroids. When enabled, Classic and Mini Beacons will not be displayed in the Shaded view
if they are currently assigned to a Rigid or Soft Frame.
5. To set how the ﬁxtures and their beams are displayed and selected in Shaded view, select from the
following options:
Show Lighting For: From this drop-down, select which beams of the ﬁxtures will be displayed.
All Fixtures: Displays all the beams of the ﬁxtures in the BlackTrax project.
Tracking Only: Displays only the beams of the ﬁxtures that are currently following
Trackables.
No Fixtures: No beams of the ﬁxtures will be displayed.
Calibrated Fixture Position: Mark this checkbox to show the position of the ﬁxture as
calibrated by BlackTrax instead of using the BTWYSIWYG drawn position.
Show Beams With Stick: Mark this checkbox to display the beams of light produced by the
ﬁxtures as stick beams with the corresponding colors indicating their tracking status.
Currently Tracking: Mark this checkbox to display only the stick beams of the ﬁxtures
connected and actively following a Trackable in a BlackTrax chapter. This stick beam
appears in green color.
Currently Standby: Mark this checkbox to display only the stick beams of the ﬁxtures
that are connected to the system and are set to follow a Trackable in a BlackTrax
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chapter. This stick beam appears in blue color.
Unassigned: Mark this checkbox to display only the stick beams of the ﬁxtures that are
connected to the system but not set to follow a Trackable in any BlackTrax chapter.
This stick beam appears in amber color.
6. Mark the Enable Message Log checkbox to activate the message logging options.
Log To File: Mark this checkbox to record the log information and automatically store into a
ﬁle in the "bt_run_time" folder of your local drive.
Log Data: Mark this checkbox to record the motion tracking information as it is displayed in
the message box.
Clear Log: Click this button to clear the message box.

Viewing LEDs and Centroids in Shaded View of BTWYSIWYG

How LEDs of a Beacon are displayed in Shaded view:
An LED appears as a solid circle when in front of everything in Shaded view.
An LED appears as a circle outline when behind an object in Shaded view.
An LED appears in the color that is identical to the Beacon color in BlackTrax.
When an LED is selected, its color turns to white and the text label identiﬁcation appears. For
example, the screenshot (above) shows "L:101.4" which indicates LED of Beacon 101 and LED no.
4.
How Centroids are displayed in Shaded view:
A Centroid appears as a solid square object when in front of everything in Shaded view.
A Centroid appears as a square outline when behind an object in Shaded view.
A Centroid appears in the color that is identical to the Beacon color in BlackTrax.
When a Centroid is selected, its color turns to white and the text label identiﬁcation appears. For
example, the screenshot (above) shows "C:Whiteboard(101)" which indicates the Centroid
associated with Beacon 101 is patched to the Whiteboard trackable.
When a Centroid is selected, the LEDs associated with the Centroid are automatically selected.
The Centroid appears with only a number if it is not patched to a Trackable.

Using the Trackables and Beacons Widget
The Trackables and Beacons widget is an easier, convenient and faster way to ﬁnd and select LEDs and
Centroids in the Shaded view of BTWYSIWYG.

To use the Trackables and Beacons widget
1. In BTWYSIWYG LIVE mode, from the Live menu, select Trackables and Beacons to open the
Trackables and Beacons panel.
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Result: The Trackables and Beacons panel appears and displays the list of Trackables,
Beacons and Frames associated with the connected BlackTrax project.
2. In the Trackables and Beacons panel, click on the arrow at the far left of the list of Trackables,
Beacons or Frame to expand or collapse the corresponding list below them.
3. In the Trackables and Beacons panel, click on a single or multiple Trackables, Beacons or Frame to
select in the Shaded view.
Result: In the Shaded view, the selected Trackable(s) or Beacon(s) or Frames will turn to
white with the corresponding text label identiﬁcation.
Note: You can activate Shaded View Selection by pressing TAB while in CAD, Design or Live mode >
Shaded View. Once you press TAB, a purple message at the top right-hand corner of the Shaded view
window appears: "Shaded View Select ON", and you may click on the objects in Shaded view to select.
Please refer to the "Using Shaded View Selection" section in the current WYSIWYG Reference Guide.

BlackTrax User Wiki

86

August 2017

BTWYSIWYG For BlackTrax
Once ﬁxtures have their position calibrated in BlackTrax, this information can be used to improve
visualization in BTWYSIWYG. The position of ﬁxtures in BTWYSIWYG will change to the calibration
locations, creating a more accurate visualization.

To use calibrated ﬁxture positions in BTWYSIWYG
1. In BlackTrax, have the BlackTrax project ﬁle open.
2. In BTWYSIWYG, in LIVE mode, go to the BlackTrax panel.
Note: To open the BlackTrax panel if closed, from the Live menu, select BlackTrax Panel.
Result: The BlackTrax Panel will appear on the right side of the BTWYSIWYG window.
3. Mark the checkbox next to BTX Mode.
4. Click Connect.
5. Mark the checkbox next to Calibrated Fixture Position.
Result: The position of ﬁxtures in BTWYSIWYG will change to reﬂect the calibration data created in
BlackTrax.
Note: For details on how to calibrate ﬁxtures, see Fixture Calibraton page.
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When visualizing in BTWYSIWYG, the beams of light produced by ﬁxtures can be changed to be
represented by stick beams. This can be useful for reducing clutter and confusion in the visualization and
help to determine where ﬁxtures are aiming and which ﬁxtures are selected.

To use ﬁxture stick beams in BTWYSIWYG
1. In BlackTrax, open the BlackTrax project ﬁle.
2. In BTWYSIWYG, in LIVE mode, go to the BlackTrax panel.
Note: To open the BlackTrax panel if closed, from the Live menu, select BlackTrax Panel.
Result: The BlackTrax panel will appear on the right side of the BTWYSIWYG window.
3. Mark the checkbox next to BTX Mode.
4. Click Connect.
5. Mark the checkbox next to Show Beams With Stick.
Result: Fixture beams will be represented as sticks in BTWYSIWYG.
6. To toggle speciﬁc stick beams on or oﬀ, unmark the checkbox next to the desired stick beam status
(Currently Tracking, Currently Standby, or Unassigned).

Understanding Stick Beam Colors
The color of a stick beam is used to communicate information about the parent ﬁxture at a glance.
A Green stick beam means a ﬁxture is connected to the system, there is a chapter created in
BlackTrax where it follows a Trackable and it is currently following a Trackable - Currently Tracking.
A Blue stick beam means a ﬁxture is connected to the system, there is a chapter created in
BlackTrax where it follows a Trackable, but it currently is not set to follow a Trackable - Currently
Standby.
An Amber stick beam means that a ﬁxture is connected to the system, but there is no chapter in
BlackTrax where that ﬁxture is told to follow Trackables - Unassigned.
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The Motive module is used to manage and control BTCameras. Motive is part of the BlackTrax software
suite and is already installed on the BTServer and is ready for you to use. The following section will guide
you though speciﬁc steps on how to use Motive to conﬁgure BTCameras to work in the Space and
function with the BTSystem.
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Depending on your tracking needs, the type of BTCameras used in your BTSystem will vary. Each model
of BTCamera has slightly diﬀerent settings in Motive. Due to these diﬀerent settings, steps outlined in
this manual may be slightly diﬀerent depending on what BTCamera is in use.
Diﬀerences include speciﬁc properties of the BTCamera found in Motive in the Cameras window, and the
BTCamera’s view found in the Camera Preview window.
Note: All BTCameras are capable of tracking.
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BTCamera introduction
BTCameras are required to be conﬁgured in certain ways to complete speciﬁc tasks: tracking objects,
referencing the BTCamera’s real-time location or aiming BTCameras. These settings can be entered in
manually, or automatically conﬁgured by selecting a preset from the Preset menu in Motive. The follow
tables explain what BTCamera settings are changed when you select a preset.

SLIM 13E presets

S250e SLIM presets

To select a preset setting for a BTCamera
1. In Motive go to the Cameras window. To open the window, go to the View menu and select
Cameras.
2. In the Cameras window, select a single BTCamera, or select all BTCameras in the group by clicking
the group name.
3. At the top of the Cameras window, select the desired preset from the Preset drop-down menu.
Result: The selected BTCameras will have their settings changed to that of the selected preset.
Note: The s250e BTCameras have been custom designed for BlackTrax, which removes the
illumination ring.
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BTCameras must be connected to the BTSystem for tracking to occur. The connection status of
BTCameras can be determined in the Devices window in Motive.

To determine if BTCameras are connected
1. In Motive, open the Devices window. To open the window, go to the View menu and select
Devices.
Result: In the Devices window, all connected BTCameras will be displayed under the Cameras
group.
Note: If a BTCamera is not visible in the Devices window, check the physical connections to see if
any BTCameras are disconnected.
Tip: To help identify BTCameras, you can click on a BTCamera in the Devices window, and the
corresponding BTCamera’s feed will ﬂash yellow in the Camera Preview window.
2. Close the Devices window.
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For tracking to occur, BTCameras have to be positioned around the perimeter of the tracking area and
aimed at the area. Tracking occurs in an area when 2 or more BTCameras view the same area at the
same time. A video feed of what BTCameras see is shown in Motive. By viewing the BTCamera’s video
feed in the visible spectrum, BTCamera positioning can be evaluated.
Attention: The Space origin must be visible to at least 2 BTCameras for camera calibration to function
correctly.
Note: To quickly see a BTCamera’s video feed in the visible spectrum, change the preset setting of the
BTCamera to Reference. See To select a preset setting for a BTCamera for more information.

To view a BTCamera’s video feed in the visible spectrum
1. In Motive go to the Cameras window. To open the window, go to the View menu and select
Cameras.
2. In the Cameras window, select a single BTCamera, or select all BTCameras in the group by clicking
the group name.
3. With the BTCamera(s) selected, look below to the Property section of the Cameras window.
4. Under the Camera Settings heading, set the Filter Type Switch ﬁeld to Visible Spectrum.
5. Set the Video Type ﬁeld to MJPEG Mode.

Result: The video displayed from the BTCameras will appear as a gray scale image in the visible
spectrum.
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BTCameras have an Aim Assist button to help with aiming BTCameras. When pressed, the BTCamera
video feed will be selected and prominently displayed in Motive. The BTCamera video feed will change so
that the Space shown is in the visible spectrum, and the exposure will be increased for a brighter image .
This should help in correctly aiming the BTCameras. Pressing the Aim Assist button a second time will
return the BTCamera’s video feed to its previous settings.

To toggle Aim Assist on BTCamera
With the BTCamera connected to the BTSystem, and with Motive operating, push the Aim Assist button
on the side of the BTCamera, above the Ethernet port.
Result: In Motive, the BTCamera will be selected and its live video feed prominently displayed. The
BTCamera’s video feed will be toggled between it’s current settings and Aim Assist mode.
Aim Assist location
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A BlackTrax project requires speciﬁc information (camera, calibration and conﬁguration) from Motive,
that is unique to every BlackTrax project. This information is required every time BlackTrax operates. A
Motive project ﬁle (.ttp) should be created to contain all this needed information.
New Project will create a new Motive project folder with the new project document (.ttp ﬁle) and all its
associated ﬁles automatically stored within the My Projects folder, or you may specify a diﬀerent folder
path for the new project folder. Specify the name and save the new Motive project.
Notes:
When a new Motive project is created from BlackTrax, all necessary settings and conﬁgurations are
automatically applied to that new project. These template projects can be used to simplify the
setup process for Motive on new installations.
We recommend to create and launch the new Motive project from the BlackTrax File menu which is
more convenient than having to manually create the new project and settings in Motive.
Save Project will save the open Motive project to the same ﬁle name and location under which it was
previously saved. If you are saving the project for the ﬁrst time, this command will perform as Save
Project As... . Save Project As... is used to save the current project with a new ﬁle name and/or a new
destination.

To save a Motive project to a new location and/or using a new ﬁle name
1. In Motive, go to the File menu and select Save Project As....
Result: The Save As dialog box will appear.
2. In the File Name ﬁeld, type the name of the project.
3. Click Save.

To save an existing Motive Project using the same location and ﬁle name
In Motive, go to the File menu and select Save Project.

To load a Motive Project
1. In Motive, go to the File menu and select Open....
Result: The Open dialog box will appear.
2. In the Open dialog box, navigate to where the desired .ttp ﬁle is saved. Click on the ﬁle to select it.
3. Click Open.
Result: The .ttp ﬁle will load. Its information and settings will load into Motive.
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After BTCameras are placed and orientated with overlapping views around the Space, BlackTrax requires
that all BTCameras be calibrated. Calibration enables BlackTrax to know BTCamera positions relative to
each other and the ﬂoor. This spatial awareness of the Space is required for tracking to be accurate.
Before BTCamera calibration can occur, certain settings in Motive need to be conﬁgured.
To conﬁgure BTCameras for calibration
1. Change the Motive layout to Calibration (found under Layout > Calibration).
2. Go to the Cameras window.
Note: To quickly conﬁgure a BTCamera for calibration, change the preset setting of the BTCamera
to Tracking, then proceed to Step 3 in this section.
In the Cameras window, select the camera group by clicking on the group name.

While the camera group is still selected, look below to the Property section for the camera
group. Under the Camera Settings heading, set the Video Type ﬁeld to Precision Mode/Object
Mode.
Set the Filter Type Switch ﬁeld to Infrared Spectrum.
3. Go to the Application Setting window.
In the Application Setting window, in the Options tab, under the Application Options heading,
set the Active Marker Labeling ﬁeld to False.

Close the Application Setting window.
4. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.
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Masking is a function in Motive where an area of the BTCamera’s vision is masked (blocked from view).
This will tell the system to ignore the masked section when looking for infrared sources. This is used
primarily to mask outside infrared interference that can confuse the system during BTCamera calibration.
Excessive masking may limit a BTCamera ﬁeld of view, as a masked area makes a BTCamera blind to
tracking in that area. It may be more beneﬁcial to reposition BTCameras to create diﬀerent ﬁelds of view,
rather then masking in extreme cases of infrared interference.
Attention: Infrared interference must be masked before calibration for calibration to be successful.
Masking will be diﬀerent depending if Motive is conﬁgured for active or passive markers.

To automatically mask all visible infrared sources from all BTCameras
Attention: Automatic masking will remove all previous masks from the BTCamera.
1. In Motive, go to the Camera Preview window.
2. In the Camera Preview toolbar, click the Block Visible Markers button.
Result: All currently visible infrared sources will be masked. Any previously created masks will be
removed. If additional sections need to be masked, use manual masking techniques.

To clear all masks from all BTCameras
1. In Motive, go to the Camera Preview window.
2. In the Camera Preview toolbar, click the Clear Blocking button.
Result: All masking will be cleared from all BTCameras.

To manually mask a BTCamera view
1. In Motive, go to the Camera Preview window.
Result: What each connected BTCamera sees is displayed as a 2D image in the Camera View
window. If BTCameras are conﬁgured to see infrared sources, they will appear as white objects.

2. In the Camera View toolbar, select the shape of the mask, either Rectangular Blocking, or Circular
Blocking from the toolbar.
Result: When making you will create masks in the chosen shape.

3. Click inside the Camera View window of a BTCamera. Mask the infrared interference areas by
clicking in one corner of the interference, and while holding the left mouse button down, dragging
the mask to cover the infrared interference.
Result: The infrared interference (white object) will be covered in by a mask (red object). While
masked, the infrared source will not interfere with tracking.
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4. Repeat for each instance of infrared interference.

5. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.
Note: You must ﬁrst clear the orientation of the camera before applying masks (if applicable).
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BTCamera calibration introduction
When BTCameras are initially placed in the Space, or if they are moved after set up, or bumped
accidentally, calibration of BTCameras is required. BTCamera calibration enables the system to
determine where the BTCameras are in relation to each other using the calibration wand, and where they
are in relation to the origin using the ground plane.
Proper calibration is very important, as incorrect calibrations will give incorrect position data and
negatively inﬂuence BTSystem accuracy.
Attention: Anytime a BTCamera is moved or bumped, BTCamera calibration will have to be performed
and saved to the Motive project ﬁle. See Working with Recordings for details saving and playing back
Motive recordings.

Diﬀerences between Full calibration and
Reﬁne calibration
There are three ways to calibrate BTCameras, a Full calibration, a Reﬁne calibration, and a Partial Reﬁne
calibration.
Full: Calibrates BTCameras using no previous information. This calibration is always used when
using BlackTrax in a new Space.
Reﬁne: This calibration method uses existing information from a previously saved calibration as a
foundation. When BTCamera calibration is performed, it builds upon the previous calibration and
corrects any errors. This calibration method is primarily used when BTCameras are moved slightly
after an initial calibration and need correction.
Partial: This calibration method uses existing information from a previously saved calibration as a
foundation. The user selects either a Full or a Reﬁne calibration type as above, and is able to
select a number of cameras to peform the partial calibration upon. When BTCamera calibration is
performed, it builds upon the previous calibration and corrects any errors. This calibration method
is primarily used when some BTCameras are moved slightly after an initial calibration and need
correction, but not the entire camera rig.

Wand calibration
Wand calibration enables BlackTrax to determine the relative position of BTCameras to each other in the
Space. This is then followed by ground plane calibration, which enables BlackTrax to determine the
BTCamera’s potion to the ground. See Ground Plane calibration below for more information.
Note: When wanding is started, Motive will start recording the wanding and auto save it to the session
folder.

To calibrate BTCameras with the calibration wand
1. In Motive, go to the Calibration layout by going to Layout > Calibration.
1. Go to the Camera Calibration pane.
2. Choose either a Full or Reﬁne calibration based on the guidelines above.
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3. In the Calibration tab, under the Wand Option heading, set the OptiWand sub-heading to
Custom.
4. Set the Wand Length (mm) ﬁeld to 1000.
5. Set the Center Distance (mm) ﬁeld to 350.
2. Click Start Wanding.
Result: BTCameras will now record calibration wand data within the Space. The Calibration Engine
section will record the samples of each BTCamera and the spread of the samples.
1. In the Physical Space, plug the power source into the calibration wand, and connect the
power source to an outlet or battery pack.
Result: The calibration wand’s LEDs should be visible in Motive as an infrared source
2. Wand the Physical Space by moving the powered calibration wand across the Space. Try to
move the wand up and down and back and forth, and rotate the head while you move, to
create diﬀerent data points (think of a ﬁgure eight motion). Ensure the calibration wand LEDs
are not covered or being blocked from BTCamera view.
Tip: When using the Slim 13E BTCamera, the front facing LED on the BTCamera will turn blue
to indicate it is collecting wanding data
Tip: It is recommended that as many BTCamera views as possible be ﬁlled with wanding data
to improve calibration accuracy.
3. In Motive, look at the Camera Preview and Perspective View window. Perspective View will show all
BTCameras the ground when they do the very ﬁrst wanding. Examine each BTCamera’s recording
of the calibration wand. Wand samples are represented as colored lines. Each BTCamera is
represented by a unique color. Each BTCamera should have roughly the same number of samples
recorded.
Attention: If a BTCamera will not record samples while wanding, consult the Camera Preview
window. See if other BTCameras are detecting the wand. If the wand does not appear on any other
BTCameras, the area will not calibrate due to lack of coverage. If the wand shows up on at least
two other BTCameras, continue wanding, but adjust the path and angle of the wand to give the
BTCameras diﬀerent views. If a section of the intended Space will not record samples after all of
the steps above, cancel the calibration. Reposition the BTCameras to obtain better overlapping
ﬁeld of views of the tracking area.
Attention: If a BTCamera will not record samples while wanding, it is also possible to deselect the
problem BTCamera in the Camera window and recalibrate with the remaining BTCameras. The area
of the Space the problem BTCamera was covering may have less accurate tracking or even no
tracking available, but the rest of the Space should be accurate.
Note: The Calibration Engine section gives feedback about the BTCamera calibration, including the
number of times the calibration wand is viewed by each BTCamera. An estimate on the quality of
the calibration is displayed based on the number of samples were recorded. Calibration quality can
be: Low, Medium, High, or Very High.
4. Click Calculate.
Result: Motive will start to calibrate BTCameras based on the collected data. Displayed at the top
of the Calibration Engine is the current state of calibration, followed by the calibration result rating
and the overall quality.
Note: The calibration data captured in Perspective View is colored to give an indication of how
accurate the data is.
Blue: Less than 6mm accurate in that area.
Red: Greater than 8mm accurate in that area.
The calibration engine displays a quality rating for all BTCameras as well as the global average and
the wand average based on the Desired Quality. The quality ratings are (in order from worst to
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best): Poor < Fair < Good < Great < Excellent < Exceptional. A full bar in the quality column
is the best ranking.
Note: A relatively high Error for a BTCamera is an indication that the given BTCamera received
poor samples during calibration.. It is recommended that you restart the wand calibration process.
At least two BTCameras must have vision of the calibration wand for data to be captured for
calibration. There is a progress bar in the Results column to highlight the quality of each
BTCamera.
While calibrating, BTCameras initially attempt to calibrate for the lowest level of quality. Once
BTCameras have met the criteria of that quality level, the system will advance to the next level
quality and attempt to calibrate. This process repeats until an exceptional quality calibration has
been achieved. Once exceptional quality had been achieved, the system will apply the calibration
automatically.
Note: In the Perspective View window you can see a visualization of the wand sample collected for
calibration. The position of BTCameras will also move to match their position in the physical Space
as the system determines their location.
5. Once the rating for each BTCamera reaches “Excellent” or greater, and the Overall Results quality
rating reaches “Excellent” or greater, the calibration results will automatically be applied to the
system.
To apply the calibration manually, in the Calibration Engine section click Apply Results.
Result: The Calibration Results Reports window will open. Calibration results are available.
1. In the Calibration Results Reports window click Apply.
Result: The calibration data will be applied to BTCameras and they will know their position in
the Space in relation to each other. BTCameras position can be viewed in the Perspective
View window in Motive. Ground plane calibration is required next to determine the
BTCamera’s position relative to the origin (if using a Reﬁne calibration, you may skip ground
plane calibration).
6. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.

Partial Camera Calibrations
As mentioned above, it is possible for the user to calibrate sections of their camera setup after the inital
calibration, as opposed to having to re calibrate the entire camera setup (as of Motive 1.10).
The partial camera calibrations are based oﬀ either a Full, or Reﬁne calibration as you would do above.
To be able to complete a partial calibration, Motive will need to have calibrated cameras to refrence.
These are known as Anchor Cameras. You need at least 2 of these anchor cameras, in addition to the
cameras you wish to calibrate in order to complete the calibration successfully.
To complete a Partial camera calibration:
1. In Motive, go to the Calibration layout by going to Layout > Calibration.
1. Go to the Camera Calibration pane.
2. Choose either a Full or Reﬁne calibration based on the guidelines above.
3. In the Calibration tab, under the Wand Option heading, set the OptiWand sub-heading
to Custom.
4. Set the Wand Length (mm) ﬁeld to 1000.
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5. Set the Center Distance (mm) ﬁeld to 350.
2. Turn oﬀ all cameras (from the Camera Pane's checkboxes) that you do not want to calibrate, or use
as anchor cameras.
For example, if you have 6 BT Cams, and want to calibrate 1 camera, you need at least 3
cameras turned on for the calibration. 2 Anchor, and 1 camera to calibrate.
3. Calibrate the system as you would above.
4. Once complete, turn on the rest of your cameras. You do not need to set the ground plane after
this step.

Known Wand calibration Issues
Issue: When Calibration Engine is calculating, calibration might return a very high error (100+) and
a very poor rating for the cameras and you may see the distortion map in the Camera View warp
outside the camera square.
Solution: Either the wand data you provided Motive does not match the real world wand (check
the wand length and center distance from above) or Motive had a hard time determining a
successful result. Reboot Motive and run the calibration recording again through the solver and if
the wanding data itself is good, this normally ﬁxes the issue.

Issue: After trying to calibrate multiple times the Calibration Engine will not give a Global
“Excellent” rating.
Solution: The data samples taken from wanding may be of poor quality and could be an issue.
Ensure the Space is properly masked from infrared interference, and BTCameras are aimed
correctly. Start calibration again and rewand the Space.
Note: Not all the BTCameras will always receive an 'Excellent' or greater rating and acceptable tracking
can still be achieved with what appears to be poor results. The calibration report will let you know how
accurate each camera is relative to each other. If one camera is poor, it might be okay if there are
several other BTCameras seeing that same area.
Tip: The best way to verify calibration is to lay out the ground plane and ensure each point is only shown
as 1 marker (not two or more points or the points are moving when the ground plane is sitting on the
ground and not moving).

Ground Plane calibration
After the BTCameras are calibrated with the calibration wand, it is necessary to set the ground plane.
This step will inform the BTSystem where they are in relation to the origin. It will also inform the
BTSystem the direction of the axis.
Attention: The origin of the Space must be visible to a minimum of 2 correctly calibrated BTCameras for
ground plane calibration to be accurate.
Note: As of Motive 1.10, when peforming Reﬁne, Full Reﬁne, or Partial Reﬁne calibration types, the
user does not have to re set the ground plane.
To calibrate BTCameras with the ground plane
1. In the
Physical
Space, unfold and lock the ground
arms
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90° angle.
2. Plug in the power source to an outlet and connect the ground plane to a power source or battery
pack.
3. Move the center marker or the ground plane over the Origin of the Space. Adjust the feet of the
ground plane to align it with the origin as deﬁned in BTWYSIWYG. You can see if the ground plane is
level with the built in level on the ground plane arms.
Attention: The origin of the coordinate plane of the tracking space must be the same as the origin
of the virtual representation of the tracking Space as made in BTWYSIWYG. If the virtual
representation and actual tracking area do not share the same origin and axes orientation,
positional data and ﬁxture tracking will be incorrect. The origin also needs to match any Third
Parties origin connected to BlackTrax.
Tip: It is highly recommended that the origin of the Space and the orientation of the axes be
marked for future reference.
4. Aim the long arm of the ground plane to the venue +Y axis.
5. Aim the short arm of the ground plane to the venue +X axis.
6. In Motive, in the Camera Calibration window, in the Ground Plane tab, set the Vertical Oﬀset (mm)
ﬁeld to 90mm.
Attention: If the ground plane is not placed at the height of the Origin, such as on a tripod or
stage, measure the distance between the X-Y plane and the center of the ground plane markers.
Enter in this value in the Vertical Oﬀset (mm) plus 90mm.
Attention: If the ground plane cannot be placed on the origin due to space restrictions, such as
obstructions blocking the Origin from BTCamera view, then the ground plane position can be oﬀset.
1. To oﬀset the ground plane, measure the distance (mm) on each axis from the Origin to the
ground plane’s position.
2. Record the diﬀerence in the Capture Volume Translation table.
3. Click Apply Translation.
Note: Each time you Apply Translation, the origin will oﬀset by 1 by each unit you speciﬁed. It is
recommended to clear the oﬀsets back to 0 after making them in case the button is hit accidentally
after you ﬁnish setting it.
Attention: It is possible to rotate the ground plane’s position in Motive without physically moving
the ground plane.
1. To rotate the ground plane, enter in the desired rotation values in the Capture Volume
Rotation table.
2. Click Apply Rotation.
7. To apply the ground plane calibration, click Set Ground Plane.
Result: The BTCameras will know their position in relation to the ground and adjust accordingly in
Camera View window in Motive.
8. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.
Note: The axis in Motive are diﬀerent then the axis in BlackTrax. Please keep that in mind when
oﬀsetting the ground plane in Motive. For reference:
BlackTrax +X = Motive -X
BlackTrax +Y = Motive +Z
BlackTrax +Z = Motive +Y
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After BTCameras are calibrated, minor adjustments need to be entered in Motive for the system to switch
from BTCamera calibration to tracking mode. These setting enable ﬁxture tracking to occur. Once
tracking mode is conﬁgured, no changes to the Motive project need to be made unless BTCameras were
moved or bumped since BTCamera calibration.

To conﬁgure BTCameras for normal tracking
1. In Motive, open the conﬁguration layout by going to Layout > Conﬁguration.
2. In the Applications Settings window, in the options tab, under the Applications Options heading, set
the Active Marker Labeling ﬁeld to True.
Result: BTCameras will only track infrared sources with identifying pulses, such as the LED of a
Stringer connected to BTBeacon.
3. Close the Application Settings window.
4. In the Reconstruction window, under the 2D Object Filter heading set the Filter Type to None.
5. Close the Reconstruction window.
6. In the Data Streaming window, under the OptiTrack Streaming Engine heading, mark the checkbox
next to Broadcast Frame Data.
1. Under the Network Interface Selection heading, set the Local Interface ﬁeld to Local loopback.
2. Close the Data Streaming window.
7. In the Synchronization window, under Synchronization, select Custom Synchronization from the
drop-down menu.
1. Under the Sync Input heading, set the Source ﬁeld to Reserved.
2. Set the Synchronization oﬀset to 5000.
3. Click Apply
Note: The Input Monitor section can be used to immediately check if the TimeKeeper is
connected correctly to the eSync and Motive. In the Input Monitor section, in the Reserved
ﬁeld, there should be a value of 100.003 Hz (or close to this number). This means Motive is
receiving the TimeKeeper sync signal. If this number is not in the range of 99.998 - 100.004
Hz (or close) there may be a conﬁguration issue with the TimeKeeper, and you should report
issue to a BTE to be resolved.
8. Save the changes to the project ﬁle. Go to the File menu and select Save Project.
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Motive can have restrictions placed to customize tracking. Infrared sources, such as a LED Stringer of a
BTBeacon, that are outside these restrictions will not be acknowledged by the system.

To set BlackTrax BTCamera beam length
Attention: The Maximum distance should be the largest distance between a BTCamera and the furthest
tracking boundary. The minimum distance should be the shortest distance between a BTCamera and the
closest tracking boundary.
1. Open the Reconstruction Properties window. To open the window, go to the View menu and select
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Point Cloud section, under the Options heading set
the Minimum Ray Length ﬁeld to the desired minimum length.
3. Set the Maximum Ray Length ﬁeld to the desired maximum length.
4. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.
Result: The beam length of BTCameras will be set. BTCameras will only acknowledge BTBeacons
within this range.
Note: After camera calibration, Motive will automatically determine these values with estimates of
acceptable tracking distances. You may override these values at any time, but if you re-calibrate
these ﬁelds will be re-populated.

Limiting tracking within boundaries
In Motive, as an optional step, you can create a boundary around the Space. The boundary will tell the
system to ignore infrared sources outside this boundary. BTBeacon positional data found outside the
boundary will not be sent downstream to other applications.
To deﬁne boundaries you will have to measure how far the origin of the Space is from the intended
boundary in the Space. This will need to be done for each axes (XYZ). The origin of the Space should be
the same origin as the duplicate Space made in WYSIWYG.
Attention: In Motive the Z axis represents length and the Y axis represents height. In the rest of
BlackTrax the Z axis represents height and the Y axis represents length. +X also becomes -X in Motive.
Note: Be aware of the -Y setting for your Space. If the origin of the Space is elevated and tracking occurs
below the origin, ensure the value can cover the intended tracking area.

To set the tracking boundary of the Space
1. Open the Reconstruction Properties window. To open the window, go to the View menu and select
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Point Cloud section, under the Reconstruction
Bounds heading set the Bound Reconstruction ﬁeld to True.
3. Set the Minimum X (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) X axis (width).
4. Set the Maximum X (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) X axis (width).
5. Set the Minimum Y (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) Y axis (height).
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6. Set the Maximum Y (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) Y axis (height).
7. Set the Minimum Z (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) Z axis (length).
8. Set the Maximum Z (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) Z axis (length).
9. Close the Reconstruction Properties window.
Result: The boundary in your Space will be deﬁned. Tracking is only possible inside this boundary.
10. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.
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Because every Space is diﬀerent, there are certain BTCamera settings that will be unique. This section
will provide guidelines on what certain Motive settings should be, to create an accurate tracking
environment.

To enable visualization of the tracking boundary
If the tracking boundaries of the Space have been deﬁned, the limits can be visualized after BTCameras
have been calibrated.
1. Open the Reconstruction Properties window. To open the window, go to the View menu and select
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Advanced Options section, under the
Reconstruction Bounds heading set the Visible Bounds ﬁeld to True.
Result: In the Perspective View window, the boundary of the space will appear as a transparent
volume.
3. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.

To disable visualization of the tracking boundary
1. Open the Reconstruction Properties window. To open the window, go to the View menu and select
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Point Cloud section, under the Reconstruction
Bounds heading set the Visible Bounds ﬁeld to False.
Result: The visualization of the tracking boundary will be disabled.
3. Save the changes to the project ﬁle. To save, go to the File menu and select Save Project.

Adding a reticle to BTCamera views
A reticle (cross-hair) can be added to all BTCamera views to aid in aiming and position.
Note: When the aim-assist feature is used on a BTCamera, a reticle is automatically toggled on for that
BTCamera.

To add a reticle to all BTCamera views
1. Open the Application Setting window. To open the window, go to the Edit menu select Application
Settings....
2. In the Application Setting window, in the Display tab, under the 2D Display Options heading, set the
Camera Reticle ﬁeld to True.
Result: Reticles will appear on all connected BTCamera views in Motive.
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In Motive it is possible to make recordings of tracked objects to play back at another time. These
recordings can be made while calibrating BTCameras to record wanding of the Space. The wanding can
then be played back anytime instead of physically rewanding the area.
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In Motive there are three modes of operation: LIVE, REC (Record) and EDIT. Modes act as a reminder of
where information shown in the Perspective View and Camera View window is originating from.
LIVE: Information shown in LIVE mode is happening in real-time. Everything shown is what
BTCameras see at the present time. When in LIVE mode, a green image is displayed in Perspective
View.
Note: LIVE mode is the default mode of Motive.

REC: Information shown in REC mode is happening in real-time and being recorded to ﬁle for later
use. Everything shown is what BTCameras see at the present time. When in REC mode, a red
image is displayed in Perspective View and a red border appears around the Perspective View and
Camera View windows.

EDIT: Information previously recorded is being played back. Everything shown is what BTCameras
saw during a recording in REC mode. When in EDIT mode, a blue image is displayed in Perspective
View.

Attention: When Motive is in EDIT mode, no live data is sent through the BTSystem. Be sure that no
application downstream of BlackTrax is relying on tracking information while switching between LIVE and
EDIT modes.
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To record in Motive
1. In Motive, from the View menu select Timeline (or go to Layouts > Recording).
Result: The Timeline window will open.
2. In the Timeline window, enter a name for the recording in the Take ﬁeld.
3. To start recording, click the Red Circle on the right hand side of the window.
Result: Motive will enter REC mode. A red outline will appear around the Perspective View and
Camera View windows. Any trackable object in the Space will be recorded to ﬁle.
4. When you want to stop recording, click the Red Circle again.
Result: Motive will exit REC mode. The recording will be saved as a .tak ﬁle.

To play back a recording in Motive
1. In Motive, from the View menu select Timeline and Project (or select Layout > Recording).
Result: The Timeline and Project windows will open.
2. Open the previous recording you want to use by double clicking the .tak ﬁle from the list in the
Project pane.
Result: Motive will enter EDIT mode and the Timeline window will change to EDIT mode functions.
A timeline of the recording will be displayed.
Note: By clicking at any point in the timeline, the recording will jump to that point.
3. Click the Play button (arrow icon) to play the recording in the Timeline pane.
Result: The recording of what BTCameras saw will be replayed for the system. The BTSystem will
act as if the recording were actually happening in real-time.

BlackTrax User Wiki

115

August 2017

Motive For BlackTrax
Each time you calibrate the cameras in Motive, the software automatically starts the recording of the
wanding. You can use this recording at a later date to re-calibrate your system, without the need of
physically wanding again.
To Calibrate from a recording
1. In Motive, from the View menu select Timeline and Project (or select Layout>Recording)
2. Open the desired recording by double clicking the .tak ﬁle from the list in the Project pane
Result: Motive will enter Edit mode, and the timeline window will change to Edit mode functions. A
timeline of the recording will be displayed.
3. From the View menu, select Camera Calibration.
4. In the Camera Calibration pane, ensure your wand settings match what they were when the wanding
took place. Choose if you wish to do a Full or Reﬁne calibration type.
5. Press Start Wanding to begin the calibration process
Result: Motive will now scan the recording for the samples which were selected. After a few seconds it
will return the same samples, and you can calculate the result as with a normal calibration.
6. In the Timeline press the Live button, to return the system to Live mode.
7. Set your ground plane as per normal.
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Attention: Before running the BlackTrax GUI, ensure you have completed the following mandatory steps
to ensure a succesful BlackTrax experience:
Set up the BTSystem in the Space: The BTSystem needs to be physically installed in the Space.
See BTSystem Hardware Conﬁguration for more information.
Create a ﬁle in BTWYSIWYG: A .wyg ﬁle ﬁle provides BlackTrax with information on Trackables,
Fixtures and Space dimensions. From a .wyg ﬁle, you can either generate a .btx ﬁle or send the
neccesary information directly between programs. See Creating a .btx ﬁle in BTWYSIWYG for more
information.
Conﬁgure and Calibrate BTCameras using Motive: Motive needs to be used to conﬁgure
BTCameras and inform the BTSystem how to track and how to share positional information with
other components. See BTCamera Calibration for more information.
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When BlackTrax launches, it will bring you by default to the last used View. If BlackTrax is opened for the
ﬁrst time, then you will be taken to the Edit View. Before the Edit view and the other views of BlackTrax
are explained, we will ﬁrst familiarize you with the various parts of the user interface.

The Default state of the BTGUI upon opening
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The functions of BlackTrax are divided into three simple core views. You may customize how the GUI lays
out the various toolbars and widgets to your liking, and as such this documentation will refer to the
default layout of the GUI. Along the left of the window is the View toolbar and Sub-View toolbar which
allows for navigation to the diﬀerent views when clicked. The views of BlackTrax are:
Live view: The Live view is where you will monitor a BlackTrax project. From this view you have the
ability to manually switch between Chapters or enable Chapter Control from a console. You can connect
or disconnect BlackTrax modules to the system as well as view the current BTBeacon patch and data and
their Trackables. You may choose which Trackables are displayed based on group, active chapter, or all
available. Only information that is saved and applied to the project is displayed here.
Live View
Edit view: The Edit view is where you will assign ﬁxtures to follow Trackables and program your
chapters. An instance of ﬁxtures and Trackable relationships is called a chapter. Chapters can be edited,
saved and managed in this page. You may control how a ﬁxture follows a Trackable by use of Fixture
Settings. Various ﬁxture settings and how they connect to BlackTrax is managed from this view.
Edit View
Calibration view: The Calibration view is the parent of Calibration sub-views. Each sub-view oﬀers
settings and operations speciﬁc to the type of calibration. As of BlackTrax v2.0.0, the sub-views available
are Fixture Calibration view and Frame Calibration view.
Note: Calibration view in itself is not a view, and instead will automatically default to the last active subview once clicked.
Fixture Calibration sub-view: Fixture Calibration sub-view allows for correction and adjustments of
approved movable ﬁxtures connected to BlackTrax, ensuring precision when following Trackables.
Features of ﬁxtures that can be calibrated are the pan and tilt settings and pan and tilt motor mapping
(DMX to angle). The calibrations proﬁles can be created, exported and imported for use as needed.
Fixture Calibration sub-view
Frame Calibration sub-view: Frame Calibration allows you to create and edit Rigid Body and Soft Body
Frames. A Frame is a collection of beacons and LEDs that form an object. From this view, you
can construct, oﬀset, and move the centroid and orientation of a Frame as well as rename them.
Frame Calibration sub-view
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BlackTrax Version 2.0 now oﬀers a fullscreen mode of the GUI. This allows you to hide the Windows
interface and focus directly on your programming/tracking work. You can control BlackTrax being in Full
Screen, or Window Mode via the View menu, as well as from the Toolbar or by pressing F11.
Note: If you are in Full Screen Mode, and launch one of the BT Modules via the Modules menu, BlackTrax
will switch to Window Mode upon launching the module.
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BTGUI Menu Bar
The Menu Bar across the top of the GUI is where you will ﬁnd access to all functions of the software. The
diﬀerent menu bars are:
File: Loading and saving or projects, as well as updating BTWYG information. You can also export
various functions such as ﬁxture calibration data and a programming report.
Edit: Discard Changes can be found here.
Discard Changes will rollback changes made in the BlackTrax project to the last savepoint
created. If no savepoint was created, the project will revert to as it was when originally
opened.
View: All docking widgets for the current view can be found here as well as options to
manipulate saved views.
Settings: Modify system and project settings.
Modules: Access to the various modules of the BlackTrax System, including Tracker, Follower, and
Tracking Adapter.
Help: About information for your current release of BlackTrax.
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BlackTrax File Menu

Introduction
The File menu is where you can save, load, update, and create projects (know as .btprj ﬁles). You can
update a .btprj ﬁle with a .btx ﬁle from WYG, or via the Apply BTWYG Updates when new BTWYG
information is sent to BlackTrax.
Other features that are availble are being able to import and export calibration data, as well as exporting
chapter programming data for reference as an .html or .xml ﬁle.
You can also exit BlackTrax from this menu.
Starting a BlackTrax Project
New Project will create a new BlackTrax Project ﬁle (.btprj). At this time you may import a .btx ﬁle,
which contains relevant ﬁxture, trackable, zone, and space infromation from a .wyg ﬁle, or you may leave
it blank to import at a later time. A .btprj ﬁle is the accumulation of all the information gathered from a
.btx ﬁle, plus all the settings and tracking information created in BlackTrax.
If another project is currently opened, you will be prompted to save changes to that project before a new
project is created. Only one BlackTrax project may be open at a time.
The New Project can be created in two modes: Standard Chapters (no Books) mode or Extended
Chapters (with Books) mode.
Chapters: A Chapter is saved information on which Trackables are tracked and assigned ﬁxtures
follow them at a speciﬁc instance. Chapters can be created, edited, saved and managed in Edit
View and recalled in Live View. Chapters can be created, edited, saved and managed as part of a
Book or Books.
Books: In Extended Chapters (with Books) mode, Chapters can be created, edited, saved and
managed as part of a Book or Books. Books can be edited, saved and managed in Edit View and
recalled in Live View.

Create BlackTrax Project Dialog

Starting a new Motive Project
From the File menu, you can choose New Project > Motive Project to create a new Motive Project ﬁle
(.ttp). To proceed in creating a new Motive Project ﬁle, go to the Motive Project File page.
Result: Creating and launching the new Motive project from the BlackTrax File menu will automatically
start Motive in a state that is ready for BlackTrax use.
Starting a new BTWYG Project
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From the File menu, you can choose New Project > BTWYG Project to create a new BTWYG Project
ﬁle (.wyg). To proceed in creating a new BTWYG Project ﬁle, go to the Creating a BTWYSIWYG
Project page.
Result: Creating and launching the new BTWYG project from the BlackTrax File menu will automatically
start BTWYSIWYG in a state that is ready for BlackTrax use.
Note: We recommend to create and launch new projects for both Motive and BTWYG from the BlackTrax
File menu which is more convenient than having to manually create the new project and settings.
To create a .btprj ﬁle
1. Click New Project.
2. Say Yes to close the current project.
Result: The Create Project window will appear.
Note: If you do not have a .btx ﬁle available, skip to step 6.
3. In the Create Project window, next to the BTX File ﬁeld, click “...”.
Result: The Browse window will open.
4. In the Browse window, navigate to the .btx ﬁle location and select the ﬁle.
5. Click Open.
Result: The Browse window will close. The .btx ﬁle will be selected with its location shown in
the BTX File ﬁeld.
6. In the Create Project window, next to the Project File ﬁeld, click “...”.
Result: The Browse window will open.
7. In the Browse window, navigate to where you want to save the .btprj ﬁle.
8. In the Name ﬁeld, enter a name for the .btprj ﬁle.
9. Click Save.
Result: The Browse window will close. The .btprj ﬁle will be named and its location shown in
the Project File ﬁeld.
10. In the Create Project window, next to the Mode ﬁeld, click on the arrow and from the drop-down
menu select Standard Chapters (no Books) or Extended Chapters (with Books).
11. Click Ok.
Result: Information from the .btx ﬁle (e.g. ﬁxtures, Trackables, Space dimensions) will be
loaded into the new .btprj ﬁle (if applicable). The .btprj ﬁle will be named, ready to be saved
and ready for use.
Opening BlackTrax Projects
Open Project will open a previously created BlackTrax project. If another project is currently opened, you
will be prompted to save changes to the current project before a new project is opened.
To open a BlackTrax project
1. Click Open Project
1. Result: The Browse window will open.
2. The Browse window, navigate to the .btprj ﬁle location and select the ﬁle.
3. Click Open.
Alternatively:
1. Mouse over Recent Files
2. Select the File from a list
Updating BTX Projects
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If a BTWYSIWYG ﬁle (.btx) has been edited since it was used to make a BlackTrax project ﬁle (.btprj),
Update BTX Projects can be used to update the BlackTrax project ﬁle. Any new .btx information will be
carried over to the existing .btprj, while maintaining any work you have already done to the project.
To update a BlackTrax project with new information from BTWYSIWYG via a .btx ﬁle
1. Click Update Project.
Result: The Browse window will open.
2. In the Browse window, navigate to the edited .btx ﬁle location, and select the ﬁle.
3. Click Open.
Result: Information from the .btx ﬁle (e.g. ﬁxtures, trackables, Space dimensions) will be
loaded into BlackTrax project ﬁle (.btprj).
To update a BlackTrax project with new information from BTWYSIWYG directly
1.
2.
3.
4.
5.

In BTWYG, go to Live Mode
Open the BTX Panel (Live -> BlackTrax Panel)
Ensure BTWYG is connected to BT (if it is not, click connect)
Click BTX Apply
In BlackTrax, go to File -> Apply BTWYG Updates

Closing BlackTrax Projects
Close Project will exit out of the currently open BlackTrax project while keeping the GUI open. Close
Project will not save the BlackTrax project and will not aﬀect the running show.
To close a BlackTrax project
1. Click Close Project.
2. A dialog box will appear asking if you really want to close the project. To close the project click Yes.
Result: The .btprj ﬁle will close.
Saving BlackTrax Projects
BlackTrax projects are saved as a .btprj ﬁle. Save Project will save the open BlackTrax project to the
same ﬁle name and location under which it was previously saved. If you are saving the project for the
ﬁrst time, this command will perform as Save Project As. Save Project As is used to save the current
project with a new ﬁle name and/or a new destination.
To save a BlackTrax project using Save Project
1. To save the current project, click Save.
To save a BlackTrax project using Save Project AS
1.
2.
3.
4.
5.

Click Save As.
The Browse dialog box will appear.
In the Browse dialog box, navigate to location you want to save the ﬁle.
In the File Name ﬁeld, type the desired name of the ﬁle.
To save the ﬁle, in the dialog box click Save.

Importing and Exporting Fixture Calibration Data
You can import and export ﬁxture calibration data to be used at a later date. This is useful to backup just
calibration data, as well as exporting calibration data to be used in lighting consoles. In both cases for
import and export, if not ﬁxtures are selected in Fixture Calibration view, then all ﬁxtures with calibration
data will be exported/imported. If ﬁxtures are selected, then only the selected ﬁxtures will export/import.
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To import ﬁxture calibration data
1. Click on Import -> Calibration.
2. Browse to the .btcal ﬁle and open it.
Result: The calibration data stored in the .btcal is applied.
To export ﬁxture calibration data
1. Click on Export -> Calibration
2. Under ﬁle type, select if you want to export .btcal (for importing back into a .btprj ﬁle) or .xml (for
importing into lighting consoles or other devices).
3. Browse to the folder you wish to save the ﬁle.
4. Click Save.
Result: All calibrated ﬁxture data is exported.
Importing and Exporting Output Conﬁguration Data
You can import and export output conﬁguration data to conﬁgure the current tracking output or store
tracking output data for later use.
To import output conﬁguration data
1. Click on Import -> Outputs.
2. Browse to the .btoc ﬁle and open it.
Result: The Output Import Details window appears. The table in the Output Import Details
window displays the output conﬁguration settings that will be imported into your project.

3. In the Output Import Details window, mark the checkbox of the following options:
Create New: This option will create the new outputs as deﬁned in the New Outputs section.
Delete Existing: This option will delete any outputs in the Deleting Outputs section. These
existing outputs are already present in the BlacTrax project.
Overwrite Existing: The current output conﬁguration deﬁned in the Existing Outputs section
will be replaced with the settings of the output conﬁguration being imported.
Note: The checkbox will only appear if an output being imported has that option (i.e. Check
New will only appear if there are new outputs).
4. If an output data with the same name is already present in your ﬁle, the changes will be
highlighted, and you are given the option to overwrite the current output with these new settings.
5. The Output Conﬁguration data stored in the .btoc is applied to the current project in BlackTrax.
To export output conﬁguration data
1.
2.
3.
4.

Click on Export -> Outputs.
Under ﬁle type, select if you want to export .btoc.
Browse to the folder you wish to save the ﬁle.
Click Save.
Result: All Output Conﬁguration data is exported to the selected folder.

Note: The project ﬁle must ﬁrst be saved before you can export output conﬁgurations.
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Export a show report
You can export a show report from the Export menu, which contains all the information regarding the
programming of the show, including chapters, trackables, and Frames.
To export a show report
1. Click on Export - > Show Report
2. Browse to where you would like to save the the ﬁle and click on Save
1. Result: The ﬁle is saved and contains all project information as of the export in an .html
format.
Closing BlackTrax
You can close BlackTrax from the ﬁle menu, at which point it will ask you to save the project, if changes
were detected.
To close BlackTrax
1. Click on Exit BlackTrax
2. If prompted, save or discard project changes
1. Result: The GUI is now closed.
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Introduction
The Edit menu is where you can discard your changes and revert back to the last time you hit the Apply
Changes button.

Discard Changes
Each time you click Apply Changes, a snapshot is created of the current editing and live space. As you
make changes, Changes: Blind will highlight in the status bar, alerting you that new changes have not
been made live. Normally, you would click on Apply Changes to apply your new edits live to the stage,
but in the event you wish to discard your changes and revert back to the last time you click Apply
Changes:
1. Click on Discard Changes in the Edit view.
2. Click Yes to conﬁrm you wish to discard all changes.
Result: All changes are discarded back to the last time you clicked Apply Changes.
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View Menu

Introduction
The View menu contains all docking widgets, both global and per view, view shortcuts, and common
widget operations. If you are ever curious about what can be done/opened, the View menu should prove
helpful.
Top Section
The top section of the View menu contains you're three core views (Live View, Edit View, Calibration
Views), and Calibration Views' two sub-views (Fixture View and Frame Calibration View). Click on
each one will take you to the selected view and hovering over Calibration Views will give you access to
the two sub-views.
Upper Middle Section
This section contains commonly used widget functions.
Resetting all views to factory defaults
If at any point you are not happy with the layout you have created, you may click Reset View to restore
the GUI's views back to factory default
1. Click on Reset View
Result: Any custom views you have created (moved docking widgets, ﬂoated widgets to
other screens, or changes the sizing of widgets) will be reverted to factory defaults.
Note: This will aﬀect all views and cannot be undone.
Closing all widgets
If you want to close all open widgets and just focus on the centre area in the GUI, you may use the Close
All Widgets option.
1. Click on Close All Widgets
Result: Any widgets currently open, including docked and ﬂoating on other monitors, will be
closed.
Note: This will only aﬀect the current view and cannot be undone
Lower Middle Section
This section contains all global widgets, meaning anything you can open and access across all views. In
this section you will ﬁnd:
Beacon Patch
BTWYG Patch
Beacons
Messages
System Log
Note: Each widget remembers its location per view only. Meaning if you take Beacon Patch and move it
to a second monitor in Edit view, then switch to Live view, Beacon Patch will reset to it's last saved
position in Live view (if no last saved position is availble, it will revert to the factory default position).
BlackTrax User Wiki

131

August 2017

BlackTrax GUI
Bottom Section
This section contains all per-view widgets, meaning each widget is only found in one view and can not be
shared between other views. In this section, per view, you will ﬁnd:
Live View
Running Chapters
Modules
Trackable Details
Edit View
Edit Chapters
Libraries
Fixture Settings
Trackable Settings
Terminal
Fixture Calibration Sub-View
Fixture Calibration Control
Fixture Calibration Properties
Fixture Calibration Points
Frame Calibration Sub-View
Frame LEDs
Frame Construction
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Settings Menu

Introduction
The Settings menu contains links to all the widgets that contain settings for the software, the current
project or the option to change between Chapter or Book mode.
System Conﬁguration: In System Conﬁguration, you will ﬁnd settings that will change the
software behaviors (such as Fixture Calibration behavior, warning prompts, and autofocus behavior
going to BTWYG).
Project Properties: In Project Properties, you will ﬁnd settings and information of the current
project such as the show name, author, and description (all editable), and the settings that will
change the DMX input for Chapter Control Channel, Book Control Channel and the Merging
Channel.
Book Control Channel: The Book Control Channel settings will be added to Project
Properties when Book mode is selected.
Merging Channel: The Merging Channel is just a monitoring channel and does not control
the merging channel. The Merging Channel must be set in the merge node and monitored
from the GUI.
Reset BTEngine Settings: All background tracking operations that were activated in BlackTrax
are reset to its original manufacturer settings. During the reset, all tracking operations will pause
momentarily.
Output Conﬁguration: In Output Conﬁguration, you can view and customize the active tracking
output data from the Output modules and Trackable Settings in the tracking operation.
Change Book Mode: Click on the Change Book Mode to switch BlackTrax between Standard
Chapters (no Books) mode or Extended Chapters (with Books) mode.
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BlackTrax Modules Menu

The Modules menu launches these modules that are used with BlackTrax. If you are in full screen mode,
selecting a module will exit full screen mode.
Module Status: Displays the list of currently active modules. See Module Status page.
BTEngine: Launches Tracker, Follower and Monitor as background tracking modules with settings
that are integrated with the various Settings widgets. See BTEngine page.
Simulator: Identiﬁcation and positional data of BTBeacons can be created, conﬁgured and
managed in simulation. See Simulator Module page.
Cue: Realtime or simulated tracking data in BlackTrax can be recorded and saved as Chapters for
playback. See Cue Module page.
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The Module Status widget displays the list of modules that are currently active with the corresponding
link connections. In the widget, you may click the Discover button to display the current active module
connections.
The Module Status widget also gives you the ability to restart, or exit modules(excluding BTWYG) by right
clicking on them.

Modules Status widget
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The Help menu is where you will ﬁnd the shortcut to the License Folder location, and the About
BlackTrax dialogue with information about BlackTrax, product version and build number.
The default License Folder location is C:\bt_run_time\license. For information on how to download the
license, please refer to the link.
The About BlackTrax dialog:
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Live View Toolbar

View and Sub-View Toolbar

View Toolbar in Fixture Calibration Sub-View

There are three toolbars in the BlackTrax GUI: Main, Views, and Sub-Views.
Main: On the left side, it contains all basic operations such as saving and loading project ﬁles, as
well as common functions found throughout the software such as Reset View, Beacon Patch, and a
fullscreen option. On the right side, you have access to the most used docking widgets found in
your current view. The right side of the toolbar will change depending on which view you are
currently in.
Views: The ability to change between the three core views: Live, Edit, and Calibration.
Sub-Views: Sub-views are available for the Calibration View. Each sub-view oﬀers functions
related to a speciﬁc type of calibration.
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Frame Construction Docking Widget

The GUI is comprised of several docking widgets, each covering features and functionally to control,
calibrate, and operate the system. You can ﬁnd all available docking widgets under the View menu, and
the most common widgets available in the toolbar.
All docking widgets comprise of a 'ﬂoat' and 'close' function. Floating a widget will detach it from the GUI,
and allow you to drag it around the screen, or to another monitor. The close function will close the
widget, at which point you must re-open it from the View menu or toolbar.
Diﬀerent widgets function in diﬀerent ways, and their speciﬁc function will be covered in other sections of
this documentation.
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Status Bar with a running show
Along the bottom of the screen there is a status bar that displays important system information at a
glance. The following information is available for view:
Following Status: Displays if ﬁxtures are following assigned Trackables.
Following active: Fixtures are following Trackables.
Following inactive: Fixtures are not following Trackables.
Attention: The following status icons act as buttons and can be clicked on to toggle following.
Mode Status: Displays if calibration mode is active or normal mode is active.
Normal Mode: Fixtures follow according to chapter programming and current chapter.
BlackTrax controls pan and tilt, and optionally zoom, iris, and dimming of intensity.
Fixture Calibration Mode: Fixtures follow according to the Fixture Calibration View, and
BlackTrax controlls intentisty, pan, tilt, zoom, iris, colour, and gobo. Chapters are ignored.
Attention: The calibration status icons act as buttons and can be clicked on to toggle calibration.
Note: For more information about Following Status and Mode Status, see below.
Current Chapter: Displays the chapter currently active.
MCV: Stands for Merging Channel Value and displays the current DMX value from the console of
the merging channel.
Chapter Control: Displays how chapters are currently controlled.
Manual: Chapter selection is under manual control.
Art-Net: Chapter selection is under DMX control.
DMX Input: Indicates if the system is receiving DMX information either from ArtNet or sACN. An
animated icon indicates the system is receiving information.
Motion Control: Indicates if the system is receiving motion information. An animated icon
indicates the system is receiving information.
BTWYG Updates: Indicates if the system is receiving an update from BTWYG via the BTX Apply
function.
Messages: A button to access the messages widget.
Changes: Indicates if changes are Live (everything is actively sending to the lighting ﬁxtures and
all constructed Frames are reporting position) or Blind (changes that have been made, but are not
actively sending to the real world system or live space). The Apply Changes button will apply the
changes to the live space.
Any change made to the BlackTrax project will be saved to a temporary savepoint. The
savepoint that was created will last until the BlackTrax project is closed.
The blue LED next to the Changes: Live indicator will turn to a ﬂashing red LED next to the
Changes: Blind indicator whenever changes are made to the project but are not yet applied
to the live space.
Apply Options: Oﬀers to select which type of change will be applied to the live space. Click on the
Apply Options button to display the Programming Changes option, Frame Changes option, and
Conﬁguration Changes option. Click on the boxes to select the option/s. By default, Programming
Changes, Frame Changes, and Conﬁguration Changes are selected when opening a new BlackTrax
project.
Programming Changes: refer to any change to the 'programming' of the show (Chapters,
Fixtures, Trackables/Beacons, Fixture Settings). Most of these changes are made in the Edit
View.
Frame Changes: refer to any change in the Frame Calibration View - changes made with the
construction, re-ordering, re-naming, modiﬁcation, etc of a Frame. All of these changes were
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made in the Frame Calibration View.
Conﬁguration Changes: refer to any changes that send updates to any of the background
modules (Tracker, Follower, Tracking Adapter and Monitor).
Apply Changes: Click Apply Changes to apply any blind changes to the live space.
Result: The changes made from the selected option/s will be applied to the live space and
blue LED next to Changes: Live will be displayed.

Following and Mode Status
When Following is enabled, Trackables assigned to the active chapter will have assigned ﬁxtures follow
them in the Space. When BlackTrax is set to Not Following, ﬁxtures will stop following and revert to
positions determined by a connected lighting console.
Attention: When you stop following, no release command is sent to the merge node. If you are in a
chapter and you stop following, the console will still not have control (if merging channel is at full).
When Fixture Calibration Mode is active, the features of the Fixture Calibration view is enabled. When
Normal Mode is active, the Fixture Calibration view is locked.
Note: To calibrate ﬁxtures, the BTSystem Following and Fixture Calibration modes must be activated at
the same time.
To enable ﬁxtures following Trackables
In the Tracking Control section, click Start Following.
Result: BlackTrax will attempt to connect modules as if Discover was used. A dialog window will appear
showing the status of modules. If successful the following icon will change to Active. Assigned ﬁxtures
will now follow Trackables assigned to the active chapter.
Attention: Any edits made in other pages will be implemented as if Apply Changes was used when the
BTSystem is set to Following.
To disable ﬁxtures following of Trackables
1. In the Tracking Control section, click Stop following.
2. A dialog window will appear asking if you really want to stop following. Click Yes.
Result: The BTSystem will stop following with ﬁxtures and the following icon will change to Not
Following.
Attention: When you stop following, a release command is not send to the merge node. If you are in a
chapter and you stop following, the console will still not have control (if merging channel is at full).
To enable ﬁxture calibration
When in Normal Mode, in the status bar, click the button labeled Normal Mode to switch to Fixture
Calibration Mode
Result: BlackTrax will be set to Fixture Calibration Mode and the features of the Fixture Calibration view
will be unlocked.
To disable ﬁxture calibration
When in Fixture Calibration Mode, in the status bar, click the button labeled Fixture Calibration to switch
to Normal Mode.
Result: BlackTrax will be set to Normal Mode and the Fixture Calibration view features will be locked.
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Table of Contents:
Fixture Calibration View
Fixture Calibration Control Widget
Fixture Calibration Properties Widget
Fixture Calibration Points Widget
Fixture Calibration
Single and Multi-Fixture Calibration
Multi-Person Calibration
Reﬁning Calibration Data
Managing Calibration Data
Frame Calibration View
Body Frames
Frame LEDs Widget
Rigid Frame Construction Widget
Creating Frames
Rigid Frames
Soft Frames
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Fixture Calibration View
The Fixture Calibration View is where the position of ﬁxtures can be calibrated to ensure ﬁxture tracking
is precise and accurate. In the Fixtures section:
BTBeacons are assigned to ﬁxtures.
Fixtures can be set into groups for convenient selection.
Calibration data collected are saved as presets which can be recalled in the Edit Chapters widget
and displayed in the Running Chapters widget.
A maximum of 24 presets are available for the calibration of ﬁxtures in multiple positions.
To have a ﬁxture follow an assigned Trackable, BlackTrax ﬁrst determines the position of the Trackable.
This is done using the BTCameras and the BTBeacon assigned to the Trackable. BlackTrax references
where a ﬁxture is based on information collected from the BTWYSIWYG .btx ﬁle. Based on the Trackable
and ﬁxture positions, the BTSystem calculates the pan and tilt angles a ﬁxture need to be at for it to be
aiming at a Trackable. This information is then sent to the ﬁxture where it changes its pan and tilt
settings accordingly to aim at the Trackable.
Note: If there are inconsistencies between the location of ﬁxtures in the Space, and the virtual Space in
BTWYSIWYG, tracking information BlackTrax creates for the ﬁxture will be inaccurate.
Fixture calibration allows you to correct these inconsistencies and ensures the location of ﬁxtures is
accurate. It is recommended that all ﬁxtures be calibrated when they are ﬁrst installed in the Space, and
individually anytime a ﬁxture is moved or bumped.
Attention:
1. Discard Changes and Apply Changes are disabled during Calibration Mode.
2. The Fixture Calibration page is locked until BlackTrax is set to Following and Calibration Mode.
Assigning beacons to ﬁxtures for calibration
1. Enter Calibration Mode.
2. From the Preset: drop-down, select the preset number. You may click on Rename to type a new
name for the selected preset.
Note: The preset numbers displayed will not change.
3. Highlight a ﬁxture (or ﬁxtures) in the center area of the BTGUI.
4. Right-click on Not Assigned under the Assigned Beacon heading. Alternately, select the Assign
Beacon Button beside Group.
5. Select a beacon.
6. Repeat steps 1-4 for all beacons you want to use for ﬁxture calibration.
7. Fixtures will cycle through following the assigned beacon(s) as points are collected.
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Fixture Calibration Controls Widget

To calibrate a ﬁxture, measurement points have to be collected. Measurement points are samples of
ﬁxture and BTBeacon data collected by the BTSystem. Typically this involves a ﬁxture attempting to lock
on to a BTBeacon in the Space. Then with the ﬁxture’s beam frozen in place, moving either Stringer LED
or the ﬁxture beam so that the Stringer’s LED is in the center of the beam.
There are two ways to control how ﬁxtures move for ﬁxture calibration: Follow Beacon, and Pan/Tilt
Sliders.
Follow Beacon: Using this control method, a ﬁxture that has been assigned a beacon, and is currently
active, will attempt to follow a BTBeacon. If there are diﬀerences between the original project ﬁle and the
actual physical space, ﬁxture following will be inaccurate and be oﬀ center from the BTBeacon. This is
normal behavior for uncalibrated ﬁxtures, and will be corrected after successful ﬁxture calibration.
Pan/Tilt Sliders: Using this control method, the pan and tilt sliders in the Measurement section are used
to move selected ﬁxtures.
Selecting a Control Mode for Fixture Calibration
1. In the Fixture Calibration Control widget, select the control method from the Control Mode dropdown menu.
Result: Fixtures will move according to the selected control method.
To move a ﬁxture using the Pan/Tilt Sliders
1. In the Fixture Calibration view, in the central widget, select the ﬁxture you want to move.
2. Select the control method to Pan/Tilt Sliders.
3. The tilt of the ﬁxture can be moved by adjusting the Tilt slider, or entering the exact angle in the
Tilt ﬁeld.
4. The pan of the ﬁxture can be moved by adjusting the Pan slider, or entering the exact angle in the
Pan ﬁeld.
Controlling Zoom and Iris
Zoom and Iris can be controlled from the Fixture Calibration Control widget using the Zoom and Iris
sliders similar to pan and tilt of the selected ﬁxture(s). If the checkboxes for Apply Globally are set, then
the control will apply to all currently active or queued ﬁxtures, otherwise it will only apply to the currently
selected ﬁxture.
Clearing Colour and Gobos and Controlling Intensity
BlackTrax will also attempt to auto clear any colour and gobos that the console is instructing the ﬁxture
to use. While in Fixture Calibration Mode, BlackTrax will also control the intensity of the ﬁxtures, turning
them on or oﬀ based on if they are queued or not.
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The Fixture Calibration Properties widget displays the ﬁxture positions and attributes that aﬀect tracking.

Fixture Calibration Properties widget

The Fixture Calibration Properties widget displays:
Selected Fixture: Model Name and Spot ID number of the selected ﬁxture.
X: Horizontal measurement of the selected ﬁxture's position.
Y: Depth measurement of the selected ﬁxture's position.
Z: Vertical measurement of the selected ﬁxture's position.
RX: Rotation angle with reference to the X axis.
RY: Rotation angle with reference to the Y axis.
RZ: Rotation angle with reference to the Z axis.
Note: Slope and Oﬀset values are used in determining the intrinsic perimeters of the ﬁxture, to
accurately map and calculate the DMX->Angle conversion of a ﬁxture.
Pan Motor Slope: Deviation value of the ﬁxture's pan movement with reference to the oﬀset.
Pan Motor Oﬀset: Oﬀset value with reference to the ﬁxture's pan movement origin.
Tilt Motor Slope: Deviation value of the ﬁxture's tilt movement with reference to the oﬀset.
Tilt Motor Oﬀset: Oﬀset value with reference to the ﬁxture's tilt movement origin.
Pan Status: Sets the orientation of the pan movement. Click on the drop-down and select Normal
or Inverted. When a ﬁxture is calibrated, this setting will always revert back to what the ﬁxture is
set to in WYSIWYG.
Tilt Status: Sets the orientation of the tilt movement. Click on this drop-down and select Normal
or Inverted. When a ﬁxture is calibrated, this setting will always revert back to what the ﬁxture is
set to in WYSIWYG.

BlackTrax User Wiki

144

August 2017

BlackTrax GUI
The Fixture Calibration Points widget displays the measurement points collected that specify the location
and beam position of a selected ﬁxture when aimed at a Trackable.

Fixture Calibration Points widget

The Fixture Calibration Points widget displays:
Table (Columns):
Number column: Calibration point number.
Use: Checkbox to select or deselect the row of data points of the selected ﬁxture. By deselecting a
checkbox, that point will no longer be used as part of the calibration next time the solver is run
(manually or automatically).
X: Horizontal measurement of the LED's position at the time of point collection (Reference: Stage
Left)
Y: Depth measurement of the LED's position at the time of point collection. (Reference: Upstage)
Z: Vertical measurement of the LED's position at the time of point collection. (Reference: Towards
the ceiling).
Pan Angle: Collected pan angle of selected ﬁxture's moving head or mirror.
Tilt Angle: Collected tilt angle of selected ﬁxture's moving head or mirror.
Residual: Error tolerance value of the measurement points collected.
Buttons:
Delete All Points: Click this button to erase all points collected from all the ﬁxtures in this chapter.
Delete Point(s): Click this button to erase all selected points collected from the selected ﬁxture.
+Collect Data Point: Click this button to collect new measurement points from the selected
ﬁxture(s) using the current LED position as the position. Also the same as pressing B on the
Beacon. The beam must be frozen for a point to be collected (in Control Mode: Manual, a point may
be collected at any time).
Freeze Beam/Unfreeze Beam: Freezes the ﬁxture in place so that you may move the LED into the
center of the beam to collect a data point. The ﬁxture will no longer respond to the updated motion
until the beam is unfrozen or a point is collected. Also the same as pressing A on the Beacon. Not
available in Control Mode: Manual.
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Table of Contents:
Single and Multi-Fixture Calibration
Multi-Person Calibration
To turn on ﬁxture calibration
1. In the status bar, click Normal Mode.
Result: The BTSystem will toggle to to Calibration Mode. The features of the Fixture
Calibration view are enabled.
To turn oﬀ ﬁxture calibration
1. In the status bar, click Fixture Calibration.
Result: The BTSystem will exit Calibration Mode and enter Normal Mode. The features of the
Fixture Calibration page are disabled.
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To calibrate a ﬁxture, measurements points have to be collected. Measurement points are samples of
ﬁxture and BTBeacon data collected by the BTSystem.
It is possible to collect measurements points for a single ﬁxture or multiple ﬁxtures. Each ﬁxture will need
its own measurement points to calibrate correctly.
Attention: For accurate ﬁxture calibration to occur, ensure that BTCameras are correctly calibrated and
accurate ﬁrst.
To collect measurement points for a single ﬁxture
1. In BlackTrax, in the Fixture Calibration View, in the Fixtures section, select the Preset number from
the Preset: drop-down. You may click on Rename to type a new name for the selected preset.
Note: The preset numbers displayed will not change.
Result: The measurement points for the single ﬁxture will be collected under this preset
number, which can be recalled in the Edit Chapters widget and displayed in the Running
Chapters widget.
2. In BlackTrax, in the Fixture Calibration view, in the Fixtures section, select the ﬁxture that needs to
be calibrated.
3. A BTBeacon will need to be used to calibrate the ﬁxture. Click Assign Beacon to view a drop-down
list of all available BTBeacons.
4. Select the desired BTBeacon from the list.
Result: The selected ﬁxture will follow the selected BTBeacon in the Space.
5. In the Physical Space, take the chosen BTBeacon. Make sure that a single Stringer is connected to
port 1 of the BTBeacon.
6. Move the BTBeacon to a point within the Space.
Result: The selected ﬁxture should be following the BTBeacon in the Space.
Attention: The LED of the Stringer must be visible to 2 or more BTCameras simultaneously
for tracking to occur.
7. At a point in the Space with the ﬁxture following the BTBeacon, in BlackTrax click Freeze Beam.
Tip: Pushing the A button on the BTBeacon being tracked will activate Freeze Beam
remotely.
Result: The ﬁxture will stop in place.
8. In the Physical Space put the Stringer LED as close to the center of the ﬁxture beam as possible.
9. With the LED still in the center of the beam, in BlackTrax click Collect Data Point.
Tip: Pushing the B button on the BTBeacon being tracked will activate Collect Data Point
remotely.
Result: BlackTrax will collect the data of the BTBeacon and ﬁxture as a measurement point
when Collect Data Point is clicked. It will add the data to the Fixture Calibration Points
section. The ﬁxture will unfreeze and continue following the BTBeacon. The ﬁxture will also
pan-ﬂip after collecting a point to ensure you are collecting points on both sides of the tilt
range.
10. At a diﬀerent location in the Space, repeat steps 5 to 8 until you create a total of 5 measurement
points.
Attention: The minimum number of measurement points needed for calibration is 5.
Note: For best results the measurement points samples should be at diﬀerent points in the
Space, creating diﬀerent pan and tilt angles. It is recommended to take measurement points
in diﬀerent areas of the Space and at diﬀerent heights, creating the most variation.
Note: Points should be collected until the ﬁxture is calibrated (typically 5-8 but sometimes
more). The ﬁxture will autocalibrate after each point once 5 points have been achieved. Auto
calibration feature can be turned oﬀ in settings.
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Collecting calibration data for multiple ﬁxtures
Multiple ﬁxtures can be calibrated at the same time to speed up the ﬁxture calibration process. It may be
easier to ﬁrst assign the desired ﬁxtures into a single ﬁxture group. The ﬁxtures are calibrated as normal
by capturing measurement points for each ﬁxture, but with the additional ability to cycle though the
ﬁxtures in the ﬁxture group.
To create a ﬁxture group
1. In the Fixtures section, select the ﬁxtures that needs to be calibrated.
2. In the Group drop-down menu, select New Group From Selected....
Result: The New Fixture Group window will appear.
3. In the New Fixture Group window, enter in a name for the ﬁxture group in the Group Name ﬁeld.
4. Click OK.
Result: The selected ﬁxtures will be joined into a ﬁxture group.
To collect measurement points for multiple ﬁxtures
1. In BlackTrax, in the Fixture Calibration View, in the Fixtures section, select the Preset number from
the Preset: drop-down. You may click on Rename to type a new name for the selected preset.
Note: The preset numbers displayed will not change.
Result: The measurement points for the multiple ﬁxtures will be collected under this preset
number, which can be recalled in the Edit Chapters widget and displayed in the Running
Chapters widget.
2. In BlackTrax, in the Fixture Calibration view, in the Fixtures section, use CTRL to select all ﬁxtures
you want to calibrate.
3. A BTBeacon will need to be used to calibrate the ﬁxtures. Click Assign Beacon to view a drop-down
list of all available BTBeacons.
4. Select the desired BTBeacon from the list.
Result: The selected ﬁxture will follow the selected BTBeacon in the Space.
5. In the Physical Space, take the chosen BTBeacon. Make sure that a single Stringer is connected to
port 1 of the BTBeacon.
6. Move the BTBeacon to a point within the Space.
Result: The ﬁrst ﬁxture of the selected ﬁxture group should be following the BTBeacon in the
Space. All ﬁxtures will follow the BTBeacon in the Space. Only the active ﬁxture will turn on,
the rest are doused.
Attention: The LED of the Stringer must be visible to 2 or more BTCameras simultaneously
for tracking to occur.
7. At a point in the Space with the ﬁxture following the BTBeacon, in BlackTrax click Freeze Beam.
Tip: Pushing the A button on the BTBeacon being tracked will activate Freeze Beam
remotely.
Result: The ﬁxture will stop in place.
Attention: You will not be able to use Freeze Beam if the BTBeacon is not tracked within the
Space.
8. In the Physical Space put the Stringer LED as close to the center of the ﬁxture beam as possible.
9. With the LED still in the center of the beam, in BlackTrax click Collect Data Point.
Tip: Pushing the B button on the BTBeacon being tracked will activate Collect Data Point
remotely.
Result: BlackTrax will collect the data of the BTBeacon and ﬁxture as a measurement point
when Collect Data Point is clicked. It will add the data to the Fixture Calibration Points
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section. The ﬁxture will douse, ﬂip, then the next ﬁxture in sequence will turn on.
10. Collect a measurement point for the currently selected ﬁxture.
11. Continue cycling through ﬁxtures and collecting measurement points at the current location until
every ﬁxture has one measurement point at that location.
12. At diﬀerent location in the Space, repeat steps 5 to 10 until you create a total of 5 measurement
points for each ﬁxture.
Attention: The minimum number of measurement points needed for calibration is 5.
Note: For best results the measurement points samples should be at diﬀerent points in the
Space, creating diﬀerent pan and tilt angles. It is recommended to take measurement points
in diﬀerent areas of the Space and at diﬀerent heights, creating the most variation.
To calibrate a ﬁxture using collected measurement points
Once measurement points are created for a ﬁxture, they can be used to create calibration data for the
ﬁxture and determine the ﬁxtures calibrated position.
1. In the Fixtures section, select the ﬁxture that needs to be calibrated.
Note: In the Fixture Calibration Points section, have a minimum of 5 measurement points
created.
2. Click Calibrate Selection.
Result: Calibration data is created from the measurement points and displayed in the
Calibration Results section under the Calibration Status column. The Calibration Status is
automatically applied to ﬁxtures. In the Fixtures section, the Calibrated ﬁeld for the ﬁxture
will change to (green) to indicate that calibration data was created and that it is applied to
the ﬁxture. In the Fixture Calibration Points section, in the Calibration Error (Residual)
column, residual values are created for each measurement point.
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Multi-Person Fixture Calibration is a new feature to BlackTrax Version 2, which allows any number of
people to simultaneously calibrate a group of ﬁxtures.

Fixtures table

Assigning Beacons
When Calibrating Fixtures, you can assign individual beacons either by group, or on an individual basis.
In the Fixture Table, you can right click a ﬁxture's Assign Beacon column and select Assign Beacon, or
select multiple ﬁxtures and select the Assign Beacon button at the top of the table. From here you can
assign a beacon to your selection of ﬁxtures. Repeat this process as many times as you have individual
beacons you wish to use to calibrate all of your ﬁxtures.
Active Status
In the Fixture table, each Fixture will have one of the following options as an associated calibration
status, represented in the Active Status column.
Inactive: Fixtures which are displaying this status are currently not assigned a beacon, and is not
calibrating, or waiting to calibrate.
Queued: Fixtures which are displaying this status have been assigned a beacon for calibration, but
are currently not being calibrated. These Fixtures will follow the beacon, with no intensity
Calibrating: Fixtures which are displaying this status have been assigned a beacon for calibration,
have their intensity at full, and are currently being calibrated.
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After calibrating a ﬁxture, Residuals for each measurement point will be calculated and shown in the
Fixture Calibration Points section.
Calibration errors are the diﬀerence between the calculated pan/tilt values of a ﬁxture, and the estimated
pan/tilt values of the ﬁxture, based on all measurement points used in the calibration. A calibration
residual between 0-0.08, is a good indication that a given measurement point is accurate relative to the
overall ﬁxture calibration. A collection of high quality samples is necessary for accurate ﬁxture
calibration. In this case, the smaller the number, the better.
A measurement point with a large residual value is an indication that it was collected poorly relative to
the other points. Poor quality measurement points should not be used in calibration; they should be
removed and the ﬁxture re-calibrated.

Fixture Calibration Points widget

To disregard measurement points for a ﬁxture
1. In the Fixtures section, select the ﬁxture that has measurement points you want to stop using for
calibration.
2. In the Fixture Calibration Points section, unmark the Use checkbox for any measurement points you
want to not use.
Result: The selected measurement points will not be used for the ﬁxture’s calibrated
position next time you hit calibrate selection.
Note: If when removing measurement points from a ﬁxture you have less then 5 remaining, you will
have to collect more sample measurement points before recalculating ﬁxture calibration.
To delete measurement points from a ﬁxture
1. In the Fixtures section, select the ﬁxture you want to delete measurement points from.
2. In the Fixture Calibration Points section, select any measurement points you want to delete.
3. Click Delete Point(s).
Result: The selected measurement points will be deleted from the ﬁxture.
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Fixture calibration data can be saved as a calibration ﬁle separate from of the BlackTrax project.
Calibration can be saved as a BlackTrax Calibration ﬁle (.btcal) which can be read by BlackTrax, or as an
XML ﬁle for third party use. Calibration proﬁles saved as .btcal ﬁles can be loaded and edited as needed
in a project.
Fixture calibration data from any preset can be exported or imported into any preset you are
currently in.
The calibration data that was imported becomes part of the preset you are currently in.
The calibration data that was imported remains part of any other presets where data has been
exported from or into already.
Attention: BlackTrax can not use XML calibration ﬁles to further calibrate ﬁxtures. Fixture calibration
saved to this format is only for third party use.
To export calibration data
Created calibration data can be saved separately from the BlackTrax project as a BlackTrax calibration
ﬁle (.btcal).
1. In Fixture Calibration View, ensure that you are currently in the preset that you want to export
from.
2. Go to File -> Export -> Calibration Data. In the dialogue that appears, select which calibration
ﬁle type will be used from the drop-down menu.

Export Calibration Menu

1. Navigate to the location where you want to save the calibration ﬁle.
2. In the File Name ﬁeld, type the name of the calibration session.
3. Click Save.
Result: Information on all ﬁxtures (calibrated or not) will be saved to the calibration ﬁle. The
information will be accurate so long as the calibrated ﬁxtures are not moved or bumped. This
is provided the Motive calibration is the same (relative to the origin).

Export Calibration Data

To import calibration data
1. In Fixture Calibration View, ensure that you are currently in the preset that you want to import to.
2. In the Fixtures section, select the ﬁxtures which have calibration data you want to import.
3. Go to File -> Import -> Calibration Data.

Import Calibration Menu

1. In the dialog window that opens, browse to the location where the calibration ﬁle (.btcal) is located.
2. Select the .btcal ﬁle.
3. Click Open.
Result: The calibration ﬁle will load and a report will display explaining which ﬁxtures have
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had data imported.
Note: If no ﬁxtures are selected, all ﬁxture data is imported.

Import Calibration Data

To uncalibrate a ﬁxture
1. In the Fixtures section, select the ﬁxtures you want to remove all calibration data from.
2. Click the Clear Selected Data button.
Result: All calibration data and measurement points will be deleted for the selected ﬁxtures.
To uncalibrate all ﬁxtures in the project
1. In the Fixtures section, click Clear All Data
2. A dialog window will appear asking if you really want to clear all calibration data from the project.
Click Yes.
Result: All calibration data will be removed from all ﬁxtures in the project.
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Table of Contents:
Body Frames
Frame LEDs Widget
Rigid Frame Construction Widget
Creating Frames
Rigid Frames
Soft Frames

Frame Calibration View
Overview
The Frame Calibration View allows the user to construct Frames from existing beacons and their LEDs.
Frames can be either Rigid of Soft. Rigid Frames are objects that are considered solid, or will not change
shape such as a table or box. Soft Frames are objects that can change shape, or are ﬂexible and move
such as a person or inﬂatable object. Both Rigid and Soft Frames can be created from the Frame
Calibration view, however each have diﬀerent requirements.
Rigid Frames
Rigid Frames require a minimum of 3 visible LEDs to be created and tracked, if less than 3 LEDs are
visible at any point, the Rigid Frame will stop being tracked. A Rigid Frame can be composed of several
beacons/LEDs, if a Rigid Frame is composed of more than 3 LEDs and one LED is hidden or removed, the
centroid will remain static, relative to the visible LEDs. The centroid is able to be rotated, and moved
around using oﬀsets. That information is saved in the project ﬁle.
Soft Frames
Soft Frames are similar to Rigid Frames however they only require a single LED to be created and
tracked. However it is possible to create Soft Frames with multiple LEDs. If a Soft Frame is composed of a
single LED and the LED is hidden or removed, then the Frame will no longer be tracked. However if a Soft
Frame has multiple LEDs and a single LED becomes hidden or is removed, Tracking will continue but shift
to follow the centroid of the remaining LEDs. You can not oﬀset the centroid of a Soft Frame, and no
orientation data is calculated.
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Body Frames Widget

Overview
The Body Frames widget (or central widget) in the Frame Calibration View lists the Frames that have
been created. The widget presents a table view listing the Name, Frame ID, the type of Frame (Soft or
Rigid) and the Status of the Frame (LEDs not ready, Ready to Construct and Constructed). From this
Widget, we can create, clone and remove Rigid and Soft Frames as well as assign a numerical name to
the Frame, similar to a Beacon ID.
Usage
The widget is a table of all Frames in the project. The Table is composed of four columns: Name, Frame
ID, Type, and Status; and at the bottom: the Frame ID box, Frame type drop-down, +/- buttons, clone
frame and reset buttons.
Name
The assigned name of the Frame, RF or SF (depending on the type of Frame), followed by the
ID assigned to the Frame when it was created
Frame ID
The ID assigned to the Frame when it was created
Type
The type of Frame (Rigid or Soft)
Status
Red: LEDs not ready.
Yellow: Ready to Construct.
Green: Constructed.
Note: Once the Frame has been constructed, but the LEDs assigned to the Frame have not yet been
seen by the system, the Frame's status will list out the LEDs that must be seen before it changes to the
"Constructed" status.
Frame ID:
At the bottom of the widget, a text entry ﬁeld exists to enter the Frame ID, which can be any
number so long as it is not already taken by an existing beacon or Frame in the system.
Type:
The Type drop down speciﬁes what type of Frame is bing created (Rigid or Soft).
+ button:
The + button adds (create) a Frame to the list after the Frame ID and Type have been
speciﬁed.
Delete button:
The Delete button removes a Frame from the list.
Note: Click Yes or Cancel in the delete conﬁrmation dialog that appears.
Clone the selected frame:
Click this button to copy and paste a selected frame, then type the new frame ID in the Clone
Frame dialog that will appear.
Reset All Frames:
Click this button to reset the frames listed in the table.
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Frame LEDs widget

Overview
The Frame LEDs widget is a widget speciﬁc to the Frame Calibration View, that lists all the LEDs assigned
to the currently selected Rigid or Soft Frame. The widget lists the LEDs assigned in a table format. The
columns listed are: Beacon ID-LED ID, LED Index, Information on the LED placement order, and the
Visibility status.
Usage
The Frame LEDs widget is used to assign Beacon LEDs to the currently selected frame in the Body
Frames widget. The widget lists all the LEDs currently assigned to the selected frame in a column format,
with the following columns:
Beacon ID-LED ID
Lists the Beacon ID and the LED ID (example 3-1 is Beacon 3, LED 1).
LED Index
The ID of the LED sorted in order of insertion (before re-ordering).
Info
Lists the informaton on the LED placement order: Origin, X-Axis, Cross-Product, Additional.
Please refer to Assigning LEDs to a Rigid Frame in Rigid Frames.
Visible
Shows the visibility status icon (Blue for visible, red for not visible, grey for inactive).
You can drag beacons from the global Beacons widget to add to the currently selected frame into this
widget to assign them to the frame.
There are also three buttons at the bottom of the widget:
Remove Selected LEDs
Removes the select LED from the frame.
Re-Order LED: Switch with Previous
Moves the currently selected LED and swaps it with the previous LED, if it is the ﬁrst in the
list, it will not move.
Re-Order LED: Switch with Next
Moves the currently selected LED and swaps it with the next LED in the list, if it is the last in
the list, it will not move.
You can replace each of the beacons in the Frame LEDs widget.
To replace a beacon
1. In the Frame LEDs widget, right click on a selected beacon in the table.
Result: The Replace Beacon tooltip is displayed.
2. Click on the Replace Beacon tooltip.
Result: The Replace Beacon dialog is displayed.
3. From the drop-down list, select the Beacon ID which will replace the selected Beacon.
4. Click OK.
Result: The new Beacon ID number is displayed in the table with the corresponding LED ID.
Note: Re-construct the Rigid Frame in the Rigid Frame Construction widget, then click Apply Changes.
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Frame Construction Widget

Overview
This widget is used to conﬁgure and monitor the currently selected frame in the Body Frames widget.
From this widget, Centroid Oﬀset and the Orientation Oﬀset can be set and applied separately. All the
changes can be applied to the existing frames in the project. Frames must ﬁrst be constructed in the
Rigid Frame Construction widget before they are ready for use.
Usage
The widget has several buttons used to perform various actions on the selected frame, or all frames in
the project:
Selected Frame
Displays the selected Rigid Frame
Construct Frame
Creates the solution for the currently selected Rigid Frame.
Set Home
Matches the orientation of the Rigid Frame to align with the world coordinate's orientation.
Reset Frame
Clears the solution for the selected Rigid Frame.
The Current Position and Current Orientation of the selected Rigid Frame lists the current position of
the centroid of all LEDs and the current orientation of the selected Rigid Frame. Centroid Oﬀset and
Orientation Oﬀset are used to change the calculated centroid and oﬀset of the constructed Rigid
Frame.
Soft Frames do not have the capability of oﬀsetting the centroid because the centroid of the frame is
calculated based on the current position of the LEDs in the frame at any given time, and the centroid
may change depending on how many LEDs are visible.
Centroid Oﬀset applies any oﬀsets to the Centroid of the currently selected Rigid Frame after the Rigid
Frame is constructed.
To set the Centroid Oﬀset values
1. Click on the Up or Down arrows to adjust the measurement values in the cells for X, Y and Z.
Tips:
Click on the cell then use the mouse wheel to scroll in increments of +/- 0.01m.
Click on the cell, press and hold CTRL and use the wheel to scroll in increments of +/- 0.10m.
Orientation Oﬀset applies any oﬀsets to the Orientation of the currently selected Rigid Frame after the
Rigid Frame is constructed.
To set the Orientation Oﬀset values
1. Click on the Up or Down arrows to adjust the values in the cells for X, Y and Z.
Tips:
Click on the cell then use the mouse wheel to scroll in increments of +/- 1 degree.
Click on the cell, press and hold CTRL and use the wheel to scroll in increments of +/- 10
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degrees.
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Table of Contents:
Rigid Frames
Soft Frames
Overview
Creating Frames can be done by creating and assigning a Frame ID from the Body Frames widget,
followed by assigning LEDs to a selected Frame. Once the LEDs are assigned, it is possible to conﬁgure
certain settings for Rigid Frames via the Rigid Frame Construction widget. The Rigid Frame Construction
widget also allows the monitoring of the Centroid for both Rigid and Soft frames, as well as the
orientation for Rigid Frames. This section will describe the process of creating both Rigid and Soft frames.
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Overview
Rigid frames are designed to be objects whose shape does not change, and is, as the name suggests
"rigid", such as a set piece like a table or box. Rigid Frames must have at least 3 LEDs assigned in order
for a solution to be created for the frame. There is no limit to the number of LEDs that can be assigned to
a rigid frame, if at any point less than 3 LEDs are visible for the speciﬁc rigid frame, then tracking will
stop. This section will outline the creation of a rigid frame.
Creating a Rigid Frame
Creation of a rigid frame is done through the Body Frames widget. The ﬁrst step is to assign an ID to the
frame, which can be completed by performing the following:
1. Enter a numerical ID for the frame in the Frame ID box (Beacon ID) at the bottom of the Body
Frames widget.
2. From the drop-down, select Rigid Body.
3. Hit the green + button.
Once the frame is created, you may double-click and type a new name on the default name cell, and
press ENTER. By default a Rigid Frame will be given a name of 'RF(ID)'.
Assigning LEDs to a Rigid Frame
Assigning LEDs to a rigid frame is achieved by dragging individual beacons from the global Beacons
widget to the Frame LEDs widget with a rigid frame selected in the Body Frames widget. It is important to
place the LEDs in the correct order on the object as well as in the Frame LEDs widget, as the ﬁrst three
LEDs assigned to a rigid frame deﬁne the orientation of the frame.
The ﬁrst LED will correspond to the origin of the local coordinate system of the object
The second LED will correspond to the positive x-axis
The third LED is special in that it can be placed anywhere, however it deﬁnes the location of the
positive y-axis in the following way:
Placing the third LED somewhere in the same plane as LED 1 and LED 2, and taking the
cross product of the vectors from the origin to LED 2, and the origin to LED 3 will deﬁne
the positive z-direction of the local coordinate system of the rigid body. To determine the
cross-product, one can simply use the right hand rule
The right hand rule can be performed as follows:
1. Take the side of the right hand, and place it along the line from the origin (LED 1) to the
positive x-axis (LED 2)
2. Curl the ﬁngers of the right hand towards the line from the origin (LED 1) to LED 3
3. The direction that the thumb points is the positive z-axis
Once the ﬁrst three LEDs are placed, any further LEDs added to the rigid body can be placed anywhere
and will be used as additional tracking points for the object, but are not required.

Constructing the Frame
Once the LEDs have been assigned the frame can be initialized and the solution can be calculated. To do
this, simply click Construct Frame in the Rigid Frame Construction widget. If the original solution of the
rigid frame changes, BlackTrax will attempt to adjust the existing solution accordingly. This will change
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the status of all current frames with LEDs assigned to them from "Done" to a list of the LEDs that have
not yet appeared (visible to the tracking system). The Apply Changes button will send all ready frames to
the global Beacons widget(s), allowing them to be assigned to a trackable. The Reset All Frames button
will remove the solution from all Frames, but not delete them. You must Apply Changes.

Set Home
In most situations, it will be necessary to align the Rigid Frame's orientation to an acceptable 'home'
position. A home position is where the object will be 0,0,0 for the Roll, Pitch, and Yaw respectively. It is
possible to manually preform this action, but it is much easier to allow BlackTrax to determine this for
you.
To use the set home function
1. Align the real world object along the same plain as the world coordinate system (that is, ensure
your X, Y, and Z directions match where you set the ground plane, an example is to set the front
face of the object facing -Y).
2. Select your desired Frame, select Set Home.
Result: Your object will now be orientated with Roll - 0, Pitch - 0, and Yaw - 0. The object will rotate in
the same way that the real world coordinate system would rotate.
Once the object is 'homed', it is easier to oﬀset the centroid and orientation of the Rigid Frame (although
you may do this before you home the object, if desired). Simply enter the required values into the X, Y,
and Z ﬁelds for the centroid (in meters), and Roll, Pitch, and Yaw ﬁelds for Orientation (in degrees). These
settings will be applied automatically, based oﬀ the time set under System Conﬁguration>Frame
Calibration>Updating oﬀsets interval (seconds). By default this is set to update 0.5 seconds after the
values are updated.
Note: You do not need to Apply Changes when doing centroid and orientation oﬀsets or setting the
home orientation.
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Overview
Soft frames are designed to be objects whose shape can be ﬂexible, such as a person or inﬂatable object.
Soft frames need a single LED assigned in order for a solution to be created for the frame. There is no
limit to the number of LEDs that can be assigned to a soft frame, if at any point less than 1 LED is visible
for the speciﬁc frame, then tracking will stop. This section will outline the creation of a soft frame.
Creating a Soft Frame
Creation of a soft frame is done through the Body Frames widget. The ﬁrst step is to assign an ID to the
frame, which can be completed by performing the following:
1. Enter a numerical ID for the frame in the Frame ID box (Beacon ID) at the bottom of the Body
Frames widget.
2. From the drop-down, select Soft Body.
3. Hit the green + button.
Once the frame is created, you may give it a name by double-clicking the default name cell, typing a new
name, and pressing enter. By default a Soft Frame will be given a name of 'SF(ID)'. You must Apply
Changes after a name change.
Assigning LEDs to a Soft Frame
Assigning LEDs to a soft frame is achieved by dragging individual beacons from the global Beacons
widget to the Frame LEDs widget with a soft frame selected in the Body Frames widget. The order of the
LEDs for a soft frame does not matter, as all soft frames are tracked at the centroid of the frame.

Constructing the Frame
Once the LEDs have been assigned the frame can be initialized and the solution can be calculated. To do
this, simply hit the Apply Changes button in the Rigid Frame Construction widget. This will change the
status of all current frames with LEDs assigned to them from "Done" to a list of the LEDs that have not
yet appeared (visible to the tracking system). This will send all ready frames to the global Beacon
widget(s), allowing them to be assigned to a trackable. The Reset All Frames button will not aﬀect soft
frames. The centroid of a soft frame cannot be set as the centroid is constantly being re-calculated based
on the position of the LEDs that the frame is made up of.
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Table of Contents:
Edit Chapters Widget
Edit Books Widget
Libraries Widget
Fixture Settings Widget
Trackable Settings Widget
Programming Chapters
Undo Stack
Terminal Widget
Error Codes for Unsupported Fixtures
Overview
The Editing View is where moving ﬁxtures are assigned to follow the position of Trackables in chapters. A
chapter is saved information on which Trackables are to be tracked, and which ﬁxtures are to follow them
at a speciﬁc instance. Speciﬁc customization can also be enabled in a chapter such as conﬁguring how a
BTBeacon’s LEDs should be used for Tracking; if a zone is to be used in the chapter; and if a terminal
command is used to alter tracking behavior.
Edit View Overview
Single Chapter Conﬁguration
The central widget in the Editing View is used for modifying Chapters and assigning Trackables and
Fixtures to the chapters. The Single Chapter tab is used to modify settings for the currently selected
chapter in the Edit Chapters widget. With a chapter selected in the Edit Chapters widget, it is possible to
drag trackables from the Trackables Library into the top area of the central widget to assign the
trackable to the selected Chapter. It is also possible to copy/paste Trackables using the "Copy/Paste"
buttons, and delete selected trackables from the selected chapter using the "Delete" button.
Once a trackable is assigned to a chapter, selecting the chapter, then the corresponding trackable you
wish to assign ﬁxtures to, you can drag the desired ﬁxtures from the Fixtures library in the Libraries
widget to the bottom area of the central widget. It is also possible to copy/paste Fixtures using the
"Copy/Paste" buttons, and delete selected ﬁxtures from the selected trackable/chapter using the "Delete"
button.
Applying ﬁxture settings is achieved by selecting the ﬁxture you desire in the bottom pane of the central
widget, and opening the Fixture Settings widget to apply any desired settings.
The method of displaying ﬁxtures in Single Chapter can be done via List View or Table View. You can add
ﬁlters in each view to display which ﬁxtures have speciﬁc settings.
Uses Iris - Will show if a ﬁxture uses iris to change the beam size
Uses Prediction - Will show if a ﬁxture has prediction settings
Has Oﬀset - Will show if a ﬁxture has any oﬀset settings applied
Has Following Setting - Will display if a ﬁxture is assigned to follow speciﬁc LEDs of assigned
BTBeacons
Uses LED 1 - Will display if a ﬁxture is assigned to follow the LED in BTBeacon port 1
Uses LED 2 - Will display if a ﬁxture is assigned to follow the LED in BTBeacon port 2
Uses LED 3 - Will display if a ﬁxture is assigned to follow the LED in BTBeacon port 3
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Uses Zones - Will show if a ﬁxture uses zoom to change the beam size
Uses Auto-Spot Mode - Will show if a ﬁxture has Auto-Spot mode settings
Uses Zoom - Will show if a ﬁxture has any zone settings applied
Using Table View changes the view to display all ﬁxtures assigned to the currently selected trackable in a
table format. The columns are conﬁgurable, and will display an icon in the corresponding column
according to which settings are applied to the ﬁxture. The columns are Spot ID, and Type, followed by
any of the settings enabled in the following list:
LED Following
Iris
Zoom
Auto-Spot
Zone
Prediction
Oﬀset
The Clear Trackable Selection button at the bottom of the top pane of the central widget will clear the
selected individual trackable or all the selected trackables.
The Clear Fixture Selection button at the bottom of the bottom pane of the central widget will clear the
selected individual ﬁxture or all the selected ﬁxtures.
Several Chapter Conﬁguration

It is possible to apply settings to several ﬁxtures at once, across multiple chapters. This can be done via
the Several Chapters tab in the central widget. In order to select multiple chapters and have them
appear in the widget, do the following:
1. Select the chapters you want from the Edit Chapters widget.
2. At the bottom of the central widget, hit the Scan Chapters button.
Result: All ﬁxtures in the selected chapters will be displayed.
3. Select the ﬁxtures you want to apply settings to, and change desired settings in the Fixture
Settings widget.
If you choose to check the Auto-Select box, then there is no need to hit Make Selection, you can simply
select the ﬁxtures you want to apply settings to and the Fixture Settings widget will allow you to make
changes to the settings of each selected ﬁxture. You may wish to de-select Auto-Select if you are
selecting several ﬁxtures at once (more than 1000 across all chapters).
The Search box allows you to search for ﬁxtures by spot number, or ﬁxture type across the selected
chapters.
The Clear Selection button at the bottom will clear the selected individual ﬁxture or all the selected
ﬁxtures.
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Overview
The Edit Chapters widget is where Chapters are created, removed, and re-ordered. The currently
selected chapter or chapters in this widget deﬁne what is displayed in the central pane of the Edit View,
in Single, or Several chapter mode.
The Edit Chapters widget is where Preset Calibrations are displayed, recalled and selected for each
Chapter.

Edit Chapters Widget

Functionality
The following actions can be performed from the Edit Chapters widget:
To Create a New Chapter
1. In the Edit Chapters widget, click the Plus button.
Result: A blank chapter will be created in the chapter list below the currently selected
chapter.
2. For the changes to take eﬀect, click Apply Changes.
To Create a Copy of an Existing Chapter
Copying a chapter will copy all aspects of the selected chapter, including ﬁxture and Trackable
relationships.
1. In the Edit Chapters widget, select the chapter you want to copy.
2. Click the Copy selected chapter button.
Result: A copy of the chapter will be created in the chapter list below the currently selected
chapter.
3. For the changes to take eﬀect, click Apply Changes.
To Delete a Chapter
1. In the Edit Chapters widget, select the chapter you want to delete.
2. Click the Delete button.
3. A dialog box will appear asking if you really want to delete the chapter. To conﬁrm deletion, click
Yes.
4. For the changes to take eﬀect, click Apply Changes.
To Move Chapters in the Chapter List
1. In the Edit Chapters widget, select the chapter you want to move.
2. Move the chapter up or down by clicking the Up Arrow or Down Arrow button respectively.
3. For the changes to take eﬀect, click Apply Changes.
To Name a Chapter
1. In the Edit Chapters widget, in the Name ﬁeld of the chapter, double-click to enable editing.
2. Enter the name of the chapter in the Name ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
To Write a Description of a Chapter
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1. In the Edit Chapters widget, in the Description ﬁeld of the chapter, double-click to enable editing.
2. Enter the chapter description in the Description ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
To Select a Preset Calibration for a Chapter
1. In the Edit Chapters widget, highlight the row to select a Chapter.
2. In the highlighted Chapter row, double-click on the Preset Calibration ﬁeld.
3. Select the preset from the Preset Calibration drop-down.
Result: The ﬁxture calibration data collected under the selected preset will be applied to the
selected Chapter.
Edit Chapters Widget in Extended Chapters (with Books) mode

Edit Chapters Widget

In Extended Chapters (with Books) mode, the Edit Chapters Widget will display the name of the selected
Book where the current selected Chapter is accessed. See Edit Books Widget.
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Overview
When BlackTrax is in Extended Chapters (with Books) mode, Chapters can be created, edited, saved
and managed as part of a Book or Books. In the Edit Books widget, a Book with Chapters can be created,
removed, re-ordered or selected for editing. The Chapters in the selected Book will be displayed in the
Edit Chapters widget for editing.

Edit Books Widget

Functionality
The following actions can be performed from the Edit Books widget:
To Select a Chapter from a Book
1. In the Edit Books widget, from the table list of Books, click on the Book that contains the Chapter
you want to select.
Result: The list of Chapters available in the selected Book will be displayed in the Edit
Chapters widget. You can proceed to select the Chapter from the Edit Chapters widget.
To Create a New Book
1. In the Edit Books widget, click the Plus button.
Result: A blank Book will be created in the Book list below the currently selected Book.
2. For the changes to take eﬀect, click Apply Changes.
To Create a Copy of an Existing Book
Copying a Book will copy all the Chapters in the selected Book, including ﬁxture and Trackable
relationships in all the Chapters in the selected Book.
1. In the Edit Books widget, select the Book you want to copy.
2. Click the Copy selected book button.
Result: A copy of the Book will be created in the Books list below the currently selected
Book.
3. For the changes to take eﬀect, click Apply Changes.
To Delete a Book
1.
2.
3.
4.

In the Edit Books widget, select the Book you want to delete.
Click the Delete button.
A dialog box will appear asking if you really want to delete the Book. To conﬁrm deletion, click Yes.
For the changes to take eﬀect, click Apply Changes.

To Move Books in the Books List
1. In the Edit Books widget, select the Book you want to move.
2. Click the Up Arrow or Down Arrow button.
3. For the changes to take eﬀect, click Apply Changes.
To Name a Book
1. In the Edit Books widget, double-click the Name ﬁeld of the selected Book.
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2. Write the name of the Book in the Name ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
To Write a Description of a Book
1. In the Edit Books widget, double-click the Description ﬁeld of the selected Book.
2. Write the description in the Description ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
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Overview
The Libraries widget contains all Trackables, Fixtures, and Zones that can be applied to Chapters in the
Editing View. The widget is separated into three tabs, one each for Trackables, Fixtures and Zones. Each
type of assignable item can be dragged from the Libraries widget into its respective area in the Edit view.
The top area for trackables, bottom area for ﬁxtures being assigned to trackables, and into the Fixture
Settings widget for Zones.
Trackables Tab
The Trackables tab is organized in a table format with three columns: Name, WYG Trackable, and Patch
status. The name is the name of the trackable in BlackTrax, which can be changed by double-clicking on
the name ﬁeld in the widget. The WYG Trackable is the name of the trackable when it was exported from
BTWYSIWYG. Finally, the patch status is whether or not the trackable has been assigned to a chapter or
chapters, signiﬁed by a blue checkmark
Depending on your BlackTrax project, you may have a large amount of Trackables to keep track of. The
Search Trackables function helps you to sort and locate the exact Trackables you need.

Libraries Widget viewing the Trackables Tab

To search for a Trackable
1. In the Trackables section, select from the Search By... drop-down menu how you want to search for
Trackables.
Note: By Name will search for Trackables based on how a Trackable is named in BlackTrax.
By WYSIWYG Frame will search for Trackables based on how a Trackable is named in
BTWYSIWYG.
2. In the Search Trackables ﬁeld, enter the name of the Trackable(s) you are looking for.
Result: The Trackable List will display only Trackables that meet your search criteria.
Grouping Trackables
To group certain trackables together to display in live mode, you use the group feature in this widget.
This can be done by selecting the trackables you would like to group, and hitting the Add button. This will
open a dialog which will prompt you for a group name. Once created, the group will appear in the
Group drop-down menu. The Delete button will delete the currently selected group (but not the
Trackables themselves).
Note: The current group selection does change the ﬁltering of the Trackable widget.
Fixtures Tab
The Fixtures tab is organized in a table structure with columns for Spot ID, Fixture Name, whether or not
it is assigned, and which Trackables it is assigned to in the currently selected chapter.
Like Trackables, there is built in search functionality to search by patch info, ﬁxture name, or by WYG
Trackable assignment.
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Libraries Widget viewing the Fixtures Tab

To search for a Fixture
1. In the Fixtures section, select from the Search By... drop-down menu how you want to search for
Fixtures.
Note: By Name will search for Fixtures based on how a Fixture is named in BlackTrax. By
WYSIWYG Trackable will search for Fixtures based on how a Trackable is named in
BTWYSIWYG.
2. In the Search Fixtures ﬁeld, enter the name of the Fixture(s) you are looking for.
Result: The Fixture List will display only Fixtures that meet your search criteria.
Zones Tab
The Zones tab is straightforward, and has only two columns, the zone Name, and the Shape Type. There
are no advanced search capabilities for zones.

Libraries Widget viewing the Zones Tab
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Overview
The Fixture Settings tab allows you to conﬁgure how ﬁxtures interact with Trackables in a speciﬁc
chapter. Fixture settings are separated into four tab sections: Basic, Oﬀset, Auto Spot and Zones.

Fixture Settings - Basic tab
Basic: This section has general settings that can be conﬁgured for a ﬁxture. The size of the beam
using the zoom or iris of the ﬁxture. Controlling how the ﬁxture deals with pan-ﬂips. What
sensitivity is used when the ﬁxture follows the trackable.
Oﬀset: This section has LED Following Settings for selecting which individual LEDs of a BTBeacon
assigned to follow a Trackable should follow.
Auto Spot: This section is for conﬁguring the ﬁxture's following properties, to better mimic that of a
human follow spot operator.
Zones: This section is for conﬁguring the ﬁxtures interaction with any zones in the chapter.
You can select a single ﬁxture, or multiple ﬁxtures in the centre area of Edit View to have Fixture Settings
display the collective settings. In multi-ﬁxture selection, there is always an 'active' ﬁxture, which displays
its current settings in the Fixture Settings widget. The active ﬁxture is indicated by the name and spot ID
of the ﬁxture at the top of the Fixture Settings widget.
When you have multi-ﬁxtures selected, any diﬀerences between ﬁxtures will be shown with a grey
highlight. For example: Spot 1 has a zoom setting of 1m and Spot 2 has a zoom setting of 2m. When you
select both ﬁxtures, the text box will highlight grey to indicate a diﬀerence between the two ﬁxtures.

Fixture settings - Basic tab (With multiple ﬁxtures selected, diﬀerences highlighted and Intensity Control
features marked.)
Beam size control
BlackTrax allows you to control the size of a ﬁxture’s beam while it is following a Trackable. This is done
using the iris or zoom features of a ﬁxture. The beam setting of a ﬁxture is linked to the chapter it was
created. Fixtures can be in multiple chapters and have a diﬀerent beam sizes in each chapter.
If both zoom and iris control are enabled, the BTSystem will tell the ﬁxture to ﬁrst use zoom control to
shape the beam size. Using both the iris and zoom can increase the range.
To control the beam size of a ﬁxture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
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3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, select the method of controlling the beam size by marking the
check-box next to the desired method.
Result: The Beam Diameter and Distance Range settings will appear.
5. In the Beam Diameter ﬁeld, enter the desired beam diameter (in meters).
Result: The Distance Range will show at what distance from the ﬁxture the beam diameter
can be maintained.
6. For the changes to take eﬀect, click Apply Changes.
Intensity control
Enable Pan-Flip Dimming: This feature manages how a ﬁxture should behave if it encounters a panﬂip during tracking in the chapter. When a ﬁxture encounters a pan-ﬂip in BlackTrax, the ﬁxture will
douse, perform the ﬂip then turn back on. The Pan-Flip Dimming feature can be enabled to add
addition time before turning back on.
To enable Pan-Flip Dimming
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, mark the checkbox next to Enable Pan-Flip Dimming.
Result: The Extra douse time feature appears.
5. To add extra douse time, enter the number of seconds in the Extra douse time ﬁeld or use the
slider.
Note: The range of time is limited to 0-3 seconds.
6. For the changes to take eﬀect, click Apply Changes.
Smooth Pickups: This feature turns the ﬁxture On once as a single event per chapter, only when
the Beacon is visible.
BlackTrax checks for motion at the beginning of the chapter.
BlackTrax automatically douses the ﬁxture to 0 if motion is not detected. When motion is
seen, the ﬁxture fades in to console control over the fade time speciﬁed once the Trackable
Visible For: time has elapsed (motion must be seen continuously during this time for the fade
to start).
When completed, the Smooth Pickups feature is disabled for the remainder of the chapter.
Smooth Pickups is disabled by default.
To enable and set Smooth Pickups
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, mark the checkbox Smooth Pickups.
5. Click on the Trackable Visible For: scroll box to set the length of time required for a Trackable to be
visible and the light to fade in.
6. Click on the Fade-in time: scroll box to set how long the light fades in.
Auto Douse: This feature turns the ﬁxture On only when the Beacon is visible and as an ongoing
event all throughout the course of the chapter.
If all LEDs of the patched Beacon becomes hidden, BlackTrax automatically douses the ﬁxture
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to 0 (from console control) after the reaction time is complete.
BlackTrax automatically fades in the ﬁxture when at least one LED is visible and after the
reaction time is complete.
Reaction time is the length of time required for motion to be visible, or to be hidden before
the fade time starts.
To enable and set Auto Douse
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, mark the checkbox Auto Douse.
5. Click on the Reaction Time: scroll box to set the length of hidden or visible time for fade time to
start.
6. Click on the Fade-In Time: scroll box to set how long the light fades in.
7. Click on the Fade-Out Time: scroll box to set how long the light fades out.
Following Sensitivity
Sensitivity determines exactly how a ﬁxture is supposed to follow a Trackable. The prediction algorithms
takes the current BTBeacon and ﬁxture information and makes an informed prediction on where the
Trackable will be next. The BTSystem will then be able to anticipate where the ﬁxture needs to aim to
keep tracking tight on the Trackable.
The prediction algorithm available are:
None: No prediction is used.
Standard Prediction: Taking the pan and tilt settings of ﬁxtures following the Trackable, a Kalman
ﬁlter is used to estimate the velocity and poisition of the ﬁxture. A prediction of the ﬁxture's future
pan/tilt values is then created.
Delay: Fixtures will follow a Trackable’s position after a set amount of time. This causes ﬁxtures to
follow behind moving Trackables. Useful for eﬀects.
Linear Prediction: Taking the current BTBeacon position as input, a Kalman ﬁlter is used to estimate
the velocity, and position of the Trackable. A prediction of the Trackable’s future movement is then
created.
Second Order Prediction: Taking the current BTBeacon position as input, a Kalman ﬁlter is used to
estimate the acceleration, velocity, and position of the Trackable. A prediction of the Trackable’s
future movement is then created.
Second Order+Prediction: Taking the pan and tilt settings of ﬁxtures following the Trackable, a
Kalman ﬁlter is used to estimate the acceleration, velocity, and position of the ﬁxture. A prediction
of the ﬁxture’s future pan/tilt values is then created.
Fixture responsiveness can also be conﬁgured with prediction. Fixture responsiveness is measured on a
scale of -4 (Smooth) to 2 (Responsive).
Smooth: A ﬁxture set to smooth will follow Trackables in a ﬂuid manner. This may appear as a
delay in extreme cases.
Responsive: A ﬁxture set to responsive will jump to and track every slight movement of a
Trackable. This may appear very jumpy in extreme cases.
Note: It is recommended that you test a ﬁxture’s prediction prior to use, to determine if the chosen
prediction movement is right for your tracking needs.
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To Assign an Algorithm to a Fixture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, select the desired sensitivity from the Sensitivity drop-down
menu.
If you want the ﬁxture to be tracking ahead of where the Trackable will be, enter how far
ahead in time (milliseconds) in the Ahead Time ﬁeld.
5. Assign how reactive you want the ﬁxture to follow by adjusting the Turner value slider to between
Smooth or Responsive.
6. For the changes to take eﬀect, click Apply Changes.

Fixture Settings - Oﬀset tab
LED Following Settings
Each Trackable can have the LEDs of assigned BTBeacons tracked individually by the BTSystem. This can
be used instead of the default setting which is the average position of all visible LEDs. Tracking can also
be altered, to follow a Trackable but on an oﬀset.
To Assign a Fixture to an Individual LED of a Trackable
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. In the LED Following Settings section, mark the radio next to the LED you want to follow.
5. For the changes to take eﬀect, click Apply Changes.
To Oﬀset the Tracking of a Trackable by a Fixture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. In the LED Following Settings section, mark the Enable Oﬀset checkbox to set the tracking oﬀset
from the X, Y, or Z axis.
5. Under the Oﬀset subsection, enter how far oﬀ from the centroid you want to oﬀset tracking in the
X, Y or Z axis by entering the values in the X, Y or Z ﬁelds.
6. For the changes to take eﬀect, click Apply Changes.
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Fixture Settings - Auto Spot tab
Auto Spot Mode settings
Auto Spot Mode is where a ﬁxture simulates the behavior of a manual follow spot. In normal operation,
moving ﬁxtures will lock on to a Trackable and follow all movement, even if the movement is very slight.
This has the possibility of making the ﬁxture’s light look shaky or jittery. In Auto Spot Mode, when a
Trackable is relatively still, the following ﬁxture will freeze in place. When the Trackable starts to make
larger movements, and/or attempt to exit the frozen light beam, the ﬁxture will unfreeze and continue
following tightly.
There are two diﬀerent follow spot modes to choose from. They can be used independently or together.
The diﬀerent auto spot modes are:
Local Damping: The system will ignore small movements on all axis.
Z-Damping: The system will ignore small vertical movements on the Z axis.
Note: Auto Spot Mode is determined per ﬁxture, per Chapter.
To Enable Auto Spot Mode for a Fixture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Auto Spot Mode Settings section, mark the checkbox next to the desired Auto Spot
Mode(s).
5. For the changes to take eﬀect, click Apply Changes.

Fixture Settings - Zones tab
Zone settings
Zones in the project can be enabled to interact with ﬁxtures following Trackables. When a Trackable or
the beam of a ﬁxture following the Trackable enters a zone, the ﬁxture can be turned on or doused. How
ﬁxtures interact with zones is user deﬁnable.
Zones can have their interaction with Trackables and ﬁxtures customized in the following ways:
Douse Out: A ﬁxture will douse when the Trackable it is following interacts with a zone.
Inside Zone: The ﬁxture will be doused while the Trackable is inside the zone.
Outside Zone: The ﬁxture will be doused while the Trackable is outside the zone.
Collision Type: How the Trackable and ﬁxture relationship interacts with the zone.
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Beam collision: When the beam of the ﬁxture following the Trackable is in the zone, the
relationship is considered in the zone.
Note: A reﬂection of the beam will not count. The size of the beam must be set for
Beam collision to work.
Point collision: When the Trackable is physically in the zone, the relationship is considered in
the zone.
To Enable a Zone for a Fixture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center area, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Auto Spot Mode Settings section, mark the checkbox next to the desired Zone Enabled.
5. Select which zone you want the ﬁxture to interact with by selecting the zone from the Zone tab in
the Library section, and dragging and dropping it in the Zone ﬁeld in the Fixture Settings tab.
6. Choose how you want the ﬁxture to douse when encountering the zone by selecting the option
from the Douse Out drop-down menu.
To have the ﬁxture fade-in rather then instantly turn on, enter the amount of time for the
fade-in in the Fade-in Time ﬁeld.
To have the ﬁxture fade-out rather then instantly turn oﬀ, enter the amount of time for the
fade-out in the Fade-out Time ﬁeld.
7. Choose how you want the to interact with the zone by selecting the option from the Collision type
drop-down menu.
8. For the changes to take eﬀect, click Apply Changes.
Note: For the changes to take eﬀect, click Apply Changes. See “BlackTrax Zones” for more
information on creating zones for a BlackTrax project.
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Trackable Settings Widget

Overview
The Trackable Settings widget is where information on the currently selected Trackable is shown, and
where the selected Trackable's settings can be edited. Trackable settings are linked to the Trackable
itself. Any BTBeacon or rigid frame assigned to the Trackable will inherit the Trackable’s settings, and
function as directed.
Setting LED Tracking
When Trackables are tracked, the position of the assigned BTBeacon’s LEDs are the Trackables position
according to the BTSystem. Which LEDs and in what conﬁguration can be customized in the Trackable
Settings widget.
When determining position, the average position, or centroid, of all selected and visible LEDs is used.
Possible conﬁgurations of Trackable LEDs are:
All Available LEDs
LED 1 and 2
LED 1 and 3
LED 2 and 3
LED 1
LED 2
LED 3
Attention: These changes are global for the chapter. Per chapter ﬁxture, LED Following settings will
override these settings.
To conﬁgure the Centroid Type of a Trackable
1. In the Edit Chapters widget, select the chapter the Trackable is in.
2. In the Trackable section, select the Trackable Container of the Trackable.
3. With the Trackable Container selected, go to the Trackable Settings widget and select the desired
centroid type from the Centroid Type drop-down menu.
4. For the changes to take eﬀect, click Apply Changes.
NOTE: These settings will not be applied to rigid or soft frames.
Enabling Orientation
1. In the Trackable section, select the Trackable Container of the Trackable.
2. With the Trackable Container selected, go to the Trackable Settings widget and select Enable from
the Orientation drop-down menu
3. For the changes to take eﬀect, click Apply Changes.
Note: If you have disabled orientation for a rigid frame, then orientation will not update in the Frame
Calibration view.
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The Relationship section displays which ﬁxtures are assigned to which Trackables in the chapter.
Available Trackable and ﬁxtures are shown in the Library section.
To add a Trackable to a chapter
1.
2.
3.
4.

In the Chapter widget, select a chapter you want to add a Trackable to.
View available Trackables by going to the Library widget and clicking on the Trackables tab.
In the Trackables tab, select the Trackable you want to add.
Click Add.
Result: A Trackable Container of the Trackable will appear in the Relationship section for the
chapter.
Note: Trackables can also be added to a chapter by dragging and dropping a Trackable from
the Trackables tab into the top section of the centre area.
5. For the changes to take eﬀect, click Apply Changes.
To delete a Trackable from a chapter
1.
2.
3.
4.

In the Chapter widget, select a chapter you want to delete a Trackable from.
View available Trackables by going to the Library widget and clicking on the Trackables tab.
In the Trackables tab, select the Trackable you want to delete.
Click Delete.
Result: The Trackable will be removed from the Chapter.
Note: You can also drag and drop the Trackable back into the Library or by clicking the
delete button in the Trackable section.
5. For the changes to take eﬀect, click Apply Changes.
To remove all Trackables from a chapter
1. In the Chapter widget, select a chapter you wish removes all Trackables from.
2. Select all Trackables in the Chapter in the centre area.
3. For the changes to take eﬀect, click Apply Changes.
To assign a ﬁxture to a Trackable
When a ﬁxture is assigned to a Trackable, the BTSystem will instruct the ﬁxture to follow the Trackable.
Fixtures will only follow an assigned Trackable in the chapter they are assigned, and only when that
chapter is active.
1.
2.
3.
4.
5.

In the Chapter widget, select a chapter that has a Trackable you want to assign a ﬁxture to.
In the centre area , select the Trackable bubble of the Trackable.
View available ﬁxtures by going to the Library widget and clicking the Fixtures tab.
In the Fixtures tab, select a ﬁxture you want to assign to the Trackable.
Click Assign.
Result: A Fixture Box of the ﬁxture will appear in the bottom section of the centre area
indicating it is assigned to that Trackable.
Note: Fixtures can also be assigned a Trackable by dragging ﬁxtures from the Fixtures tab
and dropping them onto a Trackable Container.
6. For the changes to take eﬀect, click Apply Changes.
To unassign a ﬁxture from a Trackable
1.
2.
3.
4.

In the Chapter widget, select a chapter that has a Trackable you want to unassign a ﬁxture from.
Go to the Library widget and click the Fixtures tab.
In the Fixtures tab, select the ﬁxture you want to unassign from the Trackable.
Click Unassign.
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Result: The Fixture will be removed from the Trackable.
Note: Fixtures can also be removed from Trackables by dragging ﬁxtures from the Trackable
Box to the Library widget.
5. For the changes to take eﬀect, click Apply Changes.
To copy and paste a Trackable from a chapter to another chapter
1.
2.
3.
4.
5.

In the Edit Chapters widget, select a Chapter with the Trackable you want to copy.
In the Chapter widget, click on the Trackable you want to copy.
Click on the Copy button.
In the Edit Chapters widget, select another Chapter you want to paste the copied Trackable.
In the Chapter widget, click on the Paste button.
Result: The Overwrite dialogue box will appear.
6. Click on Overwrite to cut and paste the selected Trackable or click on Keep to cancel the operation
and keep the previous Trackable.
Result: The icon of the copied Trackable will appear in the Chapter widget when Overwrite is
selected.
7. For the changes to take eﬀect, click Apply Changes.
To copy and paste the ﬁxtures from a Trackable to another Trackable
1.
2.
3.
4.
5.

In the Chapter widget, click on the Trackable with the Fixture/s you want to copy.
In the bottom section of the Chapter widget, click on the Fixture/s you want to copy.
Click on the Copy button.
On the same Chapter widget, click on another Trackable you want to paste the copied Fixture/s.
Click on the Paste button.
Result: The Overwrite dialogue box will appear.
6. Click on Overwrite to cut and paste the selected Fixture/s or click on Keep to cancel the operation
and keep the previous Fixture/s.
7. For the changes to take eﬀect, click Apply Changes.
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The Undo Stack widget is where you can undo and redo changes applied in Edit View of the BlackTrax,
such as chapter, editing, ﬁxture settings and Trackable renaming. The Undo Stack widget displays all the
editing operations that have been completed in Edit View. Each of the editing operation listed can be
selected to set the Edit View according to the previous state of the selected editing operation history.

Undo Stack widget

To go to any point in the editing operations that have been applied
1. From the View menu, choose Undo Stack
2. In the Undo Stack widget, from the list on display, click on an editing history that you wish to go to.
Result: The Edit View goes to the applied state of BlackTrax in Edit View that is associated
with the selected history in the Undo Stack widget.
Tip: You can also use the keyboard shortcuts Ctrl+Z to undo, or Ctrl+Y to redo.
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Terminal Widget with Syntax for a "Fixture Train"
Overview
The Terminal lets you alter ﬁxture following behavior to achieve unique eﬀects in BlackTrax.
Attention: Terminal commands aﬀect speciﬁed ﬁxtures across all Trackables in the chapter.
To Enter a Terminal Command
1.
2.
3.
4.

In the Edit View, select the chapter you want to aﬀect.
Open the Terminal docking widget.
Click in the Terminal and enter in the command.
All commands must end with a semicolon.

Fixture Train Command
It is possible to have multiple ﬁxtures follow a Trackable one after the other creating a train or snaking
eﬀect. The parts of the command are as follows:
ﬁxtures= - The ﬁxtues following the Trackable.
Note: The ﬁxture is identiﬁed by the ﬁxture ID used in BlackTrax.
Note: Fixtures will follow in the order stated. Fixtures can be expressed as a range (e.g.
ﬁxtures=1-10), or listed individually (e.g. ﬁxtures=1,7,20).
Note: Fixtures must start and end with a square bracket '' and '' - see the example below
start= - The delay in ms before the ﬁrst ﬁxture will start following the Trackable.
step= - The delay in ms before a ﬁxture will start following the ﬁxture before it.
Example: If step=100ms, Fixture 1 will follow the Trackable after 100ms, Fixture 2 will follow
Fixture 1 100ms after that.
span= - The total time in ms you want to delay all ﬁxtures by. The delay between each ﬁxture is
determined by the number of ﬁxtures divided by span time.
Example: If you have ten ﬁxtures and the span is 1000ms, the delay between each ﬁxture
will be 100ms.
Attention: You can only have a span= for the eﬀect, or start= and step=. You cannot use both at once.
The following is an example of a complete ﬁxture train command to demonstrate how it call comes
together.
Example: delay ﬁxtures=1-10 start=50 step=1000;
In this example ﬁxtures 1 through 10 will follow the Trackable. Fixture 1 will start following 50ms after
the Trackable has started moving. Each subsequent ﬁxture will follow the one ahead of it 1000ms after it
moves.
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When you add new ﬁxtures in BTWYSIWYG, ﬁxture conﬁguration updates are applied to BlackTrax when
you Apply BTWYG Updates and Apply Changes.
The Messages dialog will conﬁrm the project update with the new BTWYG data that has been added to
BlackTrax.
The Messages dialog will conﬁrm that it has received unsupported ﬁxture conﬁguration displaying the
ﬁxture model proﬁle and the error codes. The description of the error codes are listed below. If you
receive an unsupported ﬁxture error code, please report it to BlackTrax support, with the model, and any
error codes received.
To apply ﬁxture conﬁguration updates from BTWYSIWYG to BlackTrax
1. In BTWYSIWYG CAD mode, from the BLACKTRAX menu, choose BTX Apply.
Results:
1. The conﬁguration of the ﬁxture(s) that was added in BTWYSIWYG is applied to
BlackTrax.
2. In BlackTrax, the Incoming BTX Update icon in the Status Bar turns to blue.
2. In the Status Bar of BlackTrax, click on the Incoming BTX Update icon and Apply Changes.
Note: You can also apply this via the keyboard shortcut CTRL+W or from the File menu.
Result: The conﬁguration of the new ﬁxture(s) is applied to BlackTrax and the Messages
dialog appears conﬁrming the update. If applicable, the Messages dialog will display the
ﬁxture model and error codes for usupported ﬁxtures.

Error Codes for Unsupported Fixtures:
NPS

No Pan Stepping

NTS

No Tilt Stepping

PTOI

Pan Tilt Oﬀset Incorrect

ZOI

Zoom Oﬀset Incorrect

NZS

No Zoom Stepping

IROI

Iris Oﬀset Incorrect

NIRS

No Iris Stepping

INOI

Intensity Oﬀset Incorrect

NINS

No Intensity Stepping

NRCS

No Red Channel Stepping

NGCS

No Green Channel Stepping

NBCS

No Blue Channel Stepping

RGBOI

RGB Oﬀset Incorrect
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CWOI

Color Wheel Oﬀset Incorrect

NCWOI

Non Color Wheel Oﬀset Incorrect

GWOI

Gobo Wheel Oﬀset Incorrectq

AWOI

Animation Wheel Oﬀset Incorrect

PWOI

Prism Wheel Oﬀset Incorrect
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Table of contents:
Beacon Patch
Beacons
Messages
System Log
Project Properties
System Conﬁguration
Editing section
Fixture Calibration section
Frame Calibration section
BTWYG section
Noise Filter section
Beacons section
Output Conﬁguration
Active Outputs
Edit Output
Sending Trackables
Output Options
Output Conﬁguration Settings for Third Parties
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The Beacon Patch widget is where information on the BTBeacon, Mini Beacon, Rigid and Soft Frames are
displayed and the assignment of BTBeacons, Mini Beacons, Rigid and Soft Frames to Trackables is
controlled. For the position of a Trackable to be known, a BTBeacon or Mini Beacon or Rigid Frame or Soft
Frame must ﬁrst be assigned to the Trackable. The assignment will link the location of the BTBeacon/Mini
Beacon/Rigid Frame/Soft Frame with that of the Trackable.
The X, Y, Z position of a Trackable is based on the position of the assigned BTBeacon or Frame's centroid
in the Space. The Trackable’s orientation is based on the IMU within the BTBeacon or the calculated
orientation of a rigid frame. BlackTrax interprets the data based on the conﬁguration of the Trackable as
set in the Trackables page. BTBeacons broadcast data at all time when the BTBeacon is on, even if it is
not assigned.
The Mini Beacon has a single built-in LED, no radio and no internal inertial measurement unit (IMU). The
Mini beacon icon will display only the Mini Beacon number and the centroid positional coordinate.
Beacon Patch
Assigning BTBeacons To A Trackable
For the BTSystem to know the location and orientation information of a Trackable, a BTBeacon, Mini
Beacon, Rigid Frame or Soft Frame has to ﬁrst be assigned to a Trackable. This will associate the data of
the BTBeacon with the Trackable.
To assign a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame to a Trackable
1. Drag and drop the Beacon Icon of the BTBeacon/Mini Beacon/Rigid Frame/Soft Frame from its
location onto the Trackable Container of the Trackable.
2. Click Apply Changes. 
Result: The BTBeacon or Mini Beacon or Rigid Frame or Soft Frame will be assigned to the
Trackable.
Note: Assigning a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame to a Trackable that
already has a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame assigned will cause the
BTBeacon or Mini Beacon or Rigid Frame or Soft Frame that was previously assigned to be
unassigned.
To un-assign a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame from a Trackable
1. Drag and drop the Beacon Icon of the assigned BTBeacon/Mini Beacon/Rigid Frame/Soft Frame into
the Available Beacons section.
2. For the changes to take eﬀect, click Apply Changes.
Diﬀerent types of Beacons
There are three diﬀerent types of beacons, which can be catorgized by their heading colour:
Blue: Regular or 'Classic' Beacon - this is a phsyical BTBeacon connected to stringers
Burgundy: Mini Beacon - this is a physical Mini Beacon connected to stringers
Orange: A rigid frame - a 'virtual' BTBeacon that is constructed using at least three LEDs from any
number of BTBeacons
Pink: A soft frame - a 'virtual' BTBeacon that is constructed using at least one LED from any
number of BTBeacons
Beacon Patch Filtering
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The Available Beacons section can be set to show only the selected types of beacons. By default, the
section opens with all types of Beacons selected.
To select the Beacon type that will appear in this section
1. On the top right corner of the Available Beacons section, click on the Beacons drop down menu.
2. Click on the boxes of either the Classic Beacon, or the Rigid Frame, or the Soft Frame or Mini
Beacons that you want to show in the section.
Result: Only the selected Beacon types will appear in the Available Beacons section.
BT Beacon Data
When BTBeacons are in the Space, their location and orientation is known by the BTSystem. This
information is displayed in the Beacon Icon for easy reference. BTBeacon data can be separated into
three categories: General, Centroid and LED.
Note: If any BTBeacon information is unavailable, it will appear as “?”. This could be because the
BTBeacon LEDs are not visible by the BTSystem, or the LEDs are unplugged.
Beacon Number - This is the identifying number of BTBeacon. It is used to tell BTBeacons apart
and is assigned to the BTBeacon automatically.
Battery Icon - This icon represents the percentage of power remaining in the BTBeacon. The timer
next to the icon gives an estimate of how long the BTBeacon can operate using the current LED
conﬁguration.
Centroid BTBeacon Data
Centroid BTBeacon data is primarily information based on the average Cartesian coordinates position all
visible LEDs connecting to the BTBeacon. Additional information about the BTBeacon is also displayed.
X - This is the current X coordinate of the BTBeacon. This position is based on the average X
coordinate position of all visible LEDs connected to the BTBeacon.
Y - This is the current Y coordinate of the BTBeacon. This position is based on the average Y
coordinate position of all visible LEDs connected to the BTBeacon.
Z - This is the current Z coordinate of the BTBeacon. This position is based on the average Z
coordinate position of all visible LEDs connected to the BTBeacon.
R - This is the current roll (rotation of X axis) value of the BTBeacon. This is based on the IMU inside
the BTBeacon or the solution based on the rigid frame.
P - This is the current pitch (rotation of Y axis) value of the BTBeacon. This is based on the IMU
inside the BTBeacon or the solution based on the rigid frame.
Y - This is the current yaw (rotation of Z axis) value of the BTBeacon. This is based on the IMU
inside the BTBeacon or the solution based on the rigid frame.
Button A - This indicates the current status of the A button on the BTBeacon. The button can be
set to either ON or OFF. This button is used in ﬁxture calibration.
Button B - This indicates the current status of the B button on the BTBeacon. The button can be
set to either ON or OFF. This button is used in ﬁxture calibration.
LED BTBeacon Data
LED BTBeacon data is information on the individual Cartesian coordinate position of every LED connected
to the BTBeacon.
LED 1 - The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 1.
LED 1 Data - This is the current Cartesian coordinates of the LED in the BTBeacon’s port 1.
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LED 2 - The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 2.
LED 2 Data - This is the current Cartesian coordinates of the LED in the BTBeacon’s port 2.
LED 3 - The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 3.
LED 3 Data - This is the current Cartesian coordinates of the LED in the BTBeacon’s port 3.
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The Beacons widget gives the user an overview and control of the Beacons in the BTSystem.
Beacons, Mini Beacons, Rigid Frames and Soft Frames seen by the BTSystem.
Battery percentage per Beacon (Mini Beacon does not show Battery Percentage).
Status if the Beacon, Mini Beacon, Rigid Frame or Soft Frame is visible or not.
LED indexes with the corresponding bit codes (binary values) for every Beacon.
You can lock or unlock the Beacon list from the Lock checkbox.
You can add and remove classic Beacons from the new add and remove buttons.

Beacons widget

Beacons Widget Filtering
In the Beacons widget, you can click on either the Beacons tab or the Mini tab or the Rigid tab or the Soft
tab to select the Beacon type that you want to show in this widget.
Detailed Beacon Patch: Click this button to open the Beacon Patch widget.
Beacons tab: Click on the Beacons tab to show Regular or Classic Beacons, which are the physical
BTBeacons connected to the stringer.
Mini tab: Click on the Mini tab to show Mini Beacons, which are the physical Mini Beacons with an
LED imbedded on top of the device.
Rigid tab: Click on the Rigid tab to show only the Rigid Frame 'virtual' BTBeacons.
Soft tab: Click on the Soft tab to show only the Soft Frame 'virtual' BTBeacons.
Lock: Mark this checkbox to lock the Beacons list and disable the Beacon ID box, adding and
deleting Beacons in the table.(Available only in the Beacons tab.)
Notes:
1. When the list is locked, Beacons will not update automatically from radio data.
2. By default, the list is locked when a new project is loaded and when Apply Changes is
pressed.
Beacon ID: Assign a unique name for the Beacon. (Available only in the Beacons and Mini tabs.)
Add button: Adds a Beacon to the list in the table. (Available only in the Beacons and Mini tabs.)
Notes:
1. All Beacons follow a preset rule. (Beacon 1 = LED 1, 2, 3; Beacon 2 = LED 4, 5, 6, etc.)
2. When adding Beacons, you can enter either a single Beacon ID or range (e.g. 10-45)
Delete button: Deletes a Beacon to the list in the table. (Available only in the Beacons and Mini
tabs.)

Speciﬁc BTBeacons, Mini Beacons, Rigid Frames or Soft Frames can be assigned to Trackables for speciﬁc
chapters. These settings will override any assignment made on the Beacon Patch page.
To assign a BTBeacon, Mini Beacon, Rigid Frame or Soft Frame to a Trackable for a speciﬁc
chapter
1. In the Chapters tab, select the chapter the Trackable is in.
2. Select a Trackable
3. Go to the Beacons widget. Drag and drop icons the desired BTBeacon, Mini Beacon, Rigid Frame or
Soft Frame from the list onto the currently assigned Beacon of the desired Trackable.
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4. The chosen BTBeacon, Mini Beacon, Rigid Frame or Soft Frame will be assigned to the Trackable for
the speciﬁc chapter. A book icon will appear next to the Assignment setting in the Trackables
section.
Note: To revert back to the globally assigned BTBeacon, click the Book icon.
5. For the changes to take eﬀect, click Apply Changes.
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This widget contains a history of error warnings, and/or status updates about the state of the system.
By default, the widget will auto hide from view after 5 seconds of being displayed, and the auto hide can
be toggled on or oﬀ by the user from the widget.
The Messages widget will appear whenever there is a change to the state of the system, or an error has
occurred. As an alternative, you can manually open the widget by selecting the speech bubble in the
Status Bar.
The Messages widget can be set to appear only when a warning or error message has been generated. In
this mode, the color of the Messages Icon on the Status Bar turns blue when information is added to the
Messages widget.

Messages widget

To disable Auto Hide
1. In the Messages widget, uncheck the box beside Auto Hide.
2. Click OK.
Note: Clicking the OK button will hide the Messages widget manually.
To enable Only Appears For Errors and Warnings
1. In the Messages widget, check the box beside Only Appears For Errors and Warnings.
2. Click OK.
To clear all information
1. In the Messages widget, click Clear.
Result: The Messages widget will be cleared of all the information listed.
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The system log is used to display system information about the BlackTrax project. The various features of
the system log are as follows:
Enable Logging: Will enable events to be logged in the system log when enable.
Log Data: If logging is enabled, will record all data transmitted when enabled. Used primarily for
debugging purposes.
To ﬁle: Will save the system log to C:\bt_run_time when enabled.
Auto scroll: Will automatically scroll to the latest event when it is created in the log when enabled.
Note: If logging data To File is enabled, it is possible to accumulate Gigabytes of data in a single day of
use. It is recommend that the log ﬁle be removed periodically to conserve BTSystem memory.

To set the system log as a separate window
Double-click the System Log heading.
Result: The System Log window will now display as a seperate window.
To reattached the system log window to BlackTrax
In the System Log window, in the top right of the window, click Attach.
Result: The System Log window will now reattach to the main widget.
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The Project Properties widget is where descriptive data and properties of the BlackTrax project are
created, displayed and managed. You can change the properties that were set in this widget.

Project Properties widget

The Project Properties widget displays the following:
Show Name: Type the name of the current project in this box.
Show Author: Type the name of the author of the current project in this box.
DMX Control: In the Source drop-down, select the source of the DMX input for the Universe and
the Chapter Control Channel. In the Source drop-down, select from either Art-Net or sACN.
Chapter: Set the Chapter Control Channel number and the Universe for the assigned control
channel of the active Chapter.
Universe: Click on this scroll box to set the Universe for the assigned control channel of the
active Chapter.
Chapter Control Channel: Click on this scroll box to set the channel number for the control of
the active Chapter.
Note: Book Control Channel scroll box is displayed in this section when the project is in Book
Mode.
Merging Channel: Mark the Enable Monitoring checkbox to set the channel number that will only
monitor the Merging Channel that was set in the merge node.
Universe: Click on this scroll box to set the Universe for the assigned control channel of the
Merging Channel monitor.
Channel: Click on this scroll box to set the control channel for the Merging channel monitor.
Note: The Merging Channel is a single DMX channel that is patched into your lighting console
to enable the control of moving ﬁxtures from BlackTrax. This can be a dimmer channel that
controls intensity fading between BlackTrax and the lighting console, or a simple On/Oﬀ
control. This channel must be patched in your console and set as the trigger channel in your
merge node. See DMX/Ethernet Node for Tracking with Moving Lights.
Enable per chapter beacon assignment: Enables the setting of beacons in single chapters.
Display Units: BlackTrax allows for either metric or imperial measurement to be used. This setting
can be changed in the Display Units section. The default unit settings of BlackTrax is metric.
Loading a project will revert BlackTrax to the default unit of measurement. Click on the Display
Units drop-down to select the measurement unit.
To set the DMX Control Source
Go to the Project Properties widget, in DMX Input section, select from the Source drop-down list.
Result: The selected source will set the DMX input for the Chapter Control Channel of the BlackTrax
project.
To set the Universe and Chapter control Channel
1. Go to the Project Properties widget.
2. In the Chapter section, click on the Universe scroll box.
3. Click on Chapter Control Channel scroll box.
To enable the Merging Channel monitoring
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1.
2.
3.
4.

Go to the Project Properties widget.
In the Merging Channel section, click on the Enable Monitoring checkbox to toggle.
Click on the Universe scroll box.
Click on the Channel scroll box.

To set the units of measurement
1. Go to the Project Properties widget.
2. In the Display Units section, click the drop-down to select Metric or Imperial.
3. From the list click to select the desired measurement type.
Result: The chosen unit of measurement will apply to the BlackTrax project.
Attention: Inputs will always be in metric.
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The System Conﬁguration widget is where BlackTrax software behavior can be conﬁgured.

System Conﬁguration Widget

The System Conﬁguration widget displays the following buttons to access the sections:
Editing: System prompts can be toggled On or Oﬀ. See Editing section page.
Fixture Calibration: Settings that aﬀect the collection of measurement points of the ﬁxtures can be
toggled On or Oﬀ. See Fixture Calibration section page.
Frame Calibration: Click on the Updating oﬀsets interval (seconds) scroll box to set the time
interval for the Centroid and Orientation Oﬀset values to be applied to the selected Rigid Frame.
See Frame Calibration section page.
BTWYG: Settings that enable incoming and outgoing links to BTWYSIWYG can be toggled On or Oﬀ.
See BTWYG section page.
Noise Filter: Determines if the point is valid or not by using a probability algorithm to determine
how likely a point would be. For example, if Beacon 1, LED 2 is seen in the same spot for 100
frames, but it then appears for one frame 10m away (typically caused by IR noise), then the ﬁlter
tosses that single frame away and continues to track the real LED. See Noise Filter section page.
Beacons: Settings that aﬀect the display of Beacon battery life. See Beacons section page.
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The Editing section in the System Conﬁguration widget is where system prompts can be toggled On or
Oﬀ.
Editing section
Editing: Toggle system prompts.
Enable conﬁrmation prompts for System Changes: Mark this checkbox to display a dialog
asking for conﬁrmation to apply the changes you have made in BlackTrax after clicking Apply
Changes in Normal Mode and Fixture Calibration Mode.
Track even with warnings: Mark this checkbox to enable tracking to be aplied even when
Warning messages and dialog are displayed in Normal Mode and Fixture Calibration Mode.
Open most recent project when BlackTrax starts: Mark this checkbox to open BlackTrax with
the last project ﬁle that was opened, or unmark this checkbox to open BlackTrax with a new
project ﬁle.
To toggle the Editing behaviors
1. From the Settings menu, choose System Conﬁguration. By default, the System
Conﬁguration widget opens to display the Editing options.
2. In the Editing section, click to toggle the checkboxes for:
Enable conﬁrmation prompts for System Changes
Track even with warnings
Open most recent project when BlackTrax starts
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The Fixture Calibration section of the System Conﬁguration widget is where the settings that aﬀect the
collection of measurement points of the ﬁxtures can be toggled On or Oﬀ.

Fixture Calibration section

Fixture Calibration: Click this button to toggle measurement points of the ﬁxtures.
Use time limit: Mark this checkbox to enable the adjustment of the time interval required to
perform and complete the calculation of measurement points for each ﬁxture. Click on
the Time Limit (seconds): scroll box to set the new time limit in seconds.
Time limit (seconds): Click this scroll box to set the new time limit to complete the calculation
of measurement points in Fixture Calibration.
Check if motion from beacon is gone: Mark this checkbox to disable the collection of
measurement points when the signal from a beacon is not seen and a warning is displayed.
Unmark this checkbox to enable the collection of measurement points and the warning will
not be displayed.
Enable Automatic Calibration: Mark this checkbox to enable the automatic collection of the
measurement points after the 5th measurement point and every point thereafter.
Clear Fixture Properties: Mark the checkboxes for Clear Colour, Clear Gobo and Clear
Prism to remove the colour, gobo and prism attributes from the ﬁxtures selected in
BlackTrax.
The ﬁxture goes to white when Clear Colour is marked.
The gobo is removed from the ﬁxture when Clear Gobo is marked.
The prism is removed from the ﬁxture when Clear Prism is marked.
Uncheck All/Check All: Click on Uncheck All or Check All buttons to include or exclude the
colour, gobo and prism from the selected ﬁxture in BlackTrax.
To toggle Fixture Calibration settings
1. From the Settings menu, choose System Conﬁguration.
2. In the System Conﬁguration widget, click Fixture Calibration.
3. In the Fixture Calibration section, mark the checkboxes/scroll box for:
Use time limit
Time limit (seconds)
Check if motion from beacon is gone
Enable Automatic Calibration
Clear Fixture Properties section:
Clear Colour
Clear Gobo
Clear Prism
Click on the Uncheck All or Check All button to toggle the Clear Fixture Properties section
checkboxes.
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The Frame Calibration section in the System Conﬁguration widget is where you can set the time interval
for the Centroid and Orientation Oﬀset values of the selected Rigid Frame.

Frame Calibration section

Frame Calibration: Click on the Updating oﬀsets interval (seconds): scroll box to set the time
interval for the Centroid and Orientation Oﬀset values to be applied to the selected Rigid Frame.
To set the interval time for oﬀsets update
1. From the Settings menu, choose System Conﬁguration.
2. In the System Conﬁguration widget, click Frame Calibration.
3. In the Frame Calibration section, click and scroll to set the time value in Updating oﬀsets interval
(seconds): scroll box.
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The BTWYG section in the System Conﬁguration widget is where the settings that enable the incoming
and outgoing links to BTWYSIWYG can be toggled On or Oﬀ.

BTWYG section

BTWYG: Toggle incoming and outgoing links to BTWYSIWYG.
Allow outgoing selection to WYSIWYG: Mark this checkbox to enable the selection of ﬁxtures
in WYSIWYG from BlackTrax.
Allow incoming selection from WYSIWYG: Mark this checkbox to enable the selection of
ﬁxtures and trackables in BlackTrax from WYSIWYG.
To toggle BTWYG settings
1. From the Settingsmenu, choose System Conﬁguration.
2. In the System Conﬁguration widget, click BTWYG.
3. In the BTWYG section, click to toggle the checkboxes for:
Allow outgoing selection to WYSIWYG
Allow incoming selection from WYSIWYG

BlackTrax User Wiki

198

August 2017

BlackTrax GUI
The Noise Filter section in the System Conﬁguration widget is where noise ﬁlter settings are activated
and conﬁgured.

Noise Filter section

Noise Filter: Determines if the point is valid or not by using a probability algorithm to determine
how likely a point would be. For example, if Beacon 1, LED 2 is seen in the same spot for 100
frames, but it then appears for one frame 10m away (typically caused by IR noise), then the ﬁlter
tosses that single frame away and continues to track the real LED. As the system does not have a
concept of 'real' and 'fake', the system uses a history to determine the 'real' LED. This means that
in rare cases, noise may pass through the outlier ﬁlter if the noise is consistent, such as a
reﬂection. There are other tricks to mask out reﬂections and to trim out extra parts of the tracking
area. Please see Motive reconstruction bound settings for more information.
Enable: Mark this checkbox to activate the noise ﬁlter.
Minimum Covariance:Click this scrollbox to set how 'wide' or 'narrow' the range of noise
suppression. Minimum Covariance aﬀects a higher tolerance of points in a given spectrum.
Maximum Z-Sqr Score:Click this scrollbox to set how 'wide' or 'narrow' the range of noise
suppression. Maximum Z-Sqr Score aﬀects a wider tolerance of points in a given spectrum.
Maximum Iterations: Click this scrollbox to set the maximum number of repetitions per frame
the same data point is analyzed to determine the noise level. There is no range to this ﬁeld,
but the default is 150.
Tip: The easiest way to adjust the outlier ﬁlter is to increase or decrease the Min Covariance and
hitting Apply Changes. There is a large range that you may use, so it is best to step the ﬁeld by
either +0.1 or -0.1 each time to see if the noise becomes better or worse.
To enable and conﬁgure noise ﬁlter settings
1.
2.
3.
4.

From the Settings menu, choose System Conﬁguration.
In the System Conﬁguration widget, click Noise Filter.
In the Noise Filter section, mark the Enable checkbox to activate Noise Filter.
Click on the scrollboxes to set:
Minimum Covariance:
Maximum Z-Sqr Score:
Maximum Iterations:
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The Beacons section in the System Conﬁguration widget is where settings that aﬀect Beacon reporting
and behavior within the system can be conﬁgured.

Beacons section

Beacons: Settings that aﬀect the display of Beacon battery life.
Radio becomes stale after (seconds): Click on this scroll box to set how long after a packet of
battery life data of the beacon is received (without receiving new packets) for the radio
indicator in Live View to turn red. The radio indicator is also visible in Table View via the
Radio column.
Live View:

Icon with Fresh data (Gray)

Icon with Stale data (Red)

Table View:
Radio column with Fresh data (Green)
Radio column with Stale data (Red)
Number of battery packets to average: Click on this scroll box to set the number of times the
battery life information is collected to be averaged.
Display raw battery values in the Beacon Widget: Mark this checkbox to display the raw battery life
percentage (non-averaged) as a separate column in the Beacons Widget.
Update frames' batteries every (minutes): Click on this scroll box to set (in minutes), how the
battery status of the beacons in rigid and soft body frames will update by displaying the lowest
beacon's battery when that timer runs out (and repeats).
Detect battery time based on: Select either 1 Stringer or 2 Stringers or 3 Stringers as the reference
for monitoring the battery life capacity.
To conﬁgure battery settings
1. From the Settings menu, choose System Conﬁguration.
2. In the System Conﬁguration widget, click Beacons.
3. In the Beacons section, choose from the scroll box/drop-down options or mark the checkbox for:
Radio becomes stale after (seconds):
Number of battery packets to average:
Display raw battery values in the Beacon Widget
Update frames' batteries every (minutes):
Detect battery time based on:
1 Stringer
2 Stringers
3 Stringers
Smoothed Centroid Jumps: Mark this checkbox to enable the option of setting the timing of the
centroid updating when shifting from one calculated centroid to a newly calculated centroid. For
example, when a Stringer contributing to a centroid becomes hidden from camera view.
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Smoothing time (milliseconds): Click on this scroll box to set the time (in milliseconds) it takes for
the calculated centroid updating to complete when a Stringer contributing to a centroid becomes
hidden, or is visible again in the camera view. The shift will be smoother (but takes more time to
complete) when the timing is longer.
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The Output Conﬁguration widget displays the active tracking output data from the Output Modules and
Trackable Settings as a result of the tracking operation in BlackTrax.
The Output Conﬁguration widget is used by the BTSystem to create, customize and remove Real
Time Tracking Protocol data for Third Party use (RTTrPL, RTTrPM, and Art-Net).
The Output Conﬁguration widget receives data based on preferences conﬁgured in Output
Conﬁguration. The customized data is then sent to designated Third Party programs.
Note: Output Conﬁguration data can be imported and exported for use of current tracking output and
saved for later use. You can activate Import or Export Outputs from the File menu.

Output Conﬁguration widget

The Output Conﬁguration widget displays the following sections:
Active Outputs: The list data and settings of active modules detected by the BTSystem.
See Active Outputs page.
Edit Output: The section for managing the network connections of the selected active module.
See Edit Output page.
Sending Trackables: The list of every active Trackable detected by the BTSystem and their third
party output status (only applicable to RTTrPM outputs). See Sending Trackables page.
Output Options: The section enables you to select which RTTrPM modules to output of the
selected active module (only applicable to RTTrPM and outputs). See Output Options page.
Note: As a general rule, Apply Changes button must be pressed to apply all changes that are set by the
user in Output Conﬁguration.
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The Active Outputs section shows the list of modules that are detected by the BlackTrax System. The
connection settings and output statuses for every active module can be monitored via the Active Output
table.
Active Outputs section
Label: The unique name of the active module that was speciﬁed by the user of the BTSystem.
Type: The type of data protocol being sent to the selected module.
Output NIC: The IP address where the output is being sent through from the selected active
module.
Communication: The type of connection, such as multicast, unicast or broadcast.
Details: The target IP address where the output data will be sent to.
Status: Connection status of the detected module.
Enable: Determines if the output is externally sending output from the server.
Add: Click this button to add a new active output connection.
Delete: Click this button to delete an active output connection.
Note: Deleting an output marks it for deletion and it will be deleted when the user clicks
Apply Changes next. As a general rule, Apply Changes button must be pressed to apply all
changes that are set by the user in Output Conﬁguration.
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In the Edit Output section, you can set or change the network data of the output connection module that
is added to the Active Outputs section. You can conﬁgure RTTrPM outputs' parameters.
Network tab

Network tab

Label: Type the unique name of the active connection module that is added to the Active Output
section.
Type: Click on the drop-down to select the type of data protocol being sent to the selected active
module.
NIC: Click on the drop-down to select the local IP address where the output data is being sent
through for the selected active module.
Communication: Click on the drop-down to select the type of IP address in the connection, such as
multicast, unicast or broadcast. The default output address corresponding to multicast and
broadcast will be entered automatically according to the selected type.
Notes:
The default multicast output address for the selected output is entered automatically if
Multicast is selected.
The broadcast output address will be based oﬀ the selected NIC for the output and
entered automatically if Broadcast is selected.
The user must enter the unicast address if Unicast is selected.
Address and Port ﬁelds are editable per output, where applicable if user settings are
speciﬁed instead of the defaults.
Address: The target IP address where the output data will be sent to.
Apply: Click to apply the settings.
Note: As a general rule, Apply Changes button must be pressed to apply all changes that are set by the
user in Output Conﬁguration.
Advanced tab

Advanced tab

Coordinate System: Choose which type of coordinate system to use with positional data. Click on
this drop-down to choose between the Stage (WYSIWYG) or Screen coordinate systems.
Stage (WYSIWYG): In the Stage coordinate system, the Z axis is in the upward direction, and
Y is on the same plane as the X axis. (Used in WYSIWYG)
Screen: In the Screen coordinate system, the Z and Y axes are swapped and are reﬂected in
the RTTrPM packets for X, Y and Z values. (Used in Motive)
Integer: Choose how integer data is sent. Click on this drop-down to change the network order of
integer ﬁelds output in RTTrPM packets from Big Endian (Network Order) to Little Endian (Intel
Order).
Orientation: Click on this drop-down to change the Beacon orientation to Euler or Quaternion
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coordinates.
Apply: Click to apply the settings.
Note: As a general rule, Apply Changes button must be pressed to apply all changes that are set by the
user in Output Conﬁguration.
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The Sending Trackables section is where Trackables are displayed and selected. The Trackable Settings
in the Output Options section are then applied to the selected Trackable.

Sending Trackables section

In the Sending Trackables section:
Beacons/Mini/Rigid/Soft tab: Click on the tab to display the table with the list of trackables.
Enabled: Displays a check mark when enabled.
Beacon: Displays the Beacon ID or name.
Smoothing: Displays the Smoothing value that was set in the Trackable Settings tab.
Tip: You can select/highlight several Beacons at once and click Enable Selected to send to third parties,
or click Disable Selected to stop sending. (By default, no Beacons are sending to third parties.)
Notes:
1. Rigid and Soft bodies display their name instead of Beacon ID.
2. Apply Changes button must be pressed to apply all changes that are set by the user in Output
Conﬁguration.
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Trackable data that is being sent can be altered in the Output Options section.
Attention: The settings aﬀect Output Modules that are sending data from BlackTrax, and applies to
RTTrPM outputs.

Trackable Settings tab: Set tracking smoothing response for a single or multiple trackables. The
Smoothing option is enabled when Acceleration and Velocity in the Output Modules is marked.
Trackable Settings tab
Smoothing: Set how ﬂuid the XYZ values of the Trackable become.
Use the slider and the scroll box to adjust the range of ﬂuidity from Smooth to Responsive, to
set the range between -4 to +2. Both slider and the scroll box correspond to the same
perimeter.
A more smoothed Trackable will result in less jitter going to the third party, and can help
smooth out less than ideal calibrated volumes, but it will introduce a slight delay as well.
To set the smoothing response of a selected trackable
1. In the Output Modules tab, mark the Acceleration and Velocity checkbox and unmark the Output
Raw Position checkbox.
Result: Smoothing is enabled in the Trackable Settings tab.
2. In the Sending Trackables section, select a single or multiple Trackable(s).
3. In the Trackable Settings tab, use the Smooth to Responsive slider or click the scroll box to set the
range of ﬂuidity between -4 to +2.
Result: The smoothing range that was set is displayed in the Smoothing column of the
Sending Trackables section.

Output Modules tab: Select which data to send through the selected output module.

Output Modules tab

Send: Mark the checkboxes to select the output connection data that will be sent through.
LED: Mark this checkbox to send BTBeacon LED data.
Centroid: Mark this checkbox to send BTBeacon Centroid data.
Orientation: Mark this checkbox to send BTBeacon orientation data.
Timestamps: When enabled, the Frame ID generated by the TimeKeeper is used as a time
stamp.
Acceleration and Velocity: Mark this checkbox to send centroid and/or LED position
acceleration and velocity data.
Note: The Smoothing option in the Trackable Settings tab is enabled when Acceleration
and Velocity checkbox is marked.
Output Raw Position: Mark this checkbox to turn oﬀ the ﬁlter that is used for the acceleration
and velocity data that was sent.
Notes:
Acceleration and velocity data is not 100% accurate due to inaccuracies that can
and IR
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interference. This creates imperfect data or noise. Filtering the data is a way to
correct any noise that enters the data.
Enabling Output Raw Position, or disabling Acceleration and Velocity will deactivate the smoothing slider from the Trackable Settings tab.
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Known Output Conﬁguration settings for third parties:

d3
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Checked
Centroid: Unchecked
Orientation: Unchecked
Timestamp: Checked
Acceleration and Velocity: Checked

Green Hippo
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Checked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Checked

MRMC Flair
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Checked
Centroid: Unchecked
Orientation: Unchecked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked
BlackTrax User Wiki

209

August 2017

BlackTrax GUI

Touch Designer
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Unchecked

Rushworks CTRL+R
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked
Please Note: Rushworks CTRL+R will only work with the default RTTrPM Multicast network settings.
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Table of Contents:
Running Chapters Widget
Running Books Widget
Modules Widget
Trackable Details Widget

Live View showing all Trackables in the BlackTrax Project
Live Trackables
In the center area of the Live View is where you will ﬁnd live trackable information, showing the the
current BTBeacon patch data and their Trackables. There are a few diﬀerent options of viewing this data.
Icon View
This view displays Trackable Data in the same way it is represented in the Beacon Patch Docking Widget.
Displayed are:
Trackable container with Trackable Name
Any assigned beacons with their relevant information
An indicator beside the beacon number to indicate if the beacon is currently visible(Blue) or not
(Grey)

Live Trackables with Icon View

Table View
This view displays live trackable information with live LED status monitoring in the following columns:
Trackable with name
Assigned Beacon
Battery Status
Radio Status: Fresh data (Blue), Stale data (Red)
Visibility of the trackable: Visible (Blue), Not-visible (Grey)
Status of the individual LED associated with the trackable: Active (Blue), Inactive (Grey)

Live Trackables with Table View

Small View
This view displays Trackable Data that is represented as small icons with the Trackable Name, beacon
number with the relevant information and the indicator. Click on the box beside Small View to select this
display option. Displayed are:
Small Trackable container icon with Trackable Name
Any assigned beacons with their relevant information
An indicator beside the beacon number to indicate if the beacon is currently visible (Blue) or not
(Grey)
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In addition to the views mentioned above, there are further sorting options available to show the relevant
data as the user prefers. They are:
Show Per Chapter
This option will show only trackables currently assigned to the currently running chapter.

Per Chapter Live Trackables using the Icon View

Show By Group
This option will show any trackables that have been assigned to a group through the Trackables docking
widget. When showing by group, an additional drop down menu appears to allow the selection of groups.
For information on Trackable group creation, refer to Grouping Trackables in the Libraries widget section
of this manual.

Displaying Trackables in a selected group

Tab Views
There are also two options for displaying trackable information, while using the Icon View.
 entroid Tab will display battery information, as well as the XYZ Calculated centroid of a trackable,
C
as well as Roll, Pitch, Yaw and BTBeacon information.
LED Tab will display battery information, as well as the XYZ information of individual LED Stringers
connected to the beacon.
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Overview
The Running Chapters widget contains the list of recalled Chapters, which can be selected to become
active. The Running Chapters widget displays:
Names and descriptions assigned to the recalled Chapters.
Tracking status of the recalled Chapters.
Fixture calibration preset that was applied to the recalled Chapter.
When Tracking is active, assigned ﬁxtures will follow the Trackables assigned to the selected active
Chapter. Selecting which Chapter to activate can be controlled by using manual control in BlackTrax, or
using DMX via Art-Net or sACN from a connected lighting console.

Running Chapters Widget

Manual Chapter control
Manual control enables control of chapters from within the BlackTrax GUI.
To enable manual control of Chapters
In the center widget of Live View where the Icons are displayed, click on the drop-down menu at the
bottom left-hand corner. From the menu, select Manual.
To select a Chapter to be active using manual control
In the Running Chapters widget, from the list of saved Chapters, click on the Chapter.
Result: The selected Chapter will have an Active icon in the Active ﬁeld to show it is currently active.
Fixtures assigned to the selected Chapter will follow the assigned Trackables in the Space.
DMX Chapter control
With DMX control enabled, the selection of which chapter is active can be controlled from a lighting
console.
To enable DMX control of Chapters
1. In the center widget of Live View where the Icons are displayed, click on the drop-down menu at
the bottom left-hand corner.
2. From the menu, select DMX Input.
Result: The connected lighting console has control over the selected Chapter. The Universe
and Address used to control the Chapters from the lighting console are displayed in the
bottom left-hand corner of the center widget and in the Status Bar. The Chapter Control DMX
value is also displayed at the bottom left-hand corner of the Running Chapters widget.
To toggle auto scrolling to an active chapter
With DMX Input enabled, the Auto Scroll feature becomes available for use. Auto Scroll will make the
chapter list always display the active chapter when enabled.
To toggle auto scrolling, in the Chapter Control section, click Auto Scroll.
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Overview
The Running Books widget contains the list of created Books that can be recalled to become active.
When a Book is recalled, the list of Chapters in the Book are displayed in the Running Chapters widget.
Selecting which Book to recall can be controlled by using manual control in BlackTrax, or using DMX via
Art-Net or sACN from a connected lighting console.

Running Books Widget

Functionality
Manual Book control
Manual control enables the control of Books from within the BlackTrax GUI.
To enable manual control of Books
In the center widget of Live View where the Icons are displayed, click on the drop-down menu at the
bottom left-hand corner. From the menu, select Manual.
To select a Book to be active using manual control
In the Running Books widget, from the list of created Books, click the Book.
Result: The selected Book will have an Active icon in the Active ﬁeld to show it is currently active. The
list of Chapters in the selected Book will be displayed in the Running Chapters widget.
DMX Chapter control
With DMX control enabled, selecting which Book to recall can be controlled from a lighting console.
To enable DMX control of Books
1. In the center widget of Live View where the Icons are displayed, click on the drop-down menu at
the bottom left-hand corner.
2. From the menu, select DMX Input.
Result: The connected lighting console has control over the selected Book and all the
Chapters in the Book. The Universe and Address used to control the recalled Book and
Chapters from the lighting console are displayed in the bottom left-hand corner of the center
widget and in the Status Bar. The Book Control DMX value is also displayed at the bottom
left-hand corner of the Running Books widget.
To toggle auto scrolling in the active chapter
With DMX Input enabled, the Auto Scroll feature becomes available for use. Auto Scroll will make the
Books list always display the active Book when enabled.
To toggle auto scrolling, in the Running Books widget, click Auto Scroll.
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The BlackTrax Engine Modules section is where the diﬀerent parts of the BTSystem are connected
together. The status of all connected modules is shown so you can easily troubleshoot if any part is not
connected.

BlackTrax Modules Widget, showing Modules connected and running

Purpose of BlackTrax modules
Each module has a speciﬁc role that comes together to create the BTSystem. The following is a brief
explanation of the various modules:
Tracker: Determines position of Trackables. Loads automatically with the BTServer.
Follower: Sends position data out to ﬁxtures. Loads automatically with the BTServer.
BTWYG: BTWYSIWYG visualizes live Trackable activity in the Space.
Monitor: Displays communication and command settings of Tracking Adapters.
Note: When a module ﬁrst launches, it will auto send a discover command and attempt to connect to the
rest of the modules.
To connect modules to BlackTrax
In the Modules Status widget, click Discover.
Result: The Modules Status widget will be populated with all linked modules. Modules that are
connected display a Connected icon. Modules that are not connected display a Not Connected icon.
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Trackable Details Widget

Overview
This widget is used to monitor the details of beacons assigned to any Trackables in the currently selected
Chapter that have a Rigid or Soft frame assigned to them. Selecting a Trackable with a Rigid or Soft
frame assigned to it in the central widget of the Live View will display all the beacons which the Rigid or
Soft frame is assigned. The widget lists the name of all the beacons assigned to the frame, as well as the
battery status, and a visibility icon (Blue for visible, red for not visible, grey for inactive).
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Standardized BlackTrax keyboard shortcuts are deﬁned below:
Description

Keyboard shortcuts

New Project

Ctrl+N

Open Project

Ctrl+O

Save

Ctrl+S

Apply Changes

Ctrl+Enter

Apply BTWYG Updates

Ctrl+W

Copy

Ctrl+C

Paste

Ctrl+V

Select All

Ctrl+A

Undo

Ctrl+Z

Redo

Ctrl+Y

Live View

Ctrl+1

Edit View

Ctrl+2

Fixture View

Ctrl+3

Close All Widgets

Ctrl+'

Beacon Patch

Ctrl+B

Beacons

Ctrl+Shift+B

Messages

Ctrl+M

Fullscreen Toggle

F11

About BlackTrax

F1

Close

Alt+F4

Record Tracking and Lighting Data

Ctrl+R
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This feature enables BlackTrax to automatically record tracking and lighting data in the form of packets
while receiving incoming tracking data from Motive. This data will save in the C:\bt_run_time folder as a
.rec ﬁle. The recording can be played back in the Cue application.
To start/stop Record Tracking and Lighting Data
1. On you keyboard, click the shortcut Ctrl+R once to start recording.
Result: Tracking and Lighting Data starts recording automatically and the status bar displays
the record icon.
Record icon
2. Click the shortcut Ctrl+R again to stop the recording.
Note: Three ﬁles are saved in C:\bt_run_time.
1. Motion data: Tracker-N
2. Radio data: Tracker-R
3. RTTrPL packets: Follower-L
Sample ﬁles saved in C:\bt_run_time
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Table of contents:
1 BTEngine & Background Modules :
1.1 BTEngine :
1.1.1 Tracker Module :
1.1.1.1 Tracker Introduction :
1.1.1.2 Layout of the Tracker Module :
1.1.1.3 Summary Tab :
1.1.1.4 Managing Tracker Connections :
1.1.1.5 BTBeacons in Tracker :
1.1.1.6 Tracker Data Log :
1.1.1.7 Outlier Filter :
1.1.2 Follower Module :
1.1.2.1 Follower Introduction :
1.1.2.2 Layout of the Follower Module :
1.1.2.3 Follower Summary Tab :
1.1.2.4 Follower Connections :
1.1.2.5 Follower Data Log :
1.1.3 Monitor Module :
1.1.4 Tracking Adapter Module :
1.1.4.1 Tracking Adapter Introduction :
1.1.4.2 Layout of the Tracking Adapter Module :
1.1.4.3 Tracking Adapter Connections :
1.1.4.4 Trackables in Tracking Adapter :
1.1.4.5 Tracking Adapter Data Log :
1.1.4.6 Stream Parameters :
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The BTEngine menu activates the Tracker, Follower and Monitor modules automatically with settings
that are fully integrated within the Output Conﬁguration window, and monitored in the Monitor window.
To activate the background modules
1. From the Module menu, click on BTEngine.
Result: The Tracker, Follower and Monitor modules are activated with features operating
behind the scenes and the corresponding icons appear in the status bar. See Output
Conﬁguration for details.
Tracker icon

Follower icon

Monitor icon

To close the background modules
1. On the status bar or task tray, right click on the icon of the selected module.
2. Click on Exit to close the selected module.
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.
Table of contents:
Tracker Module
Tracker Introduction
Layout of the Tracker Module
Summary Tab
Managing Tracker Connections
BTBeacons in Tracker
Tracker Data Log
Outlier Filter
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Tracker module is a background process used by the BTSystem. Tracker takes the positional data of
a BTBeacon from the Motive module, the corresponding BTBeacon identiﬁcation data from the BTRouter,
and combines this data together. This data is known as Real Time Tracking Protocol (RTTrP). There are
three diﬀerent sub-types of RTTrP: motion (RTTrPM), and lighting (RTTrPL).
The RTTrP data is then sent downstream for use by other modules. The Follower module can use the new
data for tracking with lighting ﬁxtures. The Tracking Adapter module can further customize the data to
suit your needs and then send it to Third Party programs, such as media projectors, 3D audio devices, or
robotic ﬁxtures.
Note: All the network addresses listed in Tracker are domains linked to internal IP addresses in the
BTServer. By disabling and enabling one of the inputs/outputs, the log will display the IP address as well
as the multicast address of the input/output.
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Tracker module presents both a 'Basic' and an 'Advanced' mode layout. The simplifed 'Basic' mode
shows exclusively the Tracker module summary as well as an active Beacon list. In this mode all network
conﬁguartion settings are hidden.

In Advanced mode, four other tabs are displayed:

Input: Shows Tracker's input data sources. See Managing Tracker Connections.
Processing: Shows Tracker's internal options and output to other interal modules. See Managing
Tracker Connections.
RTTrPM: Shows Tracker's output data sources. See Managing Tracker Connections.
Log: Logs data processed by Tracker. See Tracker Data Log.
As well as:
Summary: A summary view of data ﬂowing through Tracker. See Summary Tab.
Beacons: A list of beacons seen by Tracker. See BTBeacons in Tracker.
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Summary tab shows an overview of the Tracker modules. A checkmark designates a module that is
currently active and either listening to or passing data, while an X shows a module that has been
disabled or disconnected. Packets sent or received from the specﬁc module are displayed next to this
icon.
Found at the top right corner of this tab is the layout mode selection. It can be toggled between Basic
and Advanced.
This tab also presents the option to both save and reset the entire conﬁguration of Tracker. Please note
that reseting the conﬁguration requires restarting Tracker.

Summary Tab, Basic Mode

Summary Tab, Advanced Mode

To Record Tracking Data
Tracker allows you to record tracking data in the form of packets. Simply mark the Record Tracking Data
checkbox while receiving incoming tracking data from Motive. Unmark the checkbox when you are
satisﬁed with your collected data. This data will save in the C:\bt_run_time folder as a .rec ﬁle. The
recording can be played back in the Cue application.
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

Note: You must be in the 'Advanced' mode layout of Tracker in order to change any connection settings.

Input Tab

Processing Tab

To toggle the connection of Tracker to BlackTrax
Note: The Tracker will automatically connect to BlackTrax when both the Tracker and BlackTrax GUI are
opened.
Under the Processing tab in the Tracker Connection section, click Disconnect/Connect.
Result: The connection of the Tracker to BlackTrax will be toggled. The connection status will be
displayed next to Controller link status.
To connect Tracker to other modules
To connect Tracker to 'Internal Output' or 'RTTrPM Output', mark the check box next to that module’s
name. The 'Internal Output' and 'RTTrPM Output' modules can be found under the 'Processing' and
'RTTrPM' tabs, respectively.
Result: If a module is connected to Tracker, the data in the corresponding Sent/Received ﬁeld should
see activity.
To disconnect Tracker from other modules
To disconnect Tracker from a module, unmark the check box next to that module’s name.
Result: If a module is disconnected from Tracker, the data in the corresponding Sent/Received ﬁeld
should be stationary.
To change the connection information of Tracker to a module
Note: If a non multicast IP address is entered into the Command/Listen Multicast Address ﬁeld, the IP
address will bypass multicast and send directly to the speciﬁed IP (unicast). If the IP address ends in
“.255”, data will be sent to all IP addresses in the range (broadcast).
1. Enter in the new information in the appropriate ﬁelds.
2. Disconnect then reconnect the module from Tracker.
Result: The module will be connected to Tracker with the new settings. If the connection was successful,
the corresponding Sent/Received ﬁeld will see activity.
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RTTrPM Tab default

RTTrPM Tab with "For Tracking Adapter" unchecked

RTTrP output as Big Endian or Little Endian
BlackTrax has the ability to output integers and ﬂoat in the Real Time Tracking Protocol as either big
endian or little endian.
Note: By default integer and ﬂoat output is set to little endian.
To output integer data as big endian
1. Under the RTTrPM tab, unmark the For Tracking Adapter checkbox and mark the checkbox next to
Integer Network Order.
2. Unmark the checkbox for Enable RTTrPM Output.
3. Mark the checkbox for Enable RTTrPM Output.
Result: The RTTrPM Output will now output integer data to Third Party programs using big endian.
To output ﬂoat data as big endian
1. Under the RTTrPM tab, unmark the For Tracking Adapter checkbox and mark the checkbox next
to Float Network Order.
2. Unmark the checkbox for Enable RTTrPM Output.
3. Mark the checkbox for Enable RTTrPM Output.
Result: The RTTrPM Output will now output ﬂoat data to Third Party programs using big endian.

Motive coordinate system as output
BlackTrax uses the Cartesian coordinate system to determine the position of Trackables. In all of
BlackTrax, the Z axis represents height and the Y axis represents length and X axis represents width,
except in Motive. In Motive:
The Z axis represents length.
The Y axis represents height.
The positive and negative direction of the X axis is switched. The negative X axis becomes positive
X axis.
To output data to Third Parties using Motive screen position
Attention: It is possible to output positional data to Third Party programs using Motive’s interpretation
of the coordinate system. Please note in this output coordinates are represented the following way:
The Z axis represents length
The Y axis represents height.
The negative Z becomes positive Z.
1. Under the RTTrPM tab, unmark the For Tracking Adapter checkbox and mark the checkbox next to
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Screen Position.
2. Unmark the checkbox for Enable RTTrPM Output.
3. Mark the checkbox for Enable RTTrPM Output.
Result: The Third Party Output will now output positional data to Third Party programs using the
coordinates of Motive.
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Beacons tab of the Tracker is used to manage and display information of all operating BTBeacons.
The identifying number of each BTBeacon is displayed. LEDs attached to the BTBeacon have their
identifying number displayed, as well as the bit code that LED transmits to the system. Tracker is also
told which version of the bit code is being used, so it knows how to process the LED bit codes correctly
from BTBeacons.

Beacon Tab

BTBeacon LED Bit Code
BTBeacon LEDs are identiﬁed by ﬂashing a speciﬁc bit code unique to that LED. The bit of the LED can be
changed in the Beacon List section.
A BTBeacon’s LED number outside the square brackets is the LED Index. The number inside the square
brackets is the LED’s pulsing binary code in decimal form, which is the same number seen in Motive
when an LED is selected.
Note: Each BlackTrax system is designed to operate using one bit conﬁguration at a time.
To change the bit type of LEDs
Under the Processing tab and the LED Bits section, select the desired bit type from the LED Bits drop
down menu.
Note: You must be in the Advanced mode layout to select the Processing tab.
Result: The BTBeacons will use the new bit type to display information. The internal identifying number
of the LED (the number in square brackets []) will change in the Beacon List table to reﬂect the new bit
type.

Beacon List Management
The options under the Beacons tab controls how the Beacon List operates. From here a Beacon List
current BTBeacons and their settings can be saved, loaded or edited as needed. Permissions on how
BTBeacons can join the Beacon List can also be set from here.
Attention: When a large number of BTBeacons are operating at the same time, it might be diﬃcult for
the system to simultaneously detect and add the BTBeacons to the Beacon List at once. If a large
number of BTBeacons are to operate at the same time, it is recommended that you ﬁrst create and save
a Beacon List populated with all the intended BTBeacons. Then when you want to track, simply load the
list for the BTSystem to easily reference the BTBeacons.
BlackTrax User Wiki

228

August 2017

BTEngine & Background Modules
To save a Beacon List
Under the Beacons tab, click Save List.
Result: The current Beacon List will be saved to ﬁle. The ﬁle can be found at C:\bt_run_time\\Tracker.
To load a Beacon List
Under the Beacons tab, click Load List.
Result: If a Beacon List was previously saved, it will load and the Beacon List tabled populated with the
saved BTBeacons.
To clear the Beacon List Table
Under the Beacons tab, click Reset.
Result: The Beacon List table will be cleared of all BTBeacons.
To delete selected BTBeacons from the Beacon List table
1. In the Beacon List table, select the BTBeacons you want to remove from the table.
2. Under the Beacons tab, click Delete.
Result: The selected BTBeacons will be removed from the Beacon List.

Beacon List Permissions
How BTBeacons are added and removed from the Beacon List can be managed from the Permissions
drop-down menu. There are three permission options available:
Lock: The Beacon List will be locked. No new BTBeacons will be added to the Beacon List when
detected by the BTSystem. The system will not remove inactive BTBeacons.
Never Remove: No BTBeacon currently on the Beacon List will be removed from the list, even if the
BTBeacon is detected as not being active.
Auto Update: The BTSystem will automatically populate the Beacon List with BTBeacons as they
are detected operating. The BTSystem will also remove inactive BTBeacons from the Beacon List if
they become inactive after 3 minutes and 50 seconds.
To manage Beacon List permissions
Under the Beacons tab, select the desired permission from the Permissions drop-down menu.
Result: The selected permission will immediately take eﬀect on the Beacon List table.
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

Information on data that passes through the Tracker, as a well as system events, can be displayed in the
Message Log. This information can also be save to a separate ﬁle for review later. Message Log ﬁles can
be found at C:\bt_run_time.
To Log Basic Data
Under the Log tab, mark the Enable checkbox to Record Tracking.
Result: The Message Log will record all system events in Tracker.
To Log Advanced Data
Under the Log tab, mark the checkbox next to Log Data.
Result:The Message Log will record all possible data.
To record the Tracker message log to ﬁle
Under the Log tab, mark the checkbox next to To File.
Result: The Message Log will record to a ﬁle, marked with the current data and time. While this option is
selected, data will not appear in the Tracker Message Log.
To clear the Tracker Message Log
In the Message Log section, click Clear Log.
Result: The Message Log will be cleared of all data. This action is irreversible. If logging the data to ﬁle,
that ﬁle is still available and the data inside will not be cleared.
Additionally, you can select the Detach button to open the message log in a separate window.

Data Log, With Info

Data Log, Clear
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Important Note:
In BlackTrax 2.1, the Tracker module is a background process used by the BlackTrax system with settings
that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Tracker module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The outlier ﬁlter in Tracker's Processing tab is used to modify the perimeters of the outlier ﬁlter. The ﬁlter
is responsible for determining if a point is valid or not. It uses a probability algorithm to determine how
likely a point would be. For example, if Beacon 1, LED 2 is seen in the same spot for 100 frames, but it
then appears for one frame 10m away (typically caused by IR noise), then the ﬁlter tosses that single
frame away and continues to track the real LED.
As the system does not have a concept of 'real' and 'fake', the system uses a history to determine the
'real' LED. This means that in rare cases, noise may pass through the outlier ﬁlter if the noise is
consistent, such as a reﬂection. There are other tricks to mask out reﬂections and to trim out extra parts
of the tracking area. Please see Motive reconstruction bound settings for more information.

There are three ﬁelds:
- Min Covariance
- Max Z-Sqr Score
- Max Iterations
You may change any of the values in the three ﬁelds and click Apply. By default, the ﬁlter looks like this.
Min Covariance and Max Z-Sqr Score both relate to how 'wide' or 'narrow' the ﬁlter is. Min Covariance will
aﬀect a higher tolerance of points in a given spectrum and the Max Z-Sqr Score will aﬀect a wider
tolerance of points in a given spectrum. Note that the 'spectrum' is an arbitrary unit which that is
aﬀected by how noisy the current tracking environment is.
Min Covariance can range between 0.00 and 1.00 with the default being 0.91. 1.00 means that
everything is accepted and 0.00 means that nothing is accepted.
Max Z-Sqr Score can range between 0 and 5 with the default being 4. 5 means that everything is
accepted and 4 means that nothing is accepted.
Max Iterations aﬀects how many times per frame the same data point is analyzed to determine how
'noisy' it is. There is no range to this ﬁeld, but the default is 150.
The easiest way to adjust the outlier ﬁlter is to increase or decrease the Min Covariance and hitting
apply. There is a large range that you may use, so it is best to step the ﬁeld by either +0.1 or -0.1 each
time to see if the noise becomes better or worse.
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Important Note:
In BlackTrax 2.1, the Follower Module is a background process used by the BlackTrax system with
settings that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Follower module which
can be monitored through the activated Modules widget. See BTEngine for more information.
Table of contents:
Follower Module
Follower Introduction
Layout of the Follower Module
Summary Tab
Follower Connections
Follower Data Log

BlackTrax User Wiki

232

August 2017

BTEngine & Background Modules
Important Note:
In BlackTrax 2.1, the Follower Module is a background process used by the BlackTrax system with
settings that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Follower module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Follower module is a background process used by BlackTrax behind the scenes. The Follower takes
positional data from the Tracker, and forwards the data to other sub programs for their own use.
BTWYSIWYG uses the data from Follower to virtualize real time tracking. An ArtNet network can use the
data to enable moving ﬁxtures to follow Trackables. Third Party programs or an sACN Network can use
the data however they see ﬁt.
Note: All the network addresses listed in Tracker are domains linked to internal IP addresses in the
BTServer.
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Important Note:
In BlackTrax 2.1, the Follower Module is a background process used by the BlackTrax system with
settings that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Follower module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Follower module presents both a 'Basic' and an 'Advanced' mode layout. The simplifed 'Basic' mode
shows exclusively the Follower module summary. In this mode all network conﬁguration settings are
hidden.

In Advanced mode, four other tabs are displayed:

Input: Shows Follower's input data sources. See Follower Connections.
Output: Shows Follower's output data sources. See Follower Connections.
Processing: Shows Follower's connection status to the internal BlackTrax network. See Follower
Connections.
Log: Logs data processed by Follower. See Follower Data Log.
As well as:
Summary: A summary view of data ﬂowing through Follower. See Summary Tab.
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Important Note:
In BlackTrax 2.1, the Follower Module is a background process used by the BlackTrax system with
settings that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Follower module which
can be monitored through the activated Modules widget. See BTEngine for more information.

The Summary tab shows an overview of the Follower modules. A checkmark designates a module that is
currently active and either listening to or passing data, while an X shows a module that has been
disabled or disconnected. Packets sent or received from the specﬁc module are displayed next to this
icon.
Found at the top right corner of this tab is the layout mode selection. It can be toggled between Basic
and Advanced.
This tab also presents the option to both save and reset the entire conﬁguration of Follower. Please note
that reseting the conﬁguration requires restarting Follower.
A shortcut is provided to select your lighting input format, either Art-Net or sACN, as well as enablement
of the module.

Follower, Basic Mode

Follower, Advanced Mode

To Record Lighting Data
Follower allows you to record lighting data. Simply mark the Record Lighting Data checkbox while
receiving incoming lighting data. Unmark the checkbox when you are satisﬁed with your collected data.
This data will save in the C:\bt_run_time folder.
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Important Note:
In BlackTrax 2.1, the Follower Module is a background process used by the BlackTrax system with
settings that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Follower module which
can be monitored through the activated Modules widget. See BTEngine for more information.

Note: You must be in the 'Advanced' mode layout of Follower in order to change any connection
settings.
Note: An ArtNet network is listened to on all universes, regardless of patch. A sACN network only listens
to the universes that are patched. This is based on the .btprj ﬁle. If no .btprj ﬁle is opened and launched
by BlackTrax, it will appear that sACN is not working correctly.
Once a ﬁle is open, BlackTrax will start listening to the universes that are used in the project ﬁle.
To Toggle the Connection of Follower to BlackTrack
Under the Processing tab and Follower Connection, click Disconnect/Connect.
Result: The connection of Follower to BlackTrax will be toggled. The connection status will be displayed
next to Controller link status.
To Connect Follower to Tracker
Under the Input tab and In the Motion Input, mark the Enable check box.
Result: Tracker will be connected to Follower. The data in the Received ﬁeld should be active.
To Output Lighting Data
Under the Output tab and Lighting Protocol (RTTrPL), mark the Enable check box.
Result: The network is connected to Follower and the data in the corresponding Sent ﬁeld should be
active.
To Connect Follower to an Art-Net or sACN Input Network
1. Under the Input tab, in the ArtNet Input/sACN section, unmark the Enable checkbox.
2. Under the Input tab, in the ArtNet Input/sACN section, select the desired network, from the dropdown menu.
3. Under the Input tab, in the ArtNet Input/sACN section, mark the Enable checkbox.
Result: Follower will connect to the chosen network. If the connection was successful, the corresponding
Received ﬁelds will see activity.
To Change the Connection Information of a Module in Follower
1. Enter in the new information in the appropriate ﬁelds.
2. Disconnect the module to Follower.
3. Reconnect the module to Follower.
Result: The module will be connected to Follower with the new settings. If the connection was
successful, the corresponding Sent/Received ﬁeld will see activity.
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Input Tab

Output Tab

Processing Tab
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Important Note:
In BlackTrax 2.1, the Follower Module is a background process used by the BlackTrax system with
settings that are fully integrated within the BlackTrax GUI.
In BlackTrax, click on the Modules menu and choose BTEngine to activate the Follower module which
can be monitored through the activated Modules widget. See BTEngine for more information.

Information on data that passes through the Follower, as a well as system events, can be displayed in the
Message Log. This information can also be save to a separate ﬁle for review later. Message Log ﬁles can
be found at C:\bt_run_time.
To Log Basic Data
Under the Log tab, mark the Enable checkbox to Record Tracking.
Result: The Message Log will record all system events in Follower.
To Log Advanced Data
Under the Log tab, mark the checkbox next to Log Data
Result: The Message Log will record all possible data.
To record the Follower message log to ﬁle
Under the Log tab, mark the checkbox next to To File.
Result: The Message Log will record to a ﬁle, marked with the current data and time. While this option is
selected, data will not appear in the Follower Message Log.
To clear the Follower Message Log
In the Message Log section, click Clear Log.
Result: The Message Log will be cleared of all data. This action is irreversible. If logging the data to ﬁle,
that ﬁle is still available and the data inside will not be cleared.
Additionally, you can select the Detach button to open the message log in a separate window.

Data Log, With Info

Data Log, Clear
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The Monitor module:
Displays communication and command settings of multiple Tracking Adapters that were set in the
Output Conﬁguration widget.
Runs in the task tray and activated from the BTEngine menu and every time Apply Changes is
pressed with Conﬁguration Options enabled or when the project is saved.
If new conﬁgurations are needed to be sent to Monitor/Tracking Adapter, the ﬁrst Apply
Changes will start Monitor and a second Apply Changes will push the necessary conﬁguration
once the connection is established.
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Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of the
Tracker module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. A Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

Table of contents:
Tracking Adapter Module
Tracking Adapter Introduction
Layout of the Tracking Adapter Module
Tracking Adapter Connections
Trackables in Tracking Adapter
Tracking Adapter Data Log
Stream Parameters
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Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of Tracker
module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

The Tracking Adapter module is a background process that is an extension of Tracker's RTTrPM output. It
is used by the BTSystem to customize RTTrPM data for Third Party use. The Tracker Adapter receives
data provided by the Tracker module and customizes this data based on preferences conﬁgured in the
Tracking Adapter. This customized data is then sent oﬀ to designated Third Party programs for their use.
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Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of Tracker
module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

Trackables List: A list of every active BTBeacon detected by the BTSystem. See Tracking Adapter
Connections.
Message Log: A log of all Tracking Adapter events. See Tracking Adapter Data Log.
Communications: Section for managing the network connections of the tracking adapter.
Stream Parameters: Manages how Tracking Adapter customizes data. See Stream Parameters.

BlackTrax User Wiki

242

August 2017

BTEngine & Background Modules
Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of Tracker
module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

To connect Tracking Adapter to Tracker
For Tracking Adapter to edit Tracker RTTrP data, both modules must ﬁrst be running and conﬁgured to
connect to each other.
1. In Tracker, in the Output Methods section, mark the checkboxes for RTTrPM Output and For
Tracking Adapter.
2. In the Command Port ﬁeld, enter the port number Tracker will send RTTrPM data through. In the
Command Multicast Address ﬁeld, enter the address Tracker will broadcast RTTrPM data to.
Note: These ﬁelds should automatically be ﬁlled in when a BlackTrax host ﬁle is loaded. The
host ﬁle is standard with every BTServer.
3. In Tracking Adapter, in the Communications tab, under the Input From Tracker section, mark the
checkbox next to Enable.
4. In the Port ﬁeld, enter the same port number used by the Command Port ﬁeld in Step 2.
5. In the Via Network Card ﬁeld, enter the same address used by the Command Multicast Address
ﬁeld in Step 2.
Result: The Tracker and Tracking Adapter modules will be connected. In Tracking Adapter the Packets In
ﬁeld should see activity if Tracking Adapter is receiving Tracker data.
Tracking Adapter, displaying the Connections tab
To connect Tracking Adapter to Third Parties
1. In Tracking Adapter, in the Communications tab, under the RTTrPM Output section, mark the
checkbox next to Enable.
2. In the Via Network Card ﬁeld, enter the port number Tracking Adapter will send RTTrPM data
through.
3. In the Target Address ﬁeld, enter the address Tracking Adapter will broadcast RTTrPM data to.
Result: Tracking Adapter will send RTTrPM data on the selected port to the speciﬁed address. The
Packets Out ﬁeld should see activity if Tracking Adapter is sending data.
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Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of Tracker
module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

Trackable List
The Trackable List section is used to manage which BTBeacons output data from Tracking Adapter.
To enable the output of a Trackable’s data
In the Trackable List section, mark the Activate checkbox next to the Trackable name whose data you
want to send.
To disable the output of a Trackable’s data
In the Trackable List section, unmark the Activate checkbox next to the Trackable name whose data you
want to ignore.

Trackables List Management
How Trackables currently appear in the Trackable List can be saved or loaded for future use. Permissions
on how BTBeacons can join the Trackable List can also be conﬁgured.
Attention: When a large number of Trackables are operating at the same time, it might be diﬃcult for
the system to simultaneously detect and add the Trackables to the Trackable List simultaneously. If a
large number of Trackables are to operate at the same time, it is recommended that you ﬁrst create and
save a Trackable List populated with all the intended Trackables. Then when you want to work with
their data, simply load the list for the BTSystem to easily reference the Trackables.
To save a Trackable List
In the Trackable List section, click Save List.
Result: The current Trackable List will be saved to ﬁle. To see where the information is saved, see
“Saved system data” on page 45.
To load a Trackable List
In the Trackable List section, click Load List.
Result: If a Trackable List was previously saved, it will load and the Trackable List populated with the
saved Trackable settings.
To clear the Trackable List
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In the Trackable List section, click Reset.
Result: The Trackable List table will be cleared of all Trackables.
To delete selected Trackables from the Trackable List
1. In the Trackable List, select Trackables you want to remove from the list.
2. Click Delete.
Result: The selected Trackables will be removed from the Trackable List.
Trackable List Permissions
How Trackables are added and removed from the Trackable List can be managed from the Permissions
drop-down menu. There are three permission options available:
Lock - The Trackable List will be locked. No new Trackables will be added to the Trackable List
when detected by the BTSystem. The system will not remove inactive Trackables.
Never Remove - No Trackable currently on the Trackable List will be removed from the list, even if
the Trackables is detected as not being active.
Auto Update - The BTSystem will automatically populate the Trackable List with Trackables as
they are detected operating. The BTSystem will also remove inactive Trackables from the Trackable
List if they become inactive after 3 minutes and 50 seconds.
To manage Trackable List permissions
In the Trackable List section, select the desired permission from the Permissions drop-down menu.
Result: The selected permission will immediately take eﬀect on the Trackable List.
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Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of Tracker
module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

Information on data that passes through the Tracking Adapter as well as system events can be displayed
in the Message Log. This information can also be saved to a separate ﬁle for review later. Message Log
ﬁles can be found at C:\bt_run_time.

To record Tracking Adapter data
In the Message Log section, mark the checkbox next to Enable Logging.
Result: The Message Log will record all Tracking Adapter data and events.
To display Tracking Adapter data
In the Message Log section, mark the checkbox next to Log Data.
Result: The Message Log will display all Tracking Adapter data and events.
To record the Tracking Adapter message log to ﬁle
In the Message Log section, mark the checkbox next to To File.
Result: The Message Log will record to a ﬁle, marked with the current data and time.
To automatically scroll through message log data
In the Message Log section, mark the checkbox next to Auto Scroll.
Result: The Message Log will now automatically scroll to the most recent data and events as it happens.
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Important Note:
In BlackTrax 2.1, the Tracking Adapter module is a background process that is an extension of Tracker
module, and with settings that are fully integrated into the BlackTrax GUI.
In BlackTrax, click on the Settings menu and choose Output Conﬁguration. Tracking Adapter will be
launched with settings as conﬁgured by each output after Apply Changes is pressed. See Output
Conﬁguration for more information.

The settings found in the Stream Parameters section determine how Trackable data is altered as it
passes through the Tracking Adapter.
Attention: The settings aﬀect all Trackables that are sending data from Tracking Adapter.
Tracking Adapter, displaying the Stream Parameters tab

Stream Parameters settings
Integer - Controls how integer data is sent. Data can be sent as Big Endian (Network Order) or as
Little Endian (Intel Order).
Float Point - Controls how ﬂoat point data is sent. Data can be sent as Big Endian (Network Order)
or as Little Endian (Intel Order).
Coordinate system - Controls the type of coordinate system used in position data. The coordinate
system can be the stage type found in WYSIWYG (normal XYZ), or it can use the screen type found
in Motive (Y and Z axis are reversed)
Beacon position - Toggles whether LED centroid position data is sent.
LED position - Toggles whether individual LED position data is sent.
Orientation - Toggles whether BTBeacon orientation data is sent.
Orientation data type - Toggles whether BTBeacon orientation data is sent in Euler or Quaternion
format.
Frame Rate - The frame rate that the Timekeeper sends data to Tracker.
Attention: Currently the Frame Rate option should be kept to Auto to avoid
system complications.
Time Stamp - When enabled the Frame ID of the Motive frame sent from Tracker is used as a time
stamp.
Acceleration and Velocity - Toggles whether centroid and/or LED position acceleration and
velocity data is sent.
Output Raw Position - Toggles whether the acceleration and velocity data sent is ﬁltered or
not.
Note: Acceleration and velocity data is not 100% accurate due to inaccuracies that can
occur, such as BTCamera jitter, poor BTCamera calibration, reﬂections and IR
interference. This creates imperfect data or noise. Filtering the data is a way to correct
any noise that enters the data.
Filter Tuner - A slider bar to set how ﬁltered the data should be before being sent on a scale
from -4 to 2. Smooth (-4) is heavily ﬁltered, while Responsive (2) is less ﬁltered.
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The Simulator module is a widget where the identiﬁcation and positional data of BTBeacons can be
created, conﬁgured and managed in simulation. The Simulator can send and receive simulated data to
and from the other modules. The sections in the Simulator layout are:
Beacon Conﬁguration
Beacon Position
Network Conﬁguration
Message Log

Simulator Module
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Beacon Conﬁguration:
In this section, Beacons are created, identiﬁed, conﬁgured and removed.
Create: Click this button to create a single Beacon and add to the list in the table.
LED Bit Code: Select the LED Bit Type from the drop-down list.
Attention: Beacon LEDs are identiﬁed by ﬂashing a speciﬁc bit code unique to that LED.
Higher Beacon indexes can be created with the higher bit codes (thus more Beacons) which
will add more latency to the system. A real system is based on 12-bits.
Delete: Click this button to remove the selected Beacon(s) from the list in the table.
Beacon: In the box, type the number assigned for the Beacon that you will create and assign the
corresponding index numbers.
LED 0, LED 1, LED 2: In the boxes, type the LED indexes for each LED ID corresponding to the
Beacon number that you have set in the Beacon box.
Update: Click this button to apply the LED Indexes to the Beacon, which will be displayed in the
table.
Table: displays the list of Beacon(s) created and LED Indexes, Bit Codes and position for each
corresponding LED.
LED 1, LED 2, LED 3: Mark the checkbox for each, to select the LED, and then type the
measurement (in meters) for the X, Y and Z positions.
Apply: Click this button to apply the LED positions for the selected LEDs.
Note: LED positions are relative to the centroid position.
Batch Beacon Creation: Creates Beacons in a batch.
Count: In the box, type the number of Beacons you want to create in a batch.
Create: Click this button to create the batch of Beacons and add to the list in the table.
Beacon Position:
In this section, the virtual positional oﬀset coordinates of the centroid are displayed, and can be reconﬁgured.
Path Type: Click this drop-down to select Manual or Circle.
Manual: Use the slider to set the measurements (meters) for X, Y, Z positions and RX, RY and
RZ (rotation). You can also type the measurement values in the boxes beside the sliders.
Update: Click this button to apply the measurements to the selected Beacon(s) and
update the data in the Beacon Conﬁguration table.
Range: In the boxes, type the measurement values (meters) in this section to set the
maximum and minimum ranges of the movements.
Update: Click this button to apply the range values to the selected Beacon(s).
Circle: Automatically rotates the Beacon with reference to the set position and rotation of the
centroid. You can also type the measurement values in the boxes beside to specify the
rotation oﬀset and angle. R=Radius of the circle's movement, and A=Angle of the circle
around the world coordinate system.
Update: Click this button to apply the position and rotation values to the selected
Beacon(s).
Start/Stop: Toggle this button to start or stop the movement.
Pulse: Click this button to trigger a single pulse of movement.
Network Conﬁguration:
In this section, the network address and port information linked to the internal IP addresses of the
BTServer are displayed.
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Motive Sender: Displays the network address and port information used for sending position data to
the other modules. Unmark the checkbox to disable the connection and stop sending position data.
Router Listener: Displays the network address and port information used for sending data packets
(such as commands) from the Beacons. Unmark the checkbox to disable the connection and stop
sending data.
Note: This feature is not currently used.
Router Sender: Displays the network address and port information used for sending data packets to
the Beacons (such as battery status). Unmark the checkbox to disable the connection and stop
sending data.
Message Log:
In this section, information on data that passes through the Simulator and system events are displayed.
This information can also be saved to a separate ﬁle for review later. Message Log ﬁles can be found at
C:\bt_run_time.
Display Log Data: Mark this checkbox to display information details in the Message Log.
Write to File: Mark this checkbox to save the log as a text ﬁle in the C:\bt_run_time folder.
Clear Log: Click this button to clear all messages in the log.
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Cue is a module, where real time or simulated tracking data in BlackTrax can be recorded as Time Stamp
Frames that will be saved as Chapters and played back in sequence. The sections in the Cue layout are:
Motive Input
Record
Recording Mode/Show Mode
Chapter Content
Chapter List Table
Log
Chapter Command

Cue in Recording Mode

Cue in Show Mode
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Motive Input:
In this section, network settings are displayed showing the port and the input/output connections to
Motive.
Record:
In this section, you can specify the Time Stamp Frame ID sequence to record by setting the start and end
Frames.
Frame ID: Specify the Frame time stamp data you want to record.
Start: In this box, type the Frame number where you will start the recording.
End: In this box, type the Frame number where you will end the recording.
Current Frame: Displays the actual Frames that are currently running.
Recorded: Displays the actual number of Frames that were recorded.
Start/Stop: Click this button, to start or stop the recording.
Save To File: Click this button to save the recorded Frames in the project Folder or any location that
you choose.
Note: The Save To File button appears when a recording is completed.
Chapter Content:
In this section, you can select the recorded ﬁle that will be used in the Chapter that you want to create.
File: Type the ﬁle name and path or click the browse button to locate and select the recorded
Frame.
Name: Type a name for the Chapter that you want to create.
Chapter ID: Type the number for the Chapter that you want to create (this corresponds to the
Chapter ID in the Main GUI).
Loop: Mark this checkbox to set the recorded ﬁle to play in a loop.
Delay (ms): Type the playback delay (in milliseconds) for the Chapter to wait after being triggered
to start playing data.
Recording Mode/Show Mode:
In this section, you can toggle between Recording Mode or Show Mode.
Recording Mode: Saved ﬁles are created as Chapters and added to the table for editing and
playback.
Note: Click the Recording Mode button to toggle into Show Mode, which will display the list
of Chapters in the table, and editing and playback from the Cue Module are disabled. Click
Enable Auto-Scroll to enable automatic scrolling through the Chapter list.
Load List: Click this button to load the list of saved Chapter(s) that were created and stored in a
project folder.
Save List: Click this button to save the list of Chapter(s) that were created in this module and
added to the list in the table.
Play: Click this button to playback a selected Chapter from the table. Click the Stop button that
appears to stop the playback.
Delete Chapter: Click this button to remove the selected Chapter(s) from the table.
Create Chapter: Click this button to create a Chapter that consists of the ﬁle that has been
accessed and displayed in the Chapter Content section.
Table of Chapters:
The table section displays the list of Chapters that have been created, showing in columns the Chapter
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number, Name, File, Loop, Delay, Information and Status.
Log:
In this section, information on data that passes through the Cue module and system events are
displayed. This information can also be saved to a separate ﬁle for review later. Log ﬁles can be found at
C:\bt_run_time.
Enable Logging: Mark this checkbox to display the log of data information.
To File: Mark this checkbox to enable saving the log of data information into a ﬁle in the
bt_run_time folder.
Clear: Click this button to clear all the displayed log data.
Chapter Command:
Received: Displays the number of Chapter changes received.
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The BlackTrax Device Manager is a software application where external hardware used in the
BlackTrax system can be accessed and managed directly through a PC.
In the Device Manager, ﬁrmware can be uploaded to the Beacons, TimeKeepers and Routers.
The Device Manager works with charging stations that are connected to the network.
When Device Manager launches, it opens to the last used layout by default. When Device Manager opens
for the ﬁrst time, the Main Panel, Device Settings, Charging Stations and System Log widgets are
displayed. The following section describes the various parts of the user interface.
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When Device Manager launches, it displays the table of connected devices for TimeKeepers, Routers and
Beacons on the Main panel, and the docking widgets for Device Settings, Charging Stations, System Log;
and the Charging Station Settings tab.
Main Panel: The Main panel (center area) of the Device Manager displays the table of connected devices
for TimeKeepers, Routers and Beacons that are connected to the Device Manager.

Device Settings: The Device Settings widget displays the properties and settings for the control of the
devices connected to the Charging Station. Each device type (Beacon, TimeKeeper, Router) has unique
settings and properties. The Device Settings widget for each device type displays the diﬀerent settings.

Charging Stations: The Charging Stations widget displays identiﬁcation, ﬁrmware information and status
of all connected remote charging stations for the BTBeacons. In the Charging Stations widget, you can
select and display a charging station, and the settings of the selected Charging Station will be displayed
in the Charging Station Settings widget.

Charging Stations Settings: The Charging Stations Settings widget is where you can conﬁgure the
settings of a selected remote Charging Station. When you select a Charging Station in the Charging
Stations widget, the settings of the selected Charging Station will be displayed in the Charging Stations
Settings widget.

System Log: The System Log widget displays the messages and data information from events that occur
in the Device Manager.
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Device Manager Menu Bar

The Menu Bar across the top of the interface is where you will ﬁnd access to all functions of the software.
The diﬀerent menus are:
File: Closing the Device Manager.
Widgets: Access to all the docking widgets, advanced mode and reset view toggle.
Settings: Access to the Device Manager Conﬁguration module and the System Log widget.
Help: About information for the current release of Device Manager.
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Device Manager File Menu
The File menu is where you can close the Device Manager when you click File > Exit Device Manager.
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Device Manager Widgets Menu

The Widgets menu provides:
Access to the dockable widgets: Device Settings, Charging Stations and Charging Stations Settings.
Close and reset functions.
Access to advance mode controls.
The docking widgets comprise of a 'ﬂoat' and 'close' function. Floating a widget will detach it from the
GUI, and allow you to drag it around the screen, or to another monitor. The close function will close the
widget, at which point you must re-open it from the Widgets menu.
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Device Manager Settings Menu
The Settings menu provides access to the Device Manager Conﬁguration module and the System Log
widget.
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Device Manager Help Menu
The Help menu is where you will ﬁnd the About Device Manager dialog with information about the
Device Manager, product version and build number.
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When Device Manager launches, it displays the table of connected devices for TimeKeepers, Routers and
Beacons on the Main panel, and the docking widgets for Device Settings, Charging Stations, System Log,
and the Charging Station Settings tab.
The Main panel (center area) of the Device Manager displays the table of connected devices for the
TimeKeepers, Routers and Beacons that are connected to the BlackTrax. Click on the Device Type Filter
drop-down to choose which type of device to display: All or TimeKeeper or Router or Beacon.
Note: TimeKeepers and Routers may be connected to a Charging Station via the USB port on the back of
the unit.
The Beacon, TimeKeeper, Router devices listed in the Main panel can each be selected and the settings
of the selected device will be displayed in the Device Settings widget and available for modiﬁcation. You
can also select multiple devices to apply several settings at once.

The conﬁguration settings displayed in the Main panel are:
Refresh Selection: Click this button to update the selection in the list.
Device Type Filter: Click this button to choose which type of device to display, All or TimeKeeper or
Router or Beacon.
ID: Identiﬁcation number of the Beacon device.
Type: The type of device such as TimeKeeper, Router or Beacon. Click the column heading Type to
change the order of the list.
Status: If the device is Connected or Disconnected.
Station: Identiﬁcation of the charging station where the device is currently plugged, or USB if
plugged via USB.
Battery: Percentage level of the battery life.
Radio: Shows if the radio signal from the connected device is On or Oﬀ.
Version: The ﬁrmware version of the connected device.
Preset: Displays the assigned Preset number if the settings of the connected device matches a
Preset conﬁguration or Custom if the settings have been modiﬁed.
Calibration: Indicates if the device is a calibration Beacon.
Notes: Displays packets of feedback information that is sent to the device for ﬁrmware upload.
Note: When a device is added to the list, it stays in the table, even if disconnected (will display status as
Close). When a device is added again, it will compare device IDs to determine if the same device or not,
and will update its previous location in the table.
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The Device Settings widget displays the properties and settings for the control of the devices connected
to the Charging Stations. Each device type (Beacon, TimeKeeper, Router) has unique settings and
properties. The Device Settings widget for each device type displays diﬀerent settings.
When a device is selected in the Main Panel, the Device Settings widget will display the preset settings
by default.

Device Settings for a Beacon
To open Device Settings widget for a Beacon
1. In the Main Panel, click on the Beacon that you want to select.
Result: The Device Settings widget displays the settings of the selected Beacon.

Selected Device: The type and ID number of the selected Beacon.
Serial Number: The serial number of the selected Beacon.
Product Info: The additional information or name that was set to identify the selected Beacon.
To change the settings in Device Setting for a Beacon
1. In the Preset Beacon scroll box, click on the arrow and select the Preset Beacon number.
Result:
When you select a Preset Beacon number, all the conﬁguration settings that were preprogrammed and associated with the Beacon ID number are applied to the selected
Beacon.
Assigning a Preset Beacon number to a Beacon automatically applies all other settings
to the selected Beacon.
2. Click Apply.
Result:
The default settings that was pre-programmed under the Preset Beacon number
are applied to the selected Beacon.
Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3,
Calibration), or Custom when the settings of the Beacon were changed.
3. Click on the Calibration Beacon checkbox if the selected Beacon should be programmed as a
calibration unit. A Calibration Beacon automatically transmits signal packets faster.
4. In the Beacon ID scroll box, click the arrows and select a Beacon ID number if you want to
customize the settings of the selected Beacon.
5. Click Apply.
Result: The Beacon ID number is changed and the Current Preset displays Custom.
6. In the Wireless Channel scroll box, click the arrows and select the Wireless Channel number if you
want to change the previously assigned Wireless Channel.
7. Click Apply.
Result: The Wireless Channel is changed and the Current Preset displays Custom.
8. In the Subnet scroll box, click the arrows and select the Subnet number.
9. Click Apply.
Result: The Subnet is changed and the Current Preset displays Custom.
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10. In the LED Brightness (ms) scroll box, click the arrows and select the length of exposure (in
milliseconds) to increase or decrease the brightness of the LED.
11. Click Apply.
Result: The LED Brightness is changed and the Current Preset displays Custom.
Note: The increase in the level of LED Brightness will decrease the battery life of the Beacon.
(Default = 3ms)
12. In the Loaded Firmware section, a device ﬁrmware can be located, selected and uploaded into
the selected Beacon(s).
To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update begins.
5. When ﬁrmware update is complete, a checksum is performed to verify the upload.
6. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

Device Settings for a TimeKeeper
To open Device Settings widget for a TimeKeeper
1. In the Main Panel, click on the TimeKeeper that you want to select.
Result: The Device Settings widget displays the settings of the selected TimeKeeper.
Selected Device: Displays TimeKeeper.
Serial Number: The serial number of the selected TimeKeeper.
Product Info: The additional information or name that was set to identify the selected
TimeKeeper.
To change the settings in Device Settings for a TimeKeeper
1. In the Wireless Channel dropdown, click the arrow and select the Wireless Channel number from
the list if you want to change the previously assigned Wireless Channel.
2. Click Apply.
3. In the Subnet scroll box, click the arrows and select the Subnet address if you want to change the
previously assigned address.
4. Click Apply.
5. In the Loaded Firmware section, a device ﬁrmware can be located, selected and uploaded into
the selected TimeKeeper(s).
To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into the memory.
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2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update begins.
5. When ﬁrmware update is complete, a checksum is performed to verify the upload.
6. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrmware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

Device Settings for a Router
To open Device Settings widget for a Router
1. In the Main Panel, click on the Router that you want to select.
Result: The Device Settings widget displays the settings of the selected Router.
Selected Device: Displays Router.
Serial Number: The serial number of the selected Router.
Product Info: The additional information or name that was set to identify the selected Router.
To change the settings in Device Settings for a Router
1. In the Wireless Channel dropdown, click the arrow and select the Wireless Channel number from
the list if you want to change the previously assigned Wireless Channel.
2. Click Apply.
3. In the Subnet scroll box, click the arrows and select the Subnet address if you want to change the
previously assigned address.
4. Click Apply.
5. In the Loaded Firmware section, a device ﬁrmware can be located, selected and uploaded into
the selected Router(s).
To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into the memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update is complete, a checksum is performed to verity the upload.
5. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrmware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
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Verifying...(checksum)
Finishing up...(jumping to main)
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The Charging Stations widget displays identiﬁcation, ﬁrmware information and status of all connected
remote charging stations for the BTBeacons. In the Charging Stations widget, you can select and display
a charging station, and the settings of the selected Charging Station will be displayed in the Charging
Station Settings widget.

The Charging Stations widget displays the following settings:
Connect: Click this button to connect the newly added Charging Station.
Get Beacon List: Click this button to update and add to the list, the Beacons that are connected to
the newly added Charging Station.
ID: Identiﬁcation number of the Charging Station in the range between 101 to 254. The default ID
number is 201.
Serial Number: The serial number of the hardware.
IP Address: The network IP address where the Charging Station is connected.
Status: Connected or Close.
Version: Firmware version.
Notes: Other information.

BlackTrax User Wiki

270

August 2017

BlackTrax Device Manager
The Charging Stations Settings widget is where you conﬁgure the settings of a selected remote Charging
Station. When you select a Charging Station in the Charging Stations widget, the settings of the selected
Charging Station will be displayed in the Charging Station Settings widget.

Selected Device: Identiﬁcation number of the selected Charging Station.
CS ID/IP: Select the Charging Station ID from the drop-down, then click Apply.
Loaded Firmware: In this section, a device ﬁrmware can be located, selected and uploaded into
the selected Charging Station.
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Data collected from events which occur in the Device Manager, such as system messages, conﬁguration
changes, and other events can be displayed in the System Log widget. This information can be saved
into a separate ﬁle for review later.
The System Log widget displays the date and time of the event, type of data, and the information.

In the System Log widget, these checkboxes are available to choose what and how messages are
displayed or logged.
Warnings/Errors Only: Mark this checkbox to log and display only the notiﬁcations that
indicate errors that occured or predictive warnings.
To File: Mark this checkbox to record all Device Manager data and events into a remote ﬁle,
marked with the current date and time.
Auto Scroll: Mark this checkbox to automatically scroll to the most recent data or event that has
occurred.
Clear: Click this button to clear all messages.
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From the Device Manager Conﬁguration widget, you can conﬁgure the settings for the Device Manager
application, such as Beacon LED Bit Pattern, Radio Status and the Charging Station Network Address.

To conﬁgure the settings of the Device Manager
1. From the Settings menu of the Device Manager, choose Device Manager Conﬁguration.
Result: The Device Manager Conﬁguration window appears.
2. From the LED Bit Pattern scroll box in the Device Manager Conﬁguration window, select the LED Bit
Type that will apply to the Beacons connected to the Device Manager.
Attention: Beacon LEDs are identiﬁed by ﬂashing a speciﬁc bit code unique to that LED.
Higher Beacon indexes can be created with the higher bit codes (thus more Beacons) which
will add more latency to the system. A real system is based on 12-bits.
3. Mark the Radio On checkbox to indicate when a device is connected. Radio On checkbox is
unmarked by default.
4. The jump settings scroll box displays how the Device Manager behaves when a new device is
connected to the Charging Station. These jump settings are accessible in Advanced Mode.
No Jump: By default, the device will apply whatever it's ﬁrmware is set to.
Jump to Bootloader: Device Manager sets the device to jump to it's bootloader.
Jump to Main Firmware: Device Manager sets the device to jump to the main ﬁrmware.
5. From the CS NIC Address scroll box, select the address for the Network Interface Card for the
Charging Station that is connected to the BlackTrax System.
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To set Preset Beacons
The use of Preset Beacon numbers act as an easy and convenient way to conﬁgure all perimeters of
Beacons without manually entering all settings.
1. Connect the Charging Station to the BlackTrax System.
2. Open the Device Manager.
Notes: All devices that are connected to the Charging Station are displayed in the Device
Manager automatically showing the connection status and preset settings.

3. From the table in the Main panel of the Device Manager, select a Beacon.
Result: The Device Settings widget displays the settings (default preset or previously set
custom settings) of the selected Beacon.

4. In the Preset Beacon scroll box of the Device Settings widget, scroll and select the Preset Beacon
number.
5. Click Apply.
All the pre-programmed settings associated with Preset Beacon number is applied to the
selected Beacon.
Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3,
Calibration).
Note: You may select several Beacons which assigns all Beacons with a diﬀerent preset
number, incrementing by 1.
6. Click on the Calibration Beacon checkbox if you want to set the Beacon as a calibration unit.
Result: The Calibration Beacon is set at Time Slot 1 and IMU is enabled. A Calibration Beacon
automatically transmits signal packets faster.
Example of the Preset Beacon settings:
Current Preset: 2
Wireless Channel: 26
Subnet: 35
LED Brightness: 3ms

To upload ﬁrmware from Device Settings
1. From the Device Settings widget of a selected device, click Browse and select the ﬁrmware ﬁle and
load into memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update begins.
5. When ﬁrmware update is complete, a checksum is performed to verify the upload.
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6. When checksum is complete, the device reboots.
7. Status resets to display "Ready" if a ﬁle is loaded, or "Not Ready" if no ﬁle is loaded.

To program Charging Stations
When Device Manager opens, all devices that are connected to the Charging Station are automatically
displayed in the Device Manager widget showing the connection status and the latest applied settings.

1. Select a Charging Station from the list in the Charging Stations widget.
Result: The Charging Station Settings widget displays the identiﬁcation number of the
selected Charging Station. The ID number includes the network address information.

2. If you added or replugged a Charging Station to the system, click Connect to enable the connection
of the selected Charging Station to the system.
Note: When you add a new Charging Station into the system or if the Charging Station was
unplugged from the system, you need to enable the connection again.
3. If you added or replugged a Charging Station with Beacons, click Get Beacon List to update and
add to the list, the Beacons that are connected to the newly added or replugged Charging Station.
Note: When you add a new Charging Station into the system or if the Charging Station was
unplugged from the system, you need to refresh the list of devices connected to the Charging
Station.

To upload ﬁrmware from Charging Station Settings
1. Select a Charging Station from the Charging Stations widget.
Result: The Charging Station Settings widget displays the settings of the selected Charging
Station.
2. From the Charging Station Settings widget of the selected Charging Station, click Browse and select
the ﬁrmware ﬁle and load into memory.
3. Click Upload.
4. Device Manager checks if the ﬁrware matches the selected device and proceeds to update.
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Health and Safety Information
The BTBeacon contains a rechargeable lithium-ion battery that is used to power the device. Improper use
of a lithium-ion battery can result in ﬁre or serious injury. Please read and understand the following
general warnings on lithium-ion batteries.
General warnings
Do not place the battery near ﬁre, heaters, other high temperature locations, or apply heat to the
device.
Do not pierce the battery with any sharp objects, strike with heavy objects, or otherwise damage
the casing.
Do not expose the battery to water or any other type of liquid, or allow the device to get wet.
Never short-circuit, damage or heat the battery to approximately 60°C (140°F) ±.
If the lithium-ion battery does catch ﬁre, it may burn even more violently if it comes into contact
with water or moisture in the air. DO NOT THROW WATER ON A BURNING BATTERY OR ITS LITHIUMION BATTERY! A ﬁre extinguisher must be used.
Shipping information
When transporting lithium-ion batteries, the following regulatory guidelines are followed:
Section II of Packing Instructions PI965 for Lithium Ion Battery Pack.
UN manual of Tests and Criteria, Part III, sub-section 38.3 (withstanding a 1.2m drop test).
The content of Lithium is less than 100Wh per battery.
The quantity per package is less then 10kg (gross) for UN3480. Thus the consignment is not
classiﬁed as dangerous goods.
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